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1.1 

 

Introduction 

In the past, people have used slow and unreliable methods to 

generate, send, receive and store information. However, today 

millions of people are using devices called computers to produce, 

share and store information. Before embarking on taking Computer 

Studies as a course, it will be necessary to ask the question: What 

is a computer? 

 

  Definition of a computer 
 A computer is an electronic device that accepts user input also 

referred to as data and transforms it under the influence of sets of 

special instructions called programs to produce the desired output 

referred to as information. 

 

Data can be defined as raw facts that do not have much meaning to 

the user and may include: numbers, letters and symbols. 

Information is the processed data that is meaningful to the user. 

The computer is said to be electronic because it utilizes small 

electrical signals to process information. 
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Before 20th century, most information processing was done 

manually or by use of simple machines. Today, millions of people 

are using computers 

In offices and at home to produce and store useful information 

about all Aspects of business, scientific research, government 

activities and Personal details. Together with other 

telecommunication facilities, computers have also become the 

fastest and most reliable means of communication. The integration 

of computers and, telecommunication facilities for the purpose of 

communication is what is referred to as information and 

communication technology (lCT).Computers come in different 

sizes and designs but the most common is a computer referred to as 

a personal computer (PC). Personal computers are mostly used in 

offices, schools, business premises and at home. 

 

1.2 
 

Parts of a computer 
A computer is made up of a collection of different 

components that are interconnected together in 

order to function as a single entity. A computer is 

basically made up of a system unit and other 

devices convicted to the system unit called 

peripheral devices. Examples of peripheral 

devices include; the monitor, the keyboard and the 

mouse.  

The system unit  

This is the part that houses the brain of the computer called the 

central processing unit (CPU). The system unit also houses other 
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devices called drives. Drives are used to store, record and read 

data. 

 Figure 1.2 shows a tower style system unit. 

 
Peripheral devices 
Peripheral devices are connected to the system unit using special 

cables called data interface cables that carry data and information 

to and from the devices. The cables are attached to the system unit 

using connectors called ports. . 
 
Peripheral. Devices may be arranged as shown in Figure 1.1 with 

the monitor resting on top of the system unit. Sometimes, the 

system unit may be made to stand alone (tower style) as the one in 

Figure 1.2. 

 

The keyboard 
It is the most common device that enables the user to enter data 

and instructions in the computer by pressing its keys. 

 

The mouse 
It is a device that enables the user to issue instructions to the 

computer 

By controlling a special mouse pointer displayed on the screen. 

 

The monitor 

The computer monitor or simply the screen is a television like 

device used for displaying output. It is called a monitor because it 

enables the user to monitor or see what is going on in the 

computer. 

 

1.3 
 
Classification of computers 
Computers can be categorised according to:  

1. Physical size and processing power.  

2. Purpose. 

3. Functionality. 
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Classification according to physical size and processing 
power 
Computers can be classified into four main groups namely 

supercomputers, mainframe computers, minicomputers and 

microcomputers. 

 

Supercomputers 
They are the fastest, largest, most expensive and powerful 

computers available. They are able to perform many complex 

calculations in a fraction of a second. Because of their extreme 

weight, a supercomputer is kept in a special room. Due to their 

huge processing power supercomputers generate a lot of heat. 

Special cooling systems are therefore required. Sometimes the 

whole CPU is immersed in an aquarium like tank containing liquid 

fluorocarbon to provide cooling.  

Supercomputers are mainly used for scientific research, which 

requires enormous calculations. Applications that justify use of 

supercomputers include aerodynamic design and simulation, 

petroleum research, defense and weapon analysis among others. 

Supercomputers are mainly found in developed countries such as 

in USA where they are used for advanced 

Scientific research such as nuclear physics. Figure 1.3 shows an 

example of supercomputer. 

 
Mainframe computers 
They are less powerful and less expensive than the 

supercomputers. While supercomputers may be described as giant 

computers, the mainframes are said to be big in size. They are used 

for processing data and performing complex mathematical 

calculations. They have a large storage capacity and can support a 

variety of peripherals. 
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Mainframe computers handle all kinds of problems whether 

scientific or commercial. They are mostly found in government 

agencies, big organizations and companies such as banks, 

hospitals, airports etc. which Have large information processing 

needs. Figure 1.4 shows a picture of a mainframe computer. 

 

Minicomputers 

A minicomputer resembles the mainframe but is slightly smaller. 

Thus it is referred to as a small-scale mainframe computer. 

Although it supports fewer peripheral devices and is not as 

powerful and fast as the mainframe computer, it was developed as 

a cheaper alternative to the mainframes for smaller organizations. 

They are used mainly in scientific laboratories, research 

institutions, engineering plants and places where processing 

automation is required. They are well adapted for functions such as 

accounting, word processing, database management and specific 

industry applications. Figure 1.5 shows a picture of a 

minicomputer.  

 

Microcomputer 

A microcomputer is the smallest, cheapest and relatively least 

powerful type of computer. It is called a microcomputer because; 

its CPU is called a microprocessor, which is very small compared 

to that of a mini, mainframe or supercomputers. Microcomputers 

are also called personal computers (PC) because they are designed 

to be used by one person at a time. 
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Microcomputers are commonly used in training and learning 

institutions, small business enterprises, and communication centers 

among others. Today, the power of microcomputers has grown 

tremendously closing the gap that formerly existed and reserved 

for the minicomputers and the mainframes. 

Technological advancement has seen the development of smaller 

and smaller microcomputers. The following are the various types 

of microcomputers in operation today arranged in descending order 

according to size. 

1. The desktop computer  

-Not portable. It is designed to be placed on Top of an office desk. 

2. The laptop computer  

-Portable like a briefcase. It is designed to be used by placing it on 

the lap hence its name. 

3. The palmtop e.g. personal digital assistant (PDA) 

 - Small enough to fit in the pocket and can he held in the palm 

when being used. 

 

 

 

 

 

 

Classification according to purpose 
Computers can be classified according to the tasks they perform 

either as general or special purpose computers. 

 

General-purpose computers 

General-purpose computers have been designed to be able to 

perform a variety of tasks when loaded with appropriate programs. 

They are the most common types of computers in use today. Their 

flexibility enables them to be applied in a wide range of 

applications like document processing, performing calculations, 

accounting, data and information management among others. 

 

Special purpose computers 
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Special purpose computers are designed to serve a specific purpose 

or to accomplish one particular task. Such computers can perform 

no other task except the one they were meant to do. This means 

that the set of instructions, which drive a special purpose computer, 

are limited in number at the time of manufacture. Examples of 

such computers include, robots used in a manufacturing industry 

production line, mobile phones for communication only and 

electronic calculators that carry out calculations only. 

 

Since special purpose computers are dedicated to a single task, 

they can perform the task quickly and very efficiently. 

 

Classification according to functionality 
Computers can be classified according to the type of data they can 

process. Data can either be in discrete or continuous form. Discrete 

data which is also called digital data is one that can be represented 

as distinct values that do not have any transitional stages over time 

e.g. either 1 or O. Continuous data which is also called analog data 

can be represented as progressively changing values overtime. 

Computers can be classified as digital, analog or hybrid. 

 

Digital computers 

Digital computers process digital data only. Any data to be 

manipulated by a digital computer must first be converted to digital 

form. Most home appliances today are also digital in nature. For 

example to increase the volume of a digital television you simply 

press a button and it changes from 1 to 2, 3 If the same television is 

analog, it would have a knob 

that you can continuously turn round or slide in a slot to increase 

or decrease the volume. 

 

Analog computers 

This refers to computers that process data that is analog in nature. 

Analog computers solve problems by measuring the amount of 

change that occurs in quantities like speed, temperature and 

pressure. An analog machine is usually a special purpose device 

that is dedicated to a single task. Analog computers are used in 

manufacturing process control like monitoring and regulating 
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furnace, temperatures, and pressures. They are also used in other 

applications like in weather stations to record and process 

physical quantities e.g. wind, cloud speed, temperature etc. 

 

Hybrid computers 

Hybrid computers are designed to process both analog and digital 

data.  

1.4 Development of computers 
Before 1900, most data processing was done manually using 

simple tools like stones and sticks to count and keep records. 

Around 2000 years ago, Asian merchants came up with a special 

calculating tool called abacus that could be used to calculate large 

figures. Abacii, are still in use even today. An abacus is made up of 

a rectangular frame and a crossbar at the middle. It is fitted with 

wires or strings running across from the frame to the crossbar as 

shown in Figure 1.8. 

 
, 1+5=6 

Each bead has a value of 5 

Crossbar 

Each bead has a value of 1 4+5=90+0=0 

3+5=8 

Fig. 1.8: Representing numbers using an abacus 

 

8 How to represent a number using an abacus 
Each bead in the lower row represents unitary values while the 

upper ones represent fives. To represent a number, the bead is 

moved to the crossbar. Those beads away from the crossbar 

represent zeros. The abacus in Figure 1.8 represents the number 6 

908 (six thousand nine hundred and eight). 

 

The first machine after the abacus that is usually regarded as the 

forerunner of modem computers was developed by an English 
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mathematician called Charles Babbage and was named the 

analytical engine. After the death of Babbage in 1871 there was 

little improvement on his work until the 1930s. The first computer-

like machine Mark 1 was designed by Professor Howard Aken of 

Horrard University in 1939. Mark 1 became operational in 1943. It 

weighed 5 tons and was 16 m long. Since then, rapid 

advancements in computing have been realized and can be 

categorised into five generations. 

 

First generation computers (1940s to 1958) 

These computers were very large in physical size and used 

thousands of 

electronic gadgets called vacuum tubes or thermionic valves. These 

types of computers consumed a lot of power hence they constantly 

broke down due to the excessive heat generated. Examples of such 

computers are the electronic numeric integrator and calculator 

(ENIAC) and the electronic discrete variable automatic computer 

(ED VA C). 

 

 Second generation computers (1958 -1964) 

Computers in this generation operated using tiny, solid-state 

electronic devices called transistors that were much smaller than 

the vacuum tubes. These computers produced less heat, were much 

faster, smaller in size and more reliable than those made with 

vacuum tubes. Examples of second-generation computers include 

IBM 1401 and 7070, UNIVAC 1107, ATLAS LEO Mark III and 

Honeywell 200. 

 

Third generation computers (1964 -1970) 

The third generation computers used electronic devices called 

integrated circuits (ICs) instead of transistors. An integrated circuit 

consists of thousands of small transistor circuits etched on a 

semiconductor called a silicon chip. The use of integrated circuit 

improved the processing speed and storage capacity of computers. 

Examples of third generation computers included smaller and less 

expensive minicomputers such as IBM 360 and ILL 19000 series. 

 
Fourth generation computers (1970 to present) 
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51 From 1970, further technological improvement was done on the 

silicon chip design by compressing 

more tiny circuits and transistors into even smaller space. This 

design produced what is called large scale integrated (LS1) and 

very large scale integrated (VLS1) circuits which were used in the 

innovation and technological development of the brain of the 

computer called the microprocessor. A microprocessor is a 

complete central processing unit (Processor) used in 

microcomputers. The result was development of very small 

computers with very high processing speed. The first 

microcomputer was called Apple 11 Other fourth generation 

computers included IBM 370 and 4300, Honeywell DPS-88 and 

Burroughs 7700. 

 

Fifth generation computers 

In this generation falls today's computers that have very high 

processing power and speeds than their predecessors, and whose 

size is increasingly becoming smaller. These computers have 

special instruction sets that allow them to support complex 

programs that mimic human intelligence often referred to as 

artificial intelligence. 

 

A lot of research is being done to try and come up with a machine 

that can work without human intervention. One of the most 

successful developments in this field is the advent of computers 

that can help managers to make decisions and those that can offer 

critical expert services to users instead of relying on human 

professionals. 

 
Areas where computers are used 
Computers have many advantages over other types of office and 

business equipments that are used for data processing functions. 

Three of the advantages are: 

1. Computers process data faster. The processing speed of a 

computer measured against other devices like typewriters and 

calculators is far much higher. 
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2. Computers are more accurate. As long as the correct instructions 

and data are entered, computers W produce more accurate results. 

They have the ability to handle numbers up to many decimal 

places without rounding off. 

3. Computers are more efficient. A computer utilizes minimum 

resources, to process data as compared to human beings or other 

machines. For example computers require less effort to process 

repetitive tasks. In our day to day activities, we use computers in 

almost every aspect of our lives. The following are some of the 

areas where computers are used. 

 

Supermarkets 

Most retail stores use computers to help in the management of 

daily activities like stock control. The stock control system keeps 

account of what is in store, what is to be sold and what is out of 

stock. The management is automatically alerted when a particular 

item or items are running out of stock and need reordering. 

 

Offices 

 Computers have increased efficiency in offices by reducing the 

time and effort needed to access and receive information. Most 

modern office functions have been automated for faster message 

distribution and document processing. 

 

Banks 

Special cash dispensing machines called automated teller 

machines (ATM s) have enabled automation of cash deposit and 

withdrawal services. Efficiency has also been increased due to 

better record keeping and document processing brought about by 

computers. 

 

Industries 

Computers are being used to monitor and control. Industrial 

processes. The computer age has seen the wide use of remote 

controlled devices called robots. A robot is machine that works 

like a human being but performs tasks that are too unpleasant, 

dangerous, or complex and tedious to assign to human beings. 
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Hospitals 

Computers are used to keep patients records in order to provide 

easy access to a patient s treatment and diagnosis history. 

Computerized medical devices are now being used to get a cross 

sectional view of the Patient s body that enables physicians to get 

proper. Diagnosis of the affected part of the body with high levels 

of accuracy. Computers also control life support machines in 

intensive care units (lCU). 

 

Transport 

Computers are used to monitor vehicle traffic in a busy town, 

aircraft navigation and to make reservations. 

 

Communication 

Integration of computers and telecommunication facilities has 

made message transmission and reception to be very fast and 

efficient. Because of the speed with which information can be 

transmitted around in the world using computers the world is said 

to have become a global village. 

Law enforcement agencies 

Information held in computers such as fingerprints, photographs 

and other identification details helps law enforcers to carry out 

criminal investigations speedily. 

 

Education 

Computers are widely used in the teaching and learning process. 

Learning and teaching using computers is referred to as computer-

aided learning (CAL) and computer aided teaching (CAT). For 

example experiments in subjects like Chemistry or Physics may be 

demonstrated using a special computer programs that can depict 

them on the screen through a process called simulation. 

Domestic and entertainment 
Computers can be used at home for recreational activities such as 

watching movies, playing music and computer games. They can 

also be used in storing personal information, calculating, keeping 

home budgets and for research in various fields. 

  
  Library services 
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In a computerized library, a computer enables library personnel to 

easily access and keep updated records of books and other library 

materials. Library users can also use computers to search for titles 

instead of using the manual card catalogue. 

 

1.6 The computer laboratory 
A computer laboratory is a room that has been specially prepared 

to facilitate installation of computers and to provide a safe 

conducive environment for teaching and learning of computer 

studies. The following factors must be considered when preparing 

a computer laboratory. 

1. Security of computers, programs and other resources. 

2. Reliability of the source of power. 

3. The number of computers to be installed and the available floor 

space.  

4. The maximum number of users that the laboratory can 

accommodate. 

 

Safety precautions and practices in the computer 
Laboratory 
After the establishment of the computer laboratory, a number of 

safety precautions, rules and practices need to be observed in order 

to avoid' accidental injury to the users, damage of computers or 

lack of a conducive environment for teaching and learning. The 

safety precautions and practices include: 

Behavior in the computer laboratory 

The following rules must be followed in and around a computer 

laboratory. 

1. Avoid smoking or exposing computers to dust. This is because 

smoke and dust contain small abrasive particles that can damage 

computer components and cause wearing of moving parts. 

2. Avoid carrying food and beverages to the computer room. Food 

may fall into the moving parts of the computer and damage them. 

Liquids may spill into computer parts causing rusting or electrical 

defaults. 

3. Avoid unnecessary movements because you may accidentally 

knock down peripheral devices. 
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4. At all times follow the correct procedure for starting and 

shutting down the computer to avoid loss of data and damage to 

computer Programs. 

5. Do not open up the metallic covers of computers or peripheral 

devices without permission and particularly when the computers 

power is still on. 

 

Protection against fire 

A computer room should have gaseous fire extinguishers like those 

filled with carbon dioxide. Water based or powder extinguishers 

should be avoided because they can cause damage to computer 

components. 

 

Cables insulation 

All power cables in the computer room must be properly insulated 

and laid away from busy pathways in the room. Lay them 

preferably along the wall in trunks. This avoids the danger of 

exposing the user to electric shock and power interruptions caused 

by stumbling on cables. 

 

Stable power supply 

Computers are delicate devices that require a stable source of 

power. Power from mains supply is not always stable and may 

sometimes experience power surges or under voltage sometimes 

referred to as brownout. To protect the computer from being 

damaged due to power instabilities, avoid connecting it directly to 

the mains supply. Instead, connect it to a special device called un-

interruptible power supply (UPS) then connect the UPS to the 

mains as shown below 

 

 The UPS charges when mains power is on and has power surge 

and. brownout protection capabilities. When the mains power goes 

off, it gives some sound alert (usually a beeping sound) to alert the 

user. 

 

The UPS performs two main 

functions namely: 
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1. It regulates power from an unstable power source to the 

required Clean stable voltage by eliminating surges and brownouts. 

2. It temporarily provides power to the computer in case of a 

sudden power failure hence allowing the user to store his/her work 

and shut down the computer using the correct procedure  

To enable continuity of work even in the absence of mains power, 

organizations that give critical services like banks, schools and 

hospitals usually install a standby generator that automatically 

comes on in case of a power failure. Power from the generator 

must pass through a UPS before being fed to the computer because 

it is also not stable. 

 

NB: Generally speaking, devices that provide alternative source of 

power are usually referred to as power backups. 

 

Burglar proofing 

To deter unauthorized access to the computer room, it is important 

to implement the following controls. 

1. Fit strong metallic grills and locks on doors, windows and roof 

in Case the roofing is weak.  

2. Do not welcome strangers into the computer room. 

3. Consider installing security alarms at strategic access points that 

would alert the security personnel in case of a break in. 

 

Ventilation 

There must be good air circulation in the computer room to avoid 

suffocation and overheating. Remember that both computers and 

human beings emit heat energy into the environment. Proper 

ventilation enables the computer to cool and hence, avoids damage 

to electronic parts that can be caused By overheating. Proper 

ventilation can be ensured by: 

1. Ensuring that the room has enough ventilation points like 

windows.  

2. Installing an air-conditioning system. 

3. Avoiding overcrowding of either machines or people in the 

room. 
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Dust and dump control 

a computer laboratory should be located away from excessive 

dust. The room should also be fitted with special curtains that 

would reduce entry of dust particles. Computers must remain 

covered using dust covers when not in use. 

Humidity should be at an optimum of 50%. Humidity lower than 

this allows static electricity to build up and causes damage to 

sensitive electronic components. also high humidity of over 70% 

cause rusting of the metallic parts of the computer system. To 

prevent both high and low humidity place humidifiers in the room 

 

Lighting 

a well lit computer room prevents eyestrain that eventually leads to 

headaches, stress and fatigue. It is important to adjust the 

brightness of the computer monitor until the eyes feel comfortable 

before using a computer to avoid damaging your eyes: 

fit radiation filter screens. Which are specially tinted to reduce the 

light that reaches the eye. Avoid using a flickering monitor 

because this can cause extreme eyestrain that can damage eyesight. 

 

Standard furniture 

The table on which a computer is placed must be strong and wide 

enough to bear the weight and accommodate all the peripheral 

devices. The chair for the user must be comfortable, and have a 

straight backrest for one to sit upright as illustrated below to avoid 

muscle pains and backaches caused by poor posture. The seat must 

be high enough relative to the table for comfortable use of the 

hands on the keyboard and the eyes must be the same level as the 

top of the screen when the user is seated 

 

Practical hands on skills 

Starting-up (Booting) a computer 

1. make sure that all the components are 

properly connected. The computer must be 

connected to an active power source. 

2. Switch on the monitor first, 

3. Switch on the system unit 
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When the power is on, the computer automatically goes through a 

process of self-test and preparation for use. This process is called 

booting. There are two types of booting namely: 

*  cold booting 

*  warm booting. 

Cold booting 

This happens when the computer, originally off, is switched on by 

pressing the power button of the system unit. 

The computer starts by checking all its components to determine 

whether they are functioning correctly and whether they are 

available for use. This process is called the power-on-self-test 

(POST). During this process, the monitor will display information 

showing the status of each device being tested. In case one of the 

devices is faulty or missing, this process will halt and a message 

alerting the user is displayed on the screen. The special program 

that directs the POST process is called the basic input output 

system (BIOS). 

 

When the POST process is over, the computer displays a prompt 

message requesting one to start using it. 

Some computers have programs that require a person to identify 

them selves by providing a user name and a password (a secret 

word given to the user) before it can allow one to use them. The 

process of providing such information is called logging on and it is 

a security measure meant to deter unauthorized users from using 

the computer. 

 

Warm booting (restarting) 
This happens when the computer, originally on, is forced to restart 

by pressing the restart button on the system unit or by pressing a 

combination of keys on the keyboard. It is also possible to warm 

boot a computer by using the restart command found in a special 

program called an operating system.     

 

Shutting down a computer 

It is important that the user follows the correct procedure of 

shutting down the computer at all times. If the procedure is not 
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followed then loss of data, damage of programs and computer 

components may occur. 

 

Procedure for shutting down a computer 

 1. Ensure that all the work has been properly stored. This 

process is called saving. 

 2. Close all programs that may be currently running. 

 3. If your computer is running on Microsoft Windows 98 or 

later versions then: 

(a) Click the start button on the screen. 

(b) Select the shut down command from the menu list. 

(c) In the computer prompt that appears, select shut down then 

press the enter key on the keyboard. (d) After a few seconds the 

message IT IS NOW SAVE TO TURN OFF THE COMPUTER 

appears on the screen. Switch of the system unit then the monitor. 

 

NB: Some system units switch themselves off automatically when 

you do steps 3 (a), (b) and (c) above. 

 

Keyboard layout 
The keys on the keyboard can be categorized into five groups as 

shown in Figure 1.11. 

 
Alphanumeric keys 

Keys are labeled with alphabetic letters A-Z, numbers  arranged in 

a line 1,2, ……..0 respectively and symbols like:?,], % etc. This 

group also includes the following keys: cap lock, enter tab. space 

bar and backspace. 

Caps lock key: Pressing this key let's the user type in upper case-

letters,(capitals) To switch back to lower case letters simply press 

the same key again. 
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Enter key (return key): Pressing this key forces the text cursor to 

move to the beginning of the next line. A cursor is a blinking 

underscore (-) or a vertical beam (I) that shows where, the next 

character to be typed will appear. The enter key is also used to 

instruct .the computer to execute a command that has been selected 

on the screen. 

Tab key: This key is used to move the text cursor at set intervals 

on the same line e.g. 10 mm, 20 mm etc. 

The space bar: This bar creates a space between words during 

typing. 

The backspace key: This key deletes characters from right to left 

on the same line. 

 

Function keys 
Function keys are usually located along the top of the keyboard. 

They are labeled FI, F2 up to FI2. They are used for tasks that 

occur frequently in various programs. For example pressing FI key 

in J most programs starts the HELP MENU. 

 

Cursor movement and editing keys 
Cursor movement keys are used to move the cursor on the screen. 

These keys are: 

Arrow keys: Pressing the right or left arrow key moves the cursor 

one character to right or left respectively. Pressing the upward or 

downward arrow key moves the text cursor one line up or down 

respectively. 

Page up and page down keys: Pressing page up key moves the 

cursor up one page in case the document has many pages. Pressing 

page down key moves the cursor down one page in case the 

document has many pages. 

Home and end keys: Pressing home key moves the cursor to the 

beginning of the current line. Pressing end key moves the cursor to 

the end of the current line. 

Editing keys are used to delete or insert characters in a document. 

These are: 

Insert key: This key helps the user to insert or replace a character 

at the cursor position. 
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Delete (Del) key: This key deletes characters at the cursor position 

from left to right. 

Special PC operation keys 
These keys are rarely used singly but in combination with other 

keys to give special instructions to the computer. They include 

SHIFT, CTRL, ALT and ESC keys. 

Numeric keypad keys 
The numeric keypad consists of a set of numbers 0 to 9 and the 

arithmetic signs like + (addition),  (minus), * (multiplication) and / 

(division). They are located on the right hand side of the keyboard. 

The keypad is meant to help the user to rapidly enter numeric data. 

The numbers on the numeric keypad can only be used when the, 

situated on the numeric keypad, is turned on. 

 

Otherwise, they can be used as cursor movement and editing keys 

when num lock key is turned off. It is important to note that not all 

keyboards have the numeric keypad. For example portable 

computers may lack a separate numeric keypad due to size 

limitations. 

 

Practical keyboard skills  
TYPING RULES:  

1. Sit upright with both feet firmly on the ground maintaining an 

alert Posture. 

2. Place the material to be typed on your left in a position you can 

read Without strain. 

3. Rest both hands on the keyboard with fingers resting on the 

home keys. These are keys on which fingers rest during typing in 

readiness to press other keys. The home keys for the left hand 

starting with the small finger are A, S, D, F with the thumb on 

spacebar while those of the right hand are the apostrophe (') 

semicolon (;), L, K with the thumb on the spacebar. 

4. Start typing the text slowly at first, making sure you are using all 

the Ten fingers and that you press the key nearest to the home keys 

with the closest finger, e.g. to press Q, use the small finger on the 

left hand while to press J, use the index finger on the right hand. 

Mouse skills 
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Mice (the plural of mouse) comes in various shapes, colors and 

designs. Today one can even get a mouse that uses wireless 

technology that is, it does not have a connection cable. Most mice 

have two buttons but some may have three. Figure 1.12 is an 

illustration of a mouse. 

 
Using the mouse 

When the mouse is made to slide on a flat 

surface, it controls a pointer on the screen, 

which is called a mouse pointer or a cursor. To 

make a selection, the pointer must be on the 

item that is to be selected. After selecting, the user can manipulate 

the item by pressing a mouse button 

 

USING THE MOUSE: 

1. Place the mouse on a flat smooth surface. 

2. Gently hold the mouse with your right hand, using the thumb 

and the two right-most fingers. 

3. The index finger should rest on the left button while the middle 

finger rests on the right button. 

NB: For left handed people, it is possible to change the mouse 

settings in order to comfortably hold it using the left hand. 

 

Terminologies associated with the use of a mouse 
Clicking: This means pressing and releasing the left mouse button 

once. A click often selects an object. 

Double clicking: This means pressing the left button twice in quick 

succession. Double clicking usually opens a file or starts a program 

Right clicking: Pressing the right hand side mouse button once 

displays a list of commands from which the user can make a 

selection. This list of commands is called a shortcut menu or 

context sensitive menu. It is called a context sensitive menu 

because the commands on it apply to the right clicked item. 

 

Drag and drop: This is whereby the user drags an item from one 

location on the screen to another. The procedure to accomplish this 

operation is as follows: 
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1. Point to the item you want to drag. 

2. Press the left hand side mouse button and hold it down 

3. Slide the mouse until the pointer reaches the desired position on 

the screen.  

4. Finally release the mouse button and the item will be dropped in 

the new location. 

 

COMPUTER SYSTEMS 
 
Chapter outline 
 
2.1 Introduction 
2.2 Input devices 
2.3 The central processing unit (CPU) 

2.4 Output devices 
2.5 Secondary (auxiliary) storage devices and media 2.6 
Power and interface cables 
2.7 Basic computer setup and cabling 
2.8 Computer software 
2.9 Criteria for selecting a computer system 
 
Introduction 

In the previous chapter, you were introduced to some of the parts 

or devices that make up a computer. However, a computer system 

requires more than just a collection of devices. The term system 

can be defined as a collection of independent entities that 

collectively work together to achieve a desired goal. 

 

The systems approach to computing was borrowed from the social 

scientists who believe that all things can be viewed as being made 

up of small independent components(subsystems) that come 

together to form a bigger more complex system. For example, a 

school can be seen as a system with the students, teachers, 

accounts department and the administration as subsystems. The 

school system itself is a subsystem of the ministry of education! 

Therefore, the term computer system refers to a collection of 

entities that work together to process and manage information 

using computers. It is important to note that, systems exist whether 
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computerized or manual. However, the computer is replacing many 

manual processes hence the need to study the idea of a computer 

system. For example, a document processing system in the 

secretary s office can be made more efficient by computerizing it. 

 

A computer system consists of three main components namely the 

hardware, the software and the computer user (liveware). All the 

physical components both mechanical and electronic that make up 

a computer system such as the monitor, the system unit, keyboard 

and mouse etc. are called hardware. Software is a set of computer 

programs that guides the computer in each and every activity that 

happens inside the computer during data processing operations. 

Human beings by themselves have the ability though limited, to 

process data and manage information. Computers have been 

designed to help human beings to enhance the efficiency of 

processing and managing information. It is the human being who 

issues commands to a computer depending on his or her needs. 

 

The hardware elements of a computer are generally grouped into 

four major categories namely input devices, central processing 

unit, output devices and storage devices. 

 

Input devices 
'Data may be entered into a computer using keying devices such as 

the keyboard, or using pointing devices such the mouse, or by 

devices that automatically capture data from the source referred to 

as data capture devices e.g. scanners and digital cameras, or by 

voice recognition devices such as microphones. The main purpose 

of input devices is to convert the human readable data into 

electronic or machine readable form. 

 

Input devices can be classified according to how they are used to 

enter data. This includes: 

1. Keying devices such as the keyboard, keypad etc. 

2. Pointing devices such as mouse, trackball etc.  

3. Scanning and other data capture devices. 

4. Speech recognition or voice input devices.  

5. Touch screen, digitizer and digital cameras. 
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Keying devices 
 
Keyboard and keypad 
These are the most common input devices. These devices enter 

data into a computer by typing. Apart from a few differences, a 

computer keyboard is similar to the typewriter keyboard. A keypad 

is a miniature (tiny) keyboard which is mostly used on small 

portable computers, calculators palm notes, mobile phones etc. 
 
Pointing devices 
These are the input devices that enter data or instructions by 

controlling a pointer on the screen. Apart from the mouse, the 

other pointing devices include the trackball, joystick and light pen. 

 

Trackball 

A trackball works just like the mouse but instead of moving it on a 

flat surface, a ball fixed on its top is rolled using the index finger. 

As the ball rotates, it moves a pointer on the screen; one can then 

click its button to execute the selected command. Figure 2.1 shows 

a drawing of a trackball. The advantage of a trackball over the 

mouse is that it neither requires an extra space nor a flat surface for 

movement. Today some computers are coming with a track ball on 

top of a keyboard and a mouse. 

 

Joystick 

A joystick is an input device that looks like a car 

 

 

 

 gear lever which can be moved sideways, upwards or downwards 

to control the position of the cursor. Just like the mouse, it has a 

button which is used for selecting an item. It is commonly used in 

playing video games.  

 

Light pen 

A light pen is a hand held pen-like device that has a light sensitive 

point. A light pen can make selections, place images, draw and 
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indicate dimensions by simply touching the screen. A light pen 

does not emit light 'but instead, it reacts to the light emitted by the 

display using a photosensitive. detector at its base. 

 

Scanning devices 
These are devices that enter (capture) data into the computer 

directly. Scanners can be classified according to the technology 

they use to capture data. These are optical scanners and magnetic 

ink scanners. 

 

Optical scanners 
These types of scanners capture data using light. A special type of 

concentrated beam of light is passed over the object, image or text 

which needs to be entered into the computer. The scanner converts 

the data into digital form and then passes it to the computer for 

processing. There are three types of optical scanners: 

 

Optical mark recognition (OMR) 
These types of scanners detect marks made on a piece of paper 

using a soft pen or pencil. The reader scans the marks with a 

special type of light called infrared light. Where there are no 

marks, a strong light is reflected than where one exists. These 

types of scanners are used in marking multiple choice questions, 

questionnaires, selecting numbers in lottery tickets etc. 
 
Optical bar recognition (OBR) 
Bar codes are lines of different thickness that hold item 

information such as, country of manufacture, name of the 

manufacturer, and item code. The type of scanner used to read 

these bars is called a wand or a laser scanner. The interpretation is 

based on the width of the bars rather than their location. Figure 2.3 

shows bar codes. 

 

Optical character recognition (OCR) / image scanners 
This is the most sophisticated type of scanner that operates like the 

human eye. It not only scans characters but also can scan real 

objects, pictures and drawings. 
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The most common type of this scanner is the 

flatbed scanner, Using this scanner, one can 

scan text, a real object or a picture by 

placing it on a glass plate exactly the way photocopy machine 

works. The text or a picture scanned is displayed on the screen or 

saved so that one can edit or print it. 

 

Magnetic scanners 

These types of scanners capture data by using magnetic 

technology. The data being read can either be in form of special 

magnetic characters or a continuous magnetic strip. The following 

are some of the common examples of magnetic scanners. 

 

Magnetic-ink character recognition (MICR) 
MICR was developed to help banks process cheques. MICR allows 

special devices to read magnetic characters written in a special 

format. An example of MICR device is a cheque reader that reads 

the cheque number, and sends the details to the computer to be 

used in updating the customer s account. 

Magnetic stripe recognition 
A magnetic stripe is a thin magnetic tape, often found at the 
back of a plastic card e.g. an automated teller machine card 

(ATM) and a credit card. An ATM card is used to get banking 

services without necessarily going to the counter, while a credit 

card allows the holder to get services in any centre where the card 

is acceptable. The amount spent is deducted from the holder's 
bank account. 

 

Speech recognition or voice input 
Voice recognition is a type of input method where a microphone is 

used to enter data in form of spoken words into the computer. This 

method is mostly suitable for the handicapped especially those 

with impaired hands. Although this is a fast and easier method, it 

has some disadvantages.  

It is complex to develop and it does not take care of speech related 

problem' such as accents, inflections and tone. This implies that the 

device must learn the unique speech of an individual. 
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Touch screen, digitizers and digital cameras 
 
Touch Screen 
Touch screen input method utilises the technology of a touch 

sensitive screen. When the user touches the screen, the computer 

detects the position of the finger and responds accordingly. Touch 

screens are mostly used in public places like in banking halls, 

hotels, in airports (to provide guidance information) etc. 

 

Digitisers 

A digitiser or a graphic tablet is almost similar to a light pen but 

instead it has a graphic tablet on which the user writes on using a 

device similar to a pen, called a stylus. (Figure 2.6). As the stylus 

moves on the tablet, it s drawing is directly reflected on the screen. 

Digitisers are mostly used for architectural and engineering 

designs. 

 
Digital cameras 
A digital camera stores its images in 

digital form. These images can then be 

streamed (entered) directly into a computer 

for editing or printing by connecting the camera to a computer 

using a special cable. As with the ordinary camera, there are two 

types of digitals cameras: One that can takes still images i.e. 

photographs and another that takes motion pictures (video). 

 
The central processing unit (CPU) 
The central processing unit (CPU) also known as the Processor is 

the most important component of the computer. It is actually 

regarded as the brain of the computer. This is so because all data 

processing and control operations are coordinated here. In 

microcomputers, the CPU is housed inside the system unit. It is 

mounted on a circuit board known as, the motherboard or the 

system board. The figure below shows the location where a 

processor called Cyrix is mounted on 

the motherboard. 

The CPU has three different 
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functional units called arithmetic and logic unit, control unit and 

the main memory. 

 

 

 

 

 

Arithmetic and logic unit (ALU) 
The arithmetic and logic unit is a unit of central processing unit 

where all arithmetic and logical operations are carried out. The 

basic arithmetic operations includes; addition, subtraction, 

multiplication and division. Logic operations are based on the 

computer s capacity to compare two or more values. For example, 

it may compare whether a piece of data is greater than or less than, 

equal to or not equal to etc. 

In order for the ALU to be able to process data, it has special 

temporary storage locations called registers, which holds the data 

just before processing. It also holds the results after processing. 

 
Control unit 
Control unit coordinates all processing activities in the CPU as 

well as input, storage and output operations. It determines which 

operation or instruction is to be executed next. To coordinate these 

activities, the control unit uses a system clock. The system clock 

sends electric signals as its means of communication, just like the 

way the traffic signals or a traffic officer does in a round about or 

junction to direct motorists and other road users. The number of 

pulses per second determines the speed of a microprocessor. The 

faster the clock pulses, the faster the CPU hence the faster the 

computer can process data. 

 

Main memory (primary storage or working storage) 
Main memory also known as primary storage provides storage 

location for data and instructions accessed by the control unit. 

Computer memory can be classified into read only memory (ROM) 

and random access memory (RAM). 

 

Read only memory (ROM) 
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Read only memory is used to store programmed instructions and 

data permanently or semi permanently. Data and instructions 

stored in ROM are those required to remain unchanged for long 

periods of time e.g. booting instructions, special purpose 

computers and computerized fuel pumps instructions etc. 

 

Depending on permanence of the instructions or data written on it, 

there are four types of read only memory namely; 

Mask read only memory: Once the content is written on it by the 

manufacturer, it cannot be changed. 

 

Programmable read only memory (PROM): This allows the user to 

alter it only once after the content is written on it. 

Erasable programmable read only memory (EPROM): This has a 

transparent quartz window through which its contents, can be 

erased by exposing it to ultra violet (UV) light, and then 

reprogrammed for another use. 

Electrically erasable programmable read only memory 

(EEPROM): This type of ROM can be erased and reprogrammed 

using electricity. An example of EEPROM is the memory that 

stores the basic input/output system (BIOS). 

Characteristics of read only memory (ROM) are; 

1. One can only read its content but you cannot write on it unless it 

is 

a special type of ROM. 

2. It is non-volatile i.e. its content is not lost when the computer is 

switched off 

3. Stores permanent or semi permanent instructions from the 

manufacturer called firmware. It can store semi permanent 

instructions because some variations of ROM chips can be 

programmed according to the user s specification. 

 

Random access memory (RAM) 
This is the most common type of main memory. It is called 

random access memory (RAM) because; its content can be read 

directly regardless of the sequence in which it was stored. As 
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opposed to ROM, the content in RAM is held temporarily and its 

content is lost once the computer is turned off Therefore, before 

switching off the computer, it is important that one stores (saves) 

his/her work in a device that offers relatively permanent storage 

facility. 

 

Characteristics of random access memory (RAM) are: 

1. Data can be read (retrieved) and written (stored) in it. 

2. RAM is a temporary (volatile) storage because its content 

disappears when the computer is switched off. 

3. Its content is user defined i.e. the user dictates what is to be 

contained in the RAM. 

 

Types of RAM 

There are two types of-RAM namely, static RAM (SRAM) and 

dynamic RAM (DRAM). Static RAM is very fast compared to 

dynamic RAM and holds its content as long as there is power. 

Dynamic RAM on the other hand can only hold its content for a 

short while even when power is all. To maintain the content of 

dynamic RAM, the memory chip is designed in a way that its 

content is refreshed (automatically rewritten) severally per second. 

Static RAM is more expensive. It is mostly used to make special 

types of memories. 

Special purpose memories 
Apart from ROM and RAM there are several types of special 

purpose memories found insijkde the CPU or in the input and 

output devices. These memories are vital because they increase the 

overall performance of data and instructions moving in and out of 

the CPU. These memories include buffers, registers and cache 

memory. 

 

Buffers 
This is a temporary holding place that may be part of the CPU or 

built in an input or output device. Because the CPU is very fast 

compared to the input or output devices, buffers provide temporary 

storage so that the CPU is set free to carry out other activities 

instead of waiting for all data to be entered or information to be 

output. For example since a printer cannot work at the speed of a 
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CPU, the printer buffers temporarily holds the output to be printed 

hence freeing the CPU to perform other functions. Buffers can 

hold more than one piece of data at a time. 

 

 

Registers 

As opposed to buffers, registers hold one piece of data at a time 

and are inside the CPU. Examples of registers are: 

An accumulator: This temporarily holds the results of the last 

processing step of the ALU. 

 

Instruction register: This temporarily holds an instruction just 

before it is interpreted into a form that CPU can understand it. 

An address register: This temporarily holds next piece of data 

waiting to be processed. 

Storage register: This temporarily holds a piece of data that is on 

its way to and from the CPU and the main memory. 

 

Cache Memory 

Most modem processors incorporate small high-speed type of 

SRAM called cache memory. The purpose of cache memory is to 

allow the processor to access data and instructions even faster than 

it would have taken to fetch it from the relatively slow DRAM. 

 

Memory capacities 
Memory and storage capacity is measured in special units called 

bytes. A byte is equivalent to a single character. Characters can be 

a number from 0 to 9, letters A to Z or a special symbo1. For 

example, a number like 2545 has four bytes while the words, My 

Home has seven bytes since, and the space between them has 1 

byte. 

Memory quantities can be expressed in; 

1. Kilobytes (kB): Approximately one thousand bytes.(1024) 

2. Megabytes (MB): Approximately one million bytes.  

3. Gigabytes (GB): Approximately one billion bytes. 

4. Terabytes: Approximately one trillion bytes. 
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Overall functional organization of the CPU 
The arithmetic and logic unit, the control unit and the main 

memory use electrical pathways or links referred to as buses. There 

are three types of buses namely; 

Control bus: This is the pathway for all timing and controlling 

functions sent by the control unit to other parts of the system. 

Address bus: This is the pathway used to locate the storage 

position in memory where the next instruction data to be processed 

is to be found. 

Data bus: This is the pathway where the actual data transfer takes 

place. 

Figure 2.8 is a summary of the overall organisation of the CPU and how 

it controls other computer components. 
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Fig. 2.8 Functional organisation of the CPU 
 
Types of processors and their clock speeds 
 
Processors 
In 1971, a company called Intel that specialises in manufacturing 

central processing units managed to combine the arithmetic-logic 

unit and the control unit on a single tiny processor called 

microprocessor and called it Intel 4004. This microprocessor was 

used in electronic calculators. The first microprocessor to be used 

on microcomputers was called Intel 8086 developed in 1974. Since 

then, there has been a tremendous growth in microprocessor 

technology marked by great increase in processing capability and 

speed. 

Until 1989, Intel corporation enjoyed monopoly in the field of 

microprocessor technology with her famous Intel processors. Since 

then other players joined in and started manufacturing cheaper 

alternatives. These include: Advanced Micro Devices (AMD), 

Cyrix and Motorola companies 

 

Processor clock speed 
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The speed at which a processor executes instructions is determined 

by its clock speed. System clock speed is measured in hertz’s. A 

hertz is a unit of frequency which measures the number of cycles 

per second in a signal. Quantities of the clock speed can be 

expressed in; 

1. Kilohertz (kHz):  Approximately one thousand hertz’s. 

2. Megahertz (MHz): Approximately one million hertz’s.  

3. Gigahertz (GHz): Approximately one billion hertz’s. 

There has been a tremendous growth in the processing capability 

and clock speed of microprocessors. From a speed lower than 

4MHz, modem microcomputers can run at speeds higher 2GHz. 

Table 2.1 shows a summary of how microprocessors have evolved. 

 

Processor Description Clock speed 

Intel 

8086 

The two are almost identical and were 

used 
4.7 MHz-I0 

and 8088 with the first IBMPCs 8086 was an MHz 

 improvement of 8088.  

Intel 

80286 

Provided increased performance over 

8086. 
6 MHz-20 

 
This was the processor that opened up the 

PCs 
MHz 

 to many users.  

80386SX Apart from Intel s 80286, AMD produced 33 MHz-40 

and 
their versions with copied greatly the 

Intel s. 
MHz 

80368DX 
These were the first entry in the processor 

market. 
 

80486SX 
Provided over 100% better performance 

than 
25 MHz-50 

and 80386 and were the first upgradeable MHz 

80486DX 
processors. AMD and Cyrix produced 

their version too. 
 

Pentiums 
Since 1992, Intel decided to coin their 

fifth 
60 MHz- 

(586) and 
generation with the name Pentium instead 

of 
presently 

above 80586. Pent is a Latin word that means Pentium IV 
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five. 

 
Intel chose the word in order to 

distinguish its 
with over 2.8 

 
80586 and above processors from AMD 

and 
GHz 

 Cyrix versions i.e. 5x86 and AMDK5  

 respectively. Examples of Intel Pentium  

 
processor are Pentium Pro, Pentium 

MMX, 
 

 
Pentium II and currently Pentium IV at 

the 
 

 time of writing this book.  

 
Output devices 

Output devices are peripheral devices that a computer uses to give out 

information produced after the processing operations. There are two types 

of output devices namely the softcopy and the hardcopy output devices. 

Softcopy refers to the intangible output mainly displayed on the screen or 

through other output devices such as speakers. A hardcopy is a tangible 

output produced mostly on papers by devices such as printers. 

 

Softcopy output devices. 
Some of the softcopy output devices are; 

 

Monitors 

A monitor or a video display unit (VDU) is the most common output 

device. It displays information on its screen thus helping the user to 

monitor operations carried out by the computer. 
For a long time, monitors have been designed using a long tube called the 

cathode ray tube (CRT at emits light. The screen of a cathode ray tube is 

curved slightly outward forming a convex shape. However, new flat 

displays have come which do not use CRT technology. Flat display are 

more comfortable to use, portable and do not consume a lot of power 

compared to CRT. Figure 2.9 shows a CRT monitor and flat panel display 

monitor. 
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The sharpness or clarity of an image on the screen depends on the type of 

monitor being used. Monitors that display sharp clear images are said to 

have high resolution. The images on the screen are formed by small dots 

called picture elements (pixels). The higher the number of pixels per 

square centimeter the higher the resolution hence the clarity. 

 

There are two types of monitors namely monochrome and colour 

monitors Monochrome monitors display images and text in only one 

colour mostly black and white. Colour monitors can display images and 

text in multiple colours. For a monitor to display information it must be 

connected to a separate piece of circuit board, plugged into the 

motherboard called the video card or graphics adapter. However, some 

motherboards have onboard video capability therefore there is no need for 

a video card. 

 

Examples of graphic adapters are: 

Monochrome display adapter (MDA): This was the first video card that  

was used in early computers. MDA displayed text only in one colour. 

Hercules graphics card (HGC): One weakness of the original MDA 

display was that, it could not support images of any kind. Hercule graphic 

card supports monochrome images in addition to text. 

Color graphics adapter (CGA): This can display text and images using up 

to 16 colours. 

 

Enhanced graphics adapter (EGA): This is an improvement over colour 

graphic adapter but also displayed text and images using 16 colours. 

Video graphics array (VGA): This offers at most 256 colours. 

Super video graphics array (SVGA): This is an enhancement of video 

graphic array capabilities offering over 256 colours. 

 

Small portable laptops, notebooks and even desktop PCs use flat-panel 

display. Common types of this display are: 
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Liquid crystal display (LCD): Liquid crystal displays do not display by 

emitting light of their own. Instead they have tiny liquid crystals that 

reflect light falling on them from the environment. Liquid crystal displays 

are widely used in watches, calculators, cell phones and digital cameras. 

Electro luminescent (EL): These displays are an improvement on LCDs. 

Electro luminescent emits light when electrically charged. This makes 

them clear, sharper and easier to read. 

Gas-plasma: These use a gas that emits light in the presence of electric 

current. 

Thin film transistor (TFT): This is the latest technological advancement in 

displays. It provides high quality output than all the others. 

 

Sound output 
Speakers are used to output sound from a computer. Sound may be in 

form of music, warning, video, interactive communication with a 

computer etc. 
 
Light-emitting diodes (LED) 
These are light emitting components that display light when an electric 

current is passed through them. A good example is the red or green light 

displayed by the system unit to help the user know whether it is on or off. 

Mostly LEDs are used to give warnings the same way a motorist would 

use signals to indicate when he/she is overtaking or taking a turn. 

LCD projectors project the output from the computer to a white board or 

wall. 

 

Hardcopy output devices 
The most common hard copy output devices are printers and plotters. 

 

Printers 

Printers produce a hard copy of information on papers. The quality of the 

hardcopy depends the printer s printing mechanism. There are two types 

of printers namely impact and non-impact printers. 

Impact printers 

The mechanism of impact printers is almost similar to that of an ordinary 

typewriter i.e. they produce characters by using special light hammers 

with characters or pins held on the printing head. To print, a paper is 
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placed behind an ink ribbon. When the hammer strikes on the head, 

character mark is stamped. These printers are noisy and are mostly used to 

produce rough copies. The two widely used impact printers are dot matrix 

and daisy-wheel printers. 

 

Dot matrix printers produce a hardcopy by arranging patterns of dots on 

the paper using pins held in the printing head. Figure 2.10 (a) shows an 

example of an impact printer. Figure 2.10 (b) shows print characters 

formed by a dot matrix printer.

 
 

a daisy-wheel printer has a wheel with petals on which characters are 

mounted. It is so called because it resembles a daisy flower. When 

printing, the wheel rotates allowing the petals to hit a ribbon with 

different characters as they are received from the computer. 

 

Non-impact printers 

These printers do not use the striking mechanism to produce characters on 

a piece of paper. They do not hammer the ribbon hence they are much 

quieter. The major non-impact printers are inkjet, thermal transfer and 

laser printers. 

 

Inkjet printers 

Inkjet printers form characters by spraying ink from tiny nozzles through 

an electrical field that arranges the charged ink particles into characters. 

Inkjets are cheap to buy but expensive to run because of the high cost of 

ink cartridges. Figure 2.12 shows an inkjet printer. 

Thermal printers 

Thermal printers use heat to transfer characters onto a piece of paper i.e. 

they bond characters onto a piece of paper by using hot pins which 

presses against a special ribbon. They are inexpensive alternative to 

inkjets. 

 

Laser printers 
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Laser printers prints by passing a laser beam back and forth over a 

rotating drum. The laser beam draws the image on the drum by static 

electricity. An example of a laser printer is shown in Figure 2.13. The 

charged areas pick up the ink toner from a cartridge, and press it onto the 

paper. Although these printers are more expensive to buy, they are faster, 

and cheaper to run than the inkjets. 

Plotters 
A as shown in Figure 2.14, a plotter resembles a printer but specialises in 

producing big charts such as maps, pictures and drawings. They are 

mostly used for printing geographical, architectural and engineering 

drawings e.g. maps, advertisement posters to be placed on billboards, 

machine parts etc. 

 

2.5. Secondary (auxiliary) storage devices and media 
There is need to have an alternative long-term storage location for data 

and information other than the main memory. These alternative storage 

devices that are not part of the main memory are called secondary or 

auxiliary storage devices. These devices are not directly accessible by the 

cpu. Secondary storage devices that are not housed inside the system unit 

and hence can be carried around to be used with another computer are 

called removable storage devices and media. In order to read or store data 

from a storage media, a device called a drive is required. 

 

Secondary storage devices can be classified according to the technology 

used to record data. The technology could be magnetic or optical. The 

data and instructions held in these devices must first be moved into RAM 

before processing. 

 

Removable storage devices 
 
Magnetic tapes 
A magnetic tape is a ribbon of Mylar (plastic-like) material coated with a 

thin layer of iron oxide. The tape resembles the music cassette used in 

home tape recorders. 

 

In order to read/write data records on the tape, the tape must be inserted in 

a tape drive that rotates the tape allowing a read/write head to perform 
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5.1. the operation. Most computers today don t has tape drives because of 

the advent of better storage devices. Examples of magnetic tapes include: 

reel to reel tapes, cassette tapes and cartridge tapes. 

 

Disadvantages of using magnetic tapes 

1. Magnetic tapes are slow because of the linear storage of data records on 

the tape. This means that you have to access the proceeding records 

before you get the required. 

2. There is a space between successive data records called inter-record 

gap (IRG), which results in wastage of storage space. 

 

Magnetic disks 
They have a magnetic disk platter that stores data. Examples of magnetic 

disks are floppy disks (diskettes), zip disks and jaz disk. 

 

Floppy disks " 

A floppy disk or simply a diskette is made up of a small flexible round 

disk coated with iron oxide. This disk is covered with a plastic protective 

case. Floppy disks are portable thus making them the most widely used 

type of secondary storage device. 

 

Floppy disks are inserted in a floppy drive, which has a read-write head 

that runs over the magnetised spots that contain data. Floppy disks come 

in different sizes with different storage capacities. Initial floppy disks 

were large in size but with smaller storage capacities than the presently 

available 3t-inch which has a maximum storage capacity of about 

1.44MB. Figures. 2.15 (a) shows a typical 3t-floppy diskette while Figure 

2.15 (b) shows parts of floppy disk. 

The structure of a floppy disk platter 

If the protective plastic casing of a floppy disk is removed, a circular 

flexible disk, coated with magnetic material will be revealed. The surface 

of the disk is divided into tiny invisible concentric circles called tracks 

that store data. The tracks are further divided into units called sectors as 

shown in Figure 2.16. 

 

 

Zip disks 
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These are high capacity disks that resemble the floppy disks. They are, 

however, slightly larger and thicker in size. A zip disk can hold as much 

as 250 MB. Zip disks mostly come with separate-portable external zip 

drive. 

 

Jaz disks 
These are small portable disks with high storage capacity of about 1 GB 

to 2GB. They are used for storing data that require large storage. Like jaz 

disk comes with a portable jaz drive. Figure 2.17 below shows jaz and zip 

disks and their drives. 

Care of magnetic storage media 
To care for magnetic media the following rules are to be observed. 

1. Do not expose them to strong magnetic fields. This would erase the 

magnetically recorded data on the disk. Hence do not carry magnets to the 

computer room. 

2. Keep magnetic media away from excessive heat because heat energy 

 weakens magnetic media s ability to store data. 

3. Do not drop the disk on the ground. 

 

Optical (laser) disks 
These are disks on which data is recorded using a laser beam. A laser 

beam is a very strong concentrated light. The beam bums very tiny holes 

(pits) into a thin shiny surface to record data. Likewise a laser beam in the 

optical drive is also used to read, record data on the disk. The advantages 

of optical storage media are: 

1. They store very large volumes of data. 

2. Data stored in them is more stable and more permanent than the 

magnetic media. 

Examples of optical storage disks include: LS-120 super disks (SD), 

compact disks (CDs), digital versatile disks (DVD), optical card and -

optical tape. 

 

LS-120 super disk 
This is a diskette that resembles the 3 ½-inch floppy disk but uses optical 

technology instead of magnetic technology to record data. It has greater 

capacity of storage and greater speed of data retrieval. The LS-120 drive 
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can read and write both the 3 ½-inch, 1.44 MB floppy disk and the 

120MB super disk. (Figure 2.18). 

 
Fig. 2.18 Super disk and drive 

 

 Compact disks (CD) 
Compact disks hold large quantities of data and information. One disk can 

hold as much as 700MB. They are mostly used to store data and 

information that requires a lot of space such as video clips, software, 

sounds etc. Figure 2.19 shows a compact disk. 

Currently compact disks are available in three forms namely: 

Compact disk-read only memory (CD-ROM): These are the type of 

compact disks which, when data is recorded on Them, one can neither 

change them, nor add anything on them. They are mostly used to store 

music recordings. 

Compact disk-recordable (CD-R): These compact disks are initially blank 

but with a drive called CD- Writer, the user can record data, programs or 

information on it. However, once data has been written on it, one can only 

read but not change it. 

Compact disk-rewritable (CD-RW): Unlike the CD-Rs, these types of 

compact disks allows the user to record, erase and rewrite new 

information just as one would with floppy disks. 

 

NB: Both CD-ROMs and CD-Rs are referred to as WORM (Write Once 

Read Many) because they allow the user to record data on them once but 

read the data as often as necessary. 

 

Digital versatile disks (DVD's) 
Digital versatile disks also known as digital video disks resemble compact 

disks in every aspect but the only difference is that they have higher 

storage capacity of up to 17GB which is equivalent to approximately 

twenty six 640MB CDs. They are suitable for recording motion pictures 

such as video because they offer better sound and picture quality than the 

CDs. 

 

Optical card 
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An optical card resembles the magnetic-ink character recognition card but 

instead of having a magnetic stripe, it has an optically recordable stripe 

that stores information. These types of cards are mostly used in banking 

and other business organisations to record customer details. 

 

Optical tape 

This is similar to a magnetic tape only that data is stored on it by using 

optical technology. 

 

Current and emerging trends in laser technology 

The advances in optical storage, digital video clips, voice and sound 

synthesis have formed the basis for modem multimedia technology 

exploited to develop multimedia computers. A multimedia computer does 

not only display text but can also allow the user to have sound playback 

and watch videos and pictures. A typical multimedia computer must have 

the following minimum requirements:  

1. A video graphic array or higher super video graphic array (SVGA) 

graphics card and monitor. 

2. A sound card. 

3. Compact disk or digital video disk drives. 

4. 32 MB RAM or higher. Lower memory is bottleneck to performance. 

 

Today computers can be used to tune to any of the favorite FM or TV 

channels as long as an FM/TV card is installed in the computer. 

 

Fixed storage media 
These are the storage devices that are housed inside the personal computer 

s system unit. An example is the hard disk. However it is important to 

note that some hard disks especially those used in small computers such 

as laptops are removable. 

 

The hard disk 
The hard disk, also known as the Winchester disk is a sealed unit in which 

is shiny, rigid magnetic disks or platters that are arranged vertically on a 
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common axis as shown in Figure 2.20.

 
 
How the hard disk stores data 
Each disk has two read/write heads that read/record data on both sides. 

The surfaces of each disk are divided into tracks and sectors like those of 

a floppy disk. Tracks along the common axis forms an imaginary 

cylinder. Therefore the term cylinder is sometimes used to indicate the 

number of tracks on one surface of a platter. For example if you say that a 

hard disk has ten cylinders then each disk has ten tracks on one surface. If 

the disk has ten platters then one cylinder will have twenty tracks: 

 

As the disk rotates, the read/write head moves in and out over the surface 

to record or read data. 

Hard disks have gained widespread 

popularity because: 

1. They provide permanent, cheap and 

large storage capacity that is 

rewritable. For example a computer 

can have one hard disk of 40 GB storage space. 

2. They are very fast compared to other secondary s rage devices in terms of 

data transfer.  
Care of the hard disk 
Because of the high rotational speed of the disks, it is important to 

observe the following precautions to avoid permanent destruction to the 

hard disk also called disk crash. 

1. Keep the disk away from smoke and dust. Dust and smoke particles can 

cause damage to the surface of the disk by scratching it as the head 

attempts to read data. 
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2. Switch off the computer using the correct procedure. This allows the 

read/write head to move off the disk surface before power is switched off. 

Improper procedure would risk heads crashing on rotating disks hence 

scratching them. 

 

Emerging trends in storage devices 

Because of need for vast storage prompted by today s massive data 

processing applications and need to carry a lot 

of information in easily portable storage 

devices, more advanced and reliable storage 

media are emerging. One good example 

is a storage device called the flash disk that 

is small in size (about 5 x 2 cm) but has 

capacity to store over 600MB ( equivalent to approximately 400 floppy 

disks! !). Figure 2.22 shows a diagram of a flash disk. 

 
2.6 
 
Power and interface cables 
 
Power cables 
Inside the system unit is a special power supply unit that supplies 

power to the motherboard and other internal devices. In order to 

connect the computer to the mains power outlet, you need power 

cables that link the power supply unit to the outlet. 

 

Interface cables 
All peripheral devices are connected to the motherboard hence to 

the CPU by special cables called interface cables. An interface 

cable is connected to the device on one end, and to the 

motherboard via ports on the other end. 

The difference between the power cables and the interface cables is 

that the power cable supplies power to a component while interface 

cables transmit data signals. 

 

There are different types of cables and parts namely; 
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Parallel 
cables 
and 
ports 
Parallel 

cables 

transmit 

information simultaneously using a set 

of many conductors (wires). For 

example if a cable uses 8 conductors to transmit data at the same 

time, it is said to be an 8-bit parallel cable. The advantage of using 

such cables is that they transmit data faster over a short distance. 

These cables are mostly used to connect printers and removable 

storage drives like the zip drive. Figure 2.23 shows an illustration 

of a parallel port and cable. 

 

Serial cables and ports 
Unlike the parallel cables, serial cables transmit one bit at a time. 

Although they are slow, they are much more reliable than the 

parallel ports and therefore, their connector cables can be as long 

as 15 m. Serial cables are generally used to connect devices such 

as the mouse and some serial printers. Figure 2.24 shows a 9 and a 

25 pin serial ports. 

 
Universal serial bus (USS) cable and port 
Universal serial bus is a new standard serial interface that is set to 

replace the conventional parallel and serial cables and ports. 

Currently most peripheral devices are coming with universal serial 

bus ports and interface cable. Although it transmits only I-bit at a 

time, it provides very high-speed and quality data transmission 

over distances of approximately 5 metres. USB supports a wide 

range of peripheral devices ranging from external storage drives to 

digital cameras. Figure 2.25 shows a USB port and its interface 
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cable.

 
If a computer does not have a universal serial bus port, it can be 

bought and fitted on the motherboard. 

 

Small computer systems interface (SCSI) cables and 
port 
This port and interface cables transmit data in parallel but are 

faster than the parallel cables. Another advantage of the SCSI port 

is that one SCSI port allows us to connect up to eight peripheral 

devices. 

 

Other ports and connectors. Other ports and connectors 

include; 

 

5-pin DIN and 6-pin (PS/2) ports 
Originally, most computers used the 

5-pin DIN to connect a keyboard to 

the system unit but the smaller 6-pin 

mini-DIN also known as PS/2 
interface port has almost replaced 

this technology. Currently most 

computers come with the PS/2 

connector as the new standard to connect PS/2 mouse and 

keyboard. Figure 2.26 shows a 5-pin and PS/2 connectors 

showing physical difference in size. I 

Monitor ports 
The two most common connectors used for monitors are the 9- Pin 

D and the I5-pin Hi-D connector as shown in Figure 2.27. They are 

called D-ports because they resemble letter D. 

Fo
r f

re
e K

CS
E 

No
tes

, E
xa

ms
, a

nd
 P

as
t P

ap
er

s V
isi

t h
ttp

s:/
/T

ea
ch

er
.co

.ke
/



 

(Audio connectors 
These are jack 

plugs found on 

a sound interface 

adapter used to 

connect 

speakers, 

microphone and 

other portable audio 

equipment. 

 

2.7` 
 
Basic computer 
setup and 
cabling 
 
 
Having learnt about 

various devices and how they function, it is important to 

familiarise ourselves on how to setup a computer. 

 

Before attempting to carry out any setup activity, observe the 

following precautions should be observed. 

1. Disconnect all devices from power source before starting to 

work on them. 

2. Do not work on any peripheral device without the guidance of 

the teacher.  

3. Never work alone because you may need help in case of an 

emergency.  

4. Discharge any static electricity that might have built up on the 

hands by touching an earthed metallic object and then wearing an 

anti-static wrist member. This is because your body can hold as 

much as 200 volts of static charge that can damage sensitive 

components on the motherboard. 

 

 

Tools and other requirements 
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The tools and requirements include; 

1. Different sizes and shapes of screwdrivers. 

2. Anti-static wrist member. 

3. Pliers with narrow nose. 

4. Manufacturer s manuals for motherboard and other components. 

5. Necessary software.  

6. A dismantled system unit. 

7. Peripheral devices.  

8. Interface and power cables. 

9. Any other as needed. 

 

Connecting devices to the motherboard 
The 

following are 

steps for 

connecting 

devices to the 

motherboard. 

 

Step 1: Identifying motherboard slots and components. 
Before you connect any device to the motherboard, carefully study 

the manufacturer s manual in order to identify the components 

labeled in 
 
Step 2: Connecting the hard disk, floppy drive and 
optical drive. These devices are connected to the motherboard 

using special ribbon cables like the one shown in Figure 2.30. 
The following instructions 

should be observed while 

connecting the devices: 
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1. Wear antistatic wrist member to discharge any static charge on 

the body. 

2. Check that a free drive bay exists to hold the disk drive. 

3. Slide the disk into its bay and screw it into place. 

 4. Ensure that there is a free power connector from the power supply 

unit and connect it to the drive. Notice that it is designed to fit in 

its socket in only one direction. 

5. Identify pin 1 as labeled on the drives socket and match it with the 

red or brown continuous line of the ribbon cable. Most cables will 

only fit in one direction. 

6. Connect the cable both to the drive then to the motherboard.  

7. Repeat this for all the drives. 

8. If installation is complete replace the system unit cover. 

 

Step 3: Connecting other peripheral devices 

To connect a device to the system unit, you need to identify its port 

and interface cable. 

1. Gently and carefully connect the interface cable of each device 

to the correct port and to the device if it is not already fixed 

permanently.  

2. Connect the computer to the power source and switch it on. 

3. Observe boot up information on the screen to see whether power 

on-self test (POST) displays any error message. 

4. A successful boot means that the computer was properly setup. 

NB: If the computer is completely new, programs have to be 

copied (installed) on the hard disk. 

 

2.8 Computer software 
As mentioned earlier, the term software refers to a set of computer 

programs. Its function is to guide the computer in its operations. 

Software can be classified according to purpose or acquisition. 

 

Classification according to purpose: 
Computer software may primarily be designed to manage the 

hardware resources or to help the user accomplish specific tasks. 

Therefore software may be classified as either system or 

application software. 
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System software 

System software performs a variety of fundamental operations that 

avails computer resources to the user. These functions include: 

1. Booting the computer and making sure that all the hardware 

elements are working properly. 

2. Performing operations such as retrieving, loading, executing and 

storing application programs.  

3. Storing and retrieving files. 

4. Performing a variety of system utility functions. 

 

System software is further divided into: 

1. Operating system. 2. Firmware. 

3. Utility software. 4. Networking software. 

 

The operating system 
This is a set of complex programs that work together to control 

execution of user programs called applications and acts as a go 

between (interfaces) between the applications of the computer 

hardware. It manages input/output and storage operations in a 

computer. Examples of common operating systems are Microsoft 

Windows 95/98/2000/XP, UNIX, Linux, Macintosh (Mac OS) and 

OS/2. What type of operating system software do you use in the 

computer laboratory? 

Therefore the operating system is the main program on the 

computer system. 

 

Firmware 

Firmware, also referred to as stored logic is a combination of both 

the software and hardware recorded permanently on electronic 

chips. Usually, a firmware is a read-only memory chip that is 

mounted or plugged into the motherboard. Firmware may hold an 

operating system, utility programs, language processors etc. 

 

Utility software 

Utility software is a special program that performs commonly used 

services that make certain aspects of computing to go on more 
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smoothly. Such services include sorting, copying, file handling, 

disk management etc. The two basic types of utility software are: 

1. System-level utility software: These help the user to work with 

the operating system and its functions. For example, a utility 

software tells the user when he/she enters a wrong command and 

gives suggestions how the error can be corrected. 

2. Application utility software: These make the use of an application 

program smoother and efficient. These utility programs are 

commonly purchased separately or may be part of an operating 

system. 

 

Networking software 
This type of software is mostly used to establish communication 

between two or more computers by linking them using a 

communication channel like cables to create a computer network. 

Networking software enables the exchange of data in a network as 

well as providing data security. Network software may come as 

independent software or integrated in an operating system. An 

example of networking software is novel Netware. 

 

Application software 
Application software, also called application packages are 

programs that are designed to help the user accomplish specific 

tasks. 

.Table 2.2 gives examples and uses of common application 

packages 

 

Software Uses Examples 

Word 

processor 

Typing documents 

like 

Ms Word, Lotus 

 letters. WordPro, 

WordStar. 

Spreadsheets Manipulation of 

numeric data e.g. 

calculating budgets. 

Ms Excel, Lotus 

1 2 3 

Desktop Designing 

publications 

Adobe 

PageMaker, 
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Publisher like newspapers, 

books. 

Ms publisher. 

Computer 

aided 

Technical drawing. AutoCAD. 

Design   

Databases Keeping records 

and 

Ms Access, 

Dbase. 

 files.  

Graphics 

software 

Creating and Corel Draw,’ 

Adobe 

 manipulating 

pictures. 

Photoshop. 

 
Table 2.2: Application packages 
 
Classification according to acquisition 
Generally computer programs can be classified according to how 

they are obtained as in-house developed software and standard 

software (Vendor off-the-shelf software). 

 

In-house developed programs 
These are programs that are uniquely designed and tailored to meet 

a particular user s needs. For example, a bank may decide to 

manage its banking operations using a unique program developed 

by hired programmers. These programs are not available in the 

shops and once developed for one company or user may not 

address the needs of other users. 

 

Standard software (Vendor off-the-shelf software) 
These programs are developed by software engineers, packaged 

and then made available for purchase through a vendor, a 

distributor or directly from the developer. A developer may bundle 

more than one but closely related software into one package to 

form a suite or integrated software as opposed to single-purpose 

software. Examples of suites are Lotus 

 
Suite, Microsoft-Office and Corel WordPerfect while those of 

single purpose are QuickBooks and Sage Line 50. 
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The word package is sometimes used to refer to these types of 

software that are packaged and sold by vendors. 

Advantages of standard software over the in-house developed 

programs are: 

 

1. They can easily be installed and run. 

2. They are less expensive to acquire than the cost of developing 

in-house software. 

3. They are readily available for almost any task. 

4. Since they are thoroughly tested before they are released, 

chances of errors in them are rare. 

 

5. They can easily be modified (customised) to meet specific user’s 

needs without involving expert programmers  

 

 Criteria for selecting a computer system 
The task of determining a suitable computer system for an 

individual or organisation is not easy. A good computer system 

must meet all the requirements of the user. Therefore, before 

selecting the computer system to implement, it is advisable to do 

an analysis of all the requirements necessary in order to avoid 

acquiring a system that may disappoint the users. 

Requirements analysis for selecting a computer system should 

cover the following: 

1. Identifying all user requirements. 

2. Evaluating hardware requirements that will meet the users 

needs.  

3. Evaluating software requirements that will meet the users needs. 

The computer hardware and software to be acquired should 

therefore be able to meet all needs of the data processing 

environment that, they are intended for effectively. 

 

Hardware considerations 
Some factors considered when selecting computer hardware are; 

 

Processor speed 
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The processing power and speed of a computer mainly depends on 

the processor speed. A good computer must have high processor 

speed. For example a few years ago, processors used to have 

speeds of less than 100 MHz. However, today s Pentium 

processors are operating at very high clock speeds of over 4 GHz. 

Scientists and engineers are aiming at producing a processor that 

operates at terahertz (trillion hertz). However, it is important to buy 

a processor that suits ones need not necessarily the fastest. 

Memory capacity 

As earlier mentioned, primary memory, mainly random access 

memory (RAM) is measured in megabytes (MB). For example, a 

computer may have 32MB of RAM. Although, a computer may 

have a very fast processor, it may not perform as expected if it has 

low memory capacity. Because of the current multimedia driven 

applications, a good computer should have sufficient memory to 

handle the heavy applications that require a lot of memory space in 

order to run. A computer with at least 128 MB of RAM is 

recommended for most contemporary applications. 

RAM is packaged as either dual in-line memory Module. (DIMM) 

or single in-line memory module (SIMM). 

Therefore, before one buys a memory module for the computer the 

following factors have to be considered: 

1. The type of module supported by the computer s motherboard. 

2. Does the motherboard have an empty memory slot?  
3. Will the module work well (be compatible) with the other 

existing modules on the motherboard? 

4. What is the capacity of the module? 

 

Warranty 

A warranty is an agreement between the buyer and the seller that 

spells out terms and conditions of, after selling a product in case of 

failure or malfunction. 

 

The most important consideration to make is whether the seller is 

ready to actually provide after sales services. On top of the actual 

cost of the item, most manufacturers and suppliers include a 

certain percentage charge to cover the warranty. 
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A good warranty should cover the following points: 

1. Scope of cover for example six months, one year etc. 

2. Callout response and liability agreement. For example how long 

should the supplier take to repair a fault or replace the product, and 

if he/she delays who bears the cost. 

3. Preventive maintenance for example regularity of service, at 

intervals  etc. 

 

Cost 
The cost of a computer system depends on: 

1. Its processing capability. 

2. Whether it is branded or a clone. Branded computers are more 

expensive than their equivalent clones. This is because of their 

reliability and good after sale services. 

3. Its size. Portable computers are more expensive than their desktop 

equivalents because of the superior technology involved in 

manufacturing smaller components without losing performance 

abilities. 

 

It is important to do a market survey from magazines, newspapers, 

and electronic media or visit a number of vendors to compare 

prices before purchasing a computer. Computer information and 

technology exhibitions also enlighten a buyer on current trends and 

costs. 

 

Upgradeability and compatibility 

When buying a computer, the best option would be to get one that 

can easily be upgraded to accommodate emergent technologies. 

For example some older computers cannot support large hard disks 

available in the market today hence, difficulty in upgrading them 

because smaller hard disks are no longer in circulation. 

 

Portability 

The size of electronic devices including computers has become a 

major consideration because smaller devices enhance mobility. 

 

User needs 
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When selecting computer hardware, consider the unique needs of 

the user. For example if the users have special disability like 

inability to use their hands, consider buying input devices that 

capture data through voice input. 

The user needs also determine the type of data that will be 

processed hence, the choice of the type of hardware most 

appropriate to satisfy the needs. For example in a supermarket a 

special computerized devise called a point of sale (POS) terminal 

is most suitable to record transactions. 

 

Other considerations 
Other considerations for selecting computer hardware are; 

 

Monitor 

Depending on preference, your choice for a monitor may depend 

on size, resolution and the technology used to make it. Currently 

flat panel displays have become a new market standard quickly 

replacing the cathode ray tube (CRT). 

 

Multimedia capability 
This is the combination of video, audio, text and images to provide 

an interactive, creative and effective way of producing and 

communicating information. A multimedia system should have 

speakers, CD/DVD drive, sounds card and a SVGA monitor. It 

should also have software that supports multimedia capability. 

 

Software considerations 
Although one may have a good computer with the best hardware, 

the actual real determinant of a computer s value to the user is the 

software in it that can run to solve the day to day data and 

information processing needs. 

The following factors should be considered when selecting 

software: 

 

Authenticity 

The term authenticity refers to genuineness, validity and or 

legitimacy of an item. When you acquire software from the vendor, 

make sure it is an original copy that is accompanied by the 
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developer s license and certificate of authenticity. This is because 

some people illegally produce pirated copies which is an offence. 

 

Documentation 

It refers to the manuals prepared by the developer having details on 

how to install, use and maintain the software. These include 

installation guide, maintenance guide and a user guide. This 

documentation enables the user to work with the software with 

minimum guidance. 

 

User needs 

The needs of the user determines the type of operating system and 

application programs that should be considered for acquisition. For 

example, if the user needs to type documents most often he/she 

would go for a word-processor. 

People with special disability will require software that recognizes 

other forms of input like voice and natural sound. A good example 

is software used in mobile phones to store voice and allow the user 

to make a call by just calling a name instead of keying in the 

number. 

 

Reliability and security 

People are more comfortable with software that offers good 

security to confidential and private information. 

 

User friendliness 

One of the most important features normally considered when 

using a computer program is its user-friendliness. This is a 

measure of how easily the users can be able to operate the 

computer. Some programs are more user- friendlier than others. A 

lot of research and effort has been dedicated in trying to come up 

with more user-friendly software. The ease of use of a program 

will most likely influence whether the user will prefer it or not. 

 

Cost 

The cost of software is perhaps one of the most controversial 

issues that must be considered carefully. One cannot just go for 

software because it is cheap. Many other factors may force a 
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person to buy far much more expensive software even with 

cheaper alternatives available. However it is illogical to buy 

expensive software if there is a reliable cheaper alternative that 

will meet ones needs. 

In case the off- the-shelf software does not fit the needs of the 

users it would be advisable to develop in-house software solutions 

even though they may be a bit more expensive. 

Compatibility and system configuration 

Software compatibility refers to the ability of the computer to run 

the software depending on the system setup (configuration). For 

example some software may only run on a computer that has 

32MB of RAM and above. Any computer with lower than this, 

will be said to be incompatible. It is important that one reads the 

installation guide and system requirements that comes with the 

software in order to avoid disappointment. 

Portability 

Portability in this aspect refers to whether a program can be copied 

or installed in more than one computer. Although, most software in 

the market today are portable some developers produce software 

which can be installed on one machine only. This means that if one 

has twenty computers, one should buy a license for each. 
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3.1 OPERATING SYSTEMS (OS) 
 
Chapter outline 
 
3.1 Introduction 

3.2 Resources under operating systems control 3.3 Functions of an 

operating system 

3.4 Types of operating systems 

3.5 Factors to consider when choosing an operating system 

3.6 How Windows organizes information 

3.7 Managing files and folders 

3.8 Disk management using Windows 

3.9 Installing Windows operating system 

 

Introduction 

As mentioned earlier, an operating system is the main program that 

controls the execution of user applications and enables the user to 

access the hardware and software resources of the computer. In a 

data processing environment, the user sees a computer as a group 

of application programs that enables him/her to accomplish 

specific tasks. Application programs do not directly utilize the 

hardware devices. They send messages through the operating 

system which has the capability to give instructions to the 

hardware to perform a particular task. An operating system 

therefore, supervises all the other programs in the computer and 

manages access to the hardware as shown in Figure 3.1. 

 

3.2 
 
Resources under operating systems control 
A computer is composed of a set of software-controlled resources 

that enable movement, storage and processing of data and 

information. The resources or devices under the operating system 

control include: the processor, the main memory (RAM), input and 

output device and parts, secondary storage devices and 

communication devices. 

 

The processor 
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The processor is a scarce resource. It executes tasks called 

processes. At anyone time several tasks may require processing 

hence creating competition. The operating system arranges the 

tasks according to priority and has the ability to stop a particular 

task to allow the processor to service another one. 
 
Main memory (RAM) 
At anyone given time so many tasks may require the memory so 

that they can be accessed and processed by the computer. 

However, because memory is also a scarce resource, the operating 

system determines which task will remain in memory awaiting for 

execution and which one will be sent back to secondary storage to 

wait. 

 

Because the operating system is large and very important, it is 

usually installed on the hard disk but must be loaded to RAM 

during the booting process. Not all the operating system can fit in 

RAM so a small special part that contains the most necessary 

commands and procedures called the kernel is the one that is 

loaded. 

 

Input/output devices and ports 
In most cases, the operating system controls all data input and 

information output tasks. Because most input/output devices are 

slower than the processor, the operating system has to control the 

flow of data from the time of input to the time the user receives it 

as information. It ensures that the right data reaches the processor 

at the right time. The operating system also defines the various 

input/output ports found on the computer e.g. printer port. 

 

Secondary storage devices 
The operating system manages the storage and retrieval of data on 

secondary storage devices. It also utilizes the free space on hard 

disks to enhance the performance of the computer by temporarily 

holding tasks 

 

on it that were in RAM ready for processing but have to wait for 

some time. 
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Communication devices and ports 
Communication in this case refers to how the various devices and 

programs in and out of the computer system send and receive 

messages from one another and from the processor. The operating 

system controls the overall communication process between 

various tasks and computers. External communication can be 

achieved by connecting an external device to a communication 

port using a communication medium like cables or even wireless 

communication. 

 

3.3 Functions of an operating system The functions of an 

operating system are: 

 

Job scheduling 
The processor can only handle one task at a time. Therefore, the 

operating system has to determine which task will be processed 

first and makes sure that the one that is currently being processed 

is closely monitored to avoid wasting time in the processor. The 

criteria for selecting which task will come before the other depends 

on many factors. For example, the operating system may decide to 

process smaller tasks before larger ones. 

 

Resource control and allocation 
In order for the processor to be able to recognize and priorities the 

use and requests for resources, it gives each resource a unique 

identification number called an interrupt number. Hence when two 

tasks request to use a resource at the same time, the one with 

higher priority interrupt is granted control. This can be compared 

to the priority given to the presidential motorcade on a busy road. 

Secondly, the operating system tries as much as possible to avoid a 

situation where a particular task holds a needed resource and 

refuses to release it for use by other tasks. When several tasks do 

this, an undesirable situation called deadlock occurs. 

Therefore, resource control and allocation is a core operating 

system function because it determines which task uses a particular 

resource and at what time. 

Input/output handling 
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Every computer has many input and output devices (I/O). Like a 

skilled traffic officer, the operating system coordinates between 

these various I/O and other peripheral devices such as auxiliary 

storage devices, making sure that data flows properly between 

them and sorting out any possible confusion. For example, when 

printing, the CPU directs its attention to the printing function. The 

operating system searches for the printer, chooses the correct one, 

translates the name for the CPU and finally the CPU sends the 

document to the printer. This then makes the CPU available for 

other activities. 

 

Memory management 
All data and instructions must be temporarily held in the main 

memory before and after processing. The operating system may 

organize the main memory into blocks of sizes called partitions. It 

constantly assigns main memory storage partitions to data and 

instructions. To access a piece of data or instruction, the operating 

system knows where to find each piece of data as long as the 

correct address of the partition is used. 

 

Error handling 
The operating system has many ways of alerting the user, of errors 

he or she makes. Many op rating system usually express what the 

error is, and where possible make suggestions on how to correct 

the error. The operating system does this by monitoring the status 

of the computer system and performing error checks on both 

hardware and the software. 

 

Job sequencing 
The operating system keeps a list of jobs or tasks currently being 

run and clocks them in and out of the processor. It also arranges 

them in a particular order to make it easy for the processor to 

execute them and to know how and when to fetch instructions and 

data for each task. 

 

Interrupt handling 
An interrupt is a break from the normal sequential processing of 

instructions in a program. An external request causes the processor 
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to stop executing the current task, and do something else before 

returning the control back to the program that was interrupted. 

 

Each hardware device communicates to the processor using a 

special number called the interrupt request number (IRQ number). 

Fig 3.2 shows the devices assigned to IRQ numbers in Microsoft 

Windows. 

3.4 Types of operating systems 
Operating systems can be classified according to:  

1. Number of tasks handled concurrently. 

2. Number of users. 

3. Human computer interface (HCI). 

 

Classification according to tasks handled concurrently 
 
Single program operating system 
Single program operating system allows processing of only one 

user program in the main memory at a time. This means that the 

user can only run one interactive program at a time. Then the user 

must exit from the program before loading and running another 

program. An example of a single user operating system is MS DOS 

from Microsoft Corporation. 

 

Multi tasking operating system 
This type of operating system allows a single CPU to execute 
what appears to be more than one program at the same time. 

However, internally only one program is being executed at a time. 

The CPU switches its attention between programs as it receives 

requests for processing, executing statements from one program, 

and then from another using the concept of giving a time slice to 

each application. This switching of attention is so fast that it 

appears as if the programs are being executed simultaneously. 

 

Classification according to number of users 
 
Single user operating system 
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A single user operating system is designed for use by only one 

person. It cannot support more than one person and runs only one 

user application at a time. 

 

Multi user operating system 
Multi user or multi access operating system allows more than one 

user to interactively use the computer. It can be installed on a 

computer that is accessed by many people at the same time. 

Examples of such operating systems are UNIX, Novell and 

Windows NT/2000, Linux. 

 

Classification according to interface 
The term human computer interface refers to the method of 

interaction between the computer and the user and determines how 

easily the user can operate the computer. The underlying principle 

in operating system design is to make complex tasks very simple 

for the user to carry out. This is the reason why a lot of time has 

been spent by software developers in trying to come up with user 

friendly interfaces. 

 

Currently the three main types of human computer interface are: 

 

Command line Interface 
The user interacts with a computer by typing a command at the 

prompt found on a command line. A computer reads instructions 

from the command line and executes them. For a command to be 

more user friendly, the words used should be descriptive verbs e.g. 

print, copy etc. Unique abbreviations can also be used e.g. Del Ren  

Chkdsk  etc. 

 

For example, if you are using MS DOS operating system, you can 

copy a file called Fruits.Dat from a hard disk C to floppy disk A as 

follows: COPY C:\Fruits.Dat A:\ 

 

NB: The user must press the enter key for the command to be 

executed. 
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Examples of command line interface are the early versions of MS 

DOS, PC DOS, OS/2, and UNIX. 

 

MS DOS Interface 

 

Menu driven interface 
This type of interface provides the user with a list of options to 

choose from. The interface therefore is suitable for beginners who 

may have difficulties recalling commands. 

 

Some operating systems present the user with simple menus while 

others have sophisticated menus. 

 

The user makes a selection `by typing any of the letters I, V, E, D 

or Q to activate a submenu. 

 

A menu driven interface. 

 

Later versions of DOS came with a menu driven interface called 

the DOS shell or DOS editor  

Menu 

 

The DOS shell 

 

The graphical user interface (GUI) 
This type of interface represents  commands as small pictures on 

the screen called Icons. Icons can be selected to issue a command 

using a pointing device like a mouse. GUI has become a very 

common type of interface because of its user friendliness. 

 

Examples of GUI based operating systems are OS/2 s Presentation 

Manager, Microsoft Windows, Linux and Apple Macintosh.  

 
3.5 Factors to consider when choosing an operating 
system 
When choosing an operating system for a computer, the following 

factors should be considered: 
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1. Hardware configuration or provision of the computer e.g. 

memory size, hard disk capacity, type of processor etc. 

2. Basic design of the computer e.g. is it an IBM or IBM-

Compatible, or an Apple computer.  

3. Applications intended for the computer.  

4. User friendliness or human computer interface i.e. is it 

command line based, menu driven or graphical user interface 

based. 

5. Availability in the market e.g. Microsoft Windows based 

operating systems are very common.  

6. Cost - how expensive is the operating system? 

7. Reliability i.e. can it run without crashing or hanging i.e. stop 

responding to commands. . 

 

3.6 How Windows organizes information 

 

Introduction 

Microsoft Corporation is a software company that specializes in 

the development of both operating systems and application 

programs. Some of its popular operating systems include; Windows 

95, 98, 2000, NT, Millennium (Me) and XP. These operating 

systems have gained wide popularity with many PC users because 

of their friendly graphical user interface. 

 

Other operating systems that rival Microsoft products include 

Linux, UNIX, Mac OS and OS/2. 

 

NB: In order to understand how an operating system organizes 

information, this book cuts across four versions of Windows i.e. 

Windows 95, 98, Me and XP, by giving standardized procedures 

that are common to all. However because it is hard to cater for the 

small differences in the four versions, the book provides a common 

procedure of carrying out Tasks. However, extra details on specific 

versions are discussed in appendices L II and III. 

 

The good thing about all the versions of Windows discussed in this 

book is that once you acquire basic skills in using one version, you 

can easily transfer the same to other versions. 
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Some common features in Windows operating systems:  
1. They all have similar user interface 

2. Ability to handle long file names. As opposed to MS DOS which 

can handle a maximum of eleven characters, Windows 95 and later 

versions accept file names of up to 255 characters including 

spaces. 

3. Various versions of Windows operating systems automatically 

accept a new hardware once it is connected to the computer. This 

feature is referred to as plug and play {PnP}. 

4. They all support multiple tasks and multiple users. 

Windows manages data and information stored on secondary 

storage devices by organizing it into easily accessible units called 

files and folders. 

 

Files 

A file is a collection of related data or information stored in one 

location and given a unique name that enables the operating system 

to identify it during storage and retrieval process. Every file has 

details that indicate the following: 

1. A unique name and an optional set of maximum three characters 

called an extension e.g. a file named JUNE.DOC has JUNE as the 

name and DOC as the extension. The file name and the extension 

are separated by a period (.). The extension usually suggests the 

type of information held by the file e.g. DOC suggests that it is a 

document file created in an application program called Microsoft 

Word. 

 

2. Its size and date of creation. 

 

There are two types of files namely; system file and application 

files. 

 

System files 

These of files contain information that is critical for the operation 

of the computer. For example, all hardware devices are tested and 
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made ready (initialised) during boot up by having the computer 

read information 

From special system files. These files in Windows would have 

name extensions like .sys, .ini and .dll. An example of a system file 

is system.ini 

 

Application files 
They are also called program files because they hold programs or 

application files. They may have extensions such as .exe. 

The following list gives some common file name extensions and 

suggests the type of information that could be held in the file. 

 

Extensions                                                 Type of information 

     DAT                                                        Data files 

     EXE                                                         Executable file that 

starts an application  

      TXT                                                        Text files 

     DOC                                                        Document file 
 
When naming files, it is important to give meaningful names and 

extensions that suggest its content. For example when saving a 

letter written to John, give it a name such as Johnletter. The name 

extension is automatically added by the application being used. 

 

Folders 

A folder or a directory is a named storage area where the user can 

store related files to enable easy access. Like with an ordinary file 

cabinet, a folder is meant to help the user divide a large storage 

media into small manageable storage locations. 

 

Subfolders 

A large folder may be divided into smaller units called subfolders. 

Therefore, a subfolder or subdirectory is folder/directory within 

another folder/directory. 
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In Windows, folders and subfolder icons mostly appear in yellow 

color while file icons are mostly white with a fold at the top right 

hand corner 

Storage media 
When saving a file or creating a folder, identify a storage location, 

which is more reliable and sufficient. For example, if a file or 

folder requires more than 1.44MB of storage space, you can not 

use a 1.44MB 3 inch. floppy disk instead use a storage media with 

larger space. 

 

Windows desktop 
Once you switch on the computer, Windows is automatically 

loaded into the main memory and a mostly empty screen called the 

desktop appears. This shows that the computer is ready for use. 

 

Some versions of Windows e.g. Windows XP, prompt the user to 

press Ctrl +Alt +Delete to gain access to desktop features through 

a process called Log on. 
 
Desktop features 
On the desktop are icons and a long thin bar called the task bar. 

Figure 3.8 shows a Windows Me desktop. 

 
Icons 
Icons are mostly manipulated using a pointing device e.g. the 

mouse. Some of the common icons on the desktop are My 

Computer; Recycle bin, Internet Explorer, and My Documents. 

 

The task bar 

The taskbar enables the user to easily switch between different 

programs and documents (tasks) that are currently running. 

 

Whenever the user starts a program or opens a file, its button 

appears on the taskbar and stays there until the user exits from the 

program see Figure 3.9. You can switch between various programs 

and documents in Windows by clicking these buttons. This process 

is called multi tasking. 
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The taskbar has at least three main parts. 

Start button: The leftmost button on the taskbar that the user clicks 

to display the start menu. 

Task manager: This is the plain stripe that displays buttons of all 

currently running tasks. The task manager of Figure 3.9 shows 

OPERATING SYSTE is the currently running task 

System tray: This is at the right most part of the taskbar. It has 

icons of tasks running in the background put are not displayed on 

the screen. Examples are the time and calendar, an antivirus 

program, volume control etc. To display such a task, simply double 

click its icon. 

 

The start menu 

When you click the start button, a list of choices appear called the 

start 

menu. The items on the menu may vary depending on the version 

of Windows you are using. Figure 3.10 (a) and (b) shows Windows 

Me and Windows XP start menus respectively. From careful study 

of the figures, you will notice slight variations but most commands 

on the menu items remain the same. 

 

Programs 
This menu displays a list of all programs installed in the computer. 

The menu has a small solid arrow. When you point at it, another 

list of menus called a sidekick menu will be displayed as shown in 

Figure 3.10 (a) and (b). 

 

Documents / my recent documents 

Documents menu in Windows 95, 98 and me or my recent 

documents in Windows XP lists the last fifteen recently accessed 

files. You can open any of the listed files from a storage device by 

clicking its name provided that the device is accessible. 

 

Settings / control Panel 
Settings menu in Windows 95,98 and Me or the control panel in 

Windows XP provides tools which the user can use to maintain 
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and make changes to the computer setup. It is important not to 

tamper with this menu because you may interfere with the 

computer functionality. 

Find / search 
Find in Windows 95,98,and Me or Search in XP helps the user to 

search for a file or folder in case the user forgets its name or 

location. 

 

Help / help and support 
The help command on the start menu, displays detailed 

information on how to use the operating system and solve some 

computer related problems in case of the computer fails to function 

properly. 

 

Run 
It enables the user to: 

1. Install programs on the hard disk. 

2. Open files and folders from a storage location. 

3. Run programs from removable media without necessarily 

installing it on the hard disk. 

 

Log on / log off 

Log on is a security measure that restricts unauthorized uses from 

accessing computer resources. It prompts for a user name and 

password in order to gain access. After using the computer, log off 

the computer before leaving. 

 

Shutdown 
This menu lets the user shut down, restart the computer, or restart 

in MS-DOS mode. Windows Me and Windows XP do not have 

MS-DOS in their shut down dialog box, see appendix II and III. 

Every time you finish using the computer you must first shut it 

down before turning it off. To do this you need to: 

1. Click the start button 

2. Point and click shutdown a prompt for Windows 98 will appear. 

3. If you want to shut down, click the shutdown button  

4. Finally, click ok or simply press enter 
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5. Wait for the computer to display a message, It is now save to 

turn off . Some computers automatically switch themselves off 

once you click ok. 

 

3.7 
 
Managing files and folders 
To manipulate files and folders, you can either use My Computer 

icon from the desktop or Windows explorer from the start menu. 

Each in its own way lets you see how storage devices or locations, 

files and folders are arranged. These tools also enable the user to 

manipulate files and folders. 

 

Windows explorer 
Windows explorer lets the user display the drives and folders in a 

hierarchy or tree structure. The computer tree is an up side down 

structure with the highest level being the root. The explorer divides 

the window into two panes. The left pane displays a tree of drives 

and folders while the right pane displays a list of files and sub 

folders contained in a particular open drive or folder. 

 

To display the Windows explorer in some versions of Windows 

like 95/98 carry out the following procedure: 

1. Click the start button then 

2. Point to the programs menu 

3. From the Programs go to the sidekick menu, click windows 

explorer 

 

An explorer window such as the one shown in Figure 3.12 will be 

displayed. 

NB: In some operating systems, Windows explorer command may 

not necessarily be located on the program s menu. The other 

method of displaying the explorer window is to: 

1. Right click' my computer icon on the desktop. 

2. Point and left click explorer from the shortcut menu. 

 

This method of displaying the explorer window has been adopted 

as the standard way of displaying the explorer window throughout 
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this book to take care of various versions of Windows operating 

systems. 

 

In Figure 3.12, the highest item in the tree is the desktop then 

followed by My Computer. If you observe keenly, you will notice 

that some items have a small box on their left with a plus or minus 

sign inside. If an item has the plus sign on its left, it contains other 

lower level items e.g. My Documents folder in the above figure, 

has subfolders inside. To display the subfolders, click the plus sign 

and the sign will change to minus meaning that all subfolders in 

that level have been displayed. You can reduce (collapse) the tree 

by clicking minus sign. 

 

Using My computer 
Double clicking on my computer icon, gives you a graphical view 

of what is inside the computer. This includes the drives, the control 

panel and other resources as shown in Figure 3.13 (a). 

To display files and folders from a particular drive proceed as 

follows: 

1. Double click a drive icon. A window appears displaying files 

and folders stored in the root of the drive in question. The root is 
considered to be the highest level of the directory tree where all 

directories/folders start. 
2. Double click a folder to display its contents. 

3. Double click the hard disk (drive C). Its content will be 

displayed as shown in Figure 3.13 (b). 

4. From this window you can start manipulating your files and 

folders. 

 

4. 

 

Creating a new folder 

There will be times when the user would want to create new 

folders. Say, for instance, when working on a detailed project that 

has multiple files. It is advisable that all related files be kept 

together in one folder. To create a new folder proceeds as follows: 

1. Using My computer icon display the Explorer window. 
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2. From the folder tree on the left pane, select the location in which 

you want to create a new folder. 

3. From the File menu, click New then click Folder as shown in 

Figure 3.14 (a). Anew folder with a temporary name New folder 

appears in the explorer window as shown in Figure 3.14 (b). 

4. Type a new name for the folder to replace the temporary name 

then  press Enter key or click the icon once. 

NB: To create a subfolder, follow the steps above but select a 

folder as the location. To open a folder proceeds as follows: 

1. Using My computer icon display the Explorer window. 

2. From the folder tree on the left pane, click the plus sign against 

the storage location that contains the file or folder you wish to 

open. 

3. From the folder tree, select the folder. Its contents will be 

displayed on the right pane. 

 

Creating a new file . 

Depending on the programs installed in your computer, you can 

create files of different types such as drawings, text document etc. 

To create a new text document proceed as follows. 

1. Using My computer icon display the Explorer window. 

2. From the folder tree on the left pane, select the location in which 

you want to create a new file. 

3. From the File Menu, point new 

4. Select text document from a list of available applications and an 

icon with a temporary name appears in the explorer window. 

5. Type a new name for the new file to replace the temporary name 
and press enter key. 

NB: In Windows, file names can contain up to 255 characters, 

including spaces but, with no special symbols such as \ /: *? < > I. 

 

The application Window 

In order to enter data in the new file just created above, you have 

to open it in its application program. This can be done by double 

clicking the file icon. A rectangular area called an application 

window appears on the screen as shown in Figure 3.15. 

 

Parts of a Window 
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Title bar 

This is a bar across the top of the window that displays the name of 

the current application program or task. 

On the right of the title bar are three tiny buttons namely: 

Minimize button: It reduces a window by pressing a button which 

is placed on the taskbar. 

The restore/maximize button: It stretches the window to cover the 

entire desktop or restore it to its original size. 

The close button: It is used to exit an application. 

 

Menu bar 

Menu bar provides a list of commands that can be used to 

manipulate a task. For example, to save a document, click file and 

then save. 

Too/bars 
These are buttons arranged in a row that are shortcuts to menu 

commands. 

 

Work area 
This is the working area where you can create your documents. 

 

Status bar 
This is an interactive strip at the bottom of the application window 

that acts as a communication link between the user and the 

operating system. Such interactive activities include saving, 

opening a file, printing, cursor position etc. 
 
Scroll buttons and arrows 
Scrolling is the moving up, down, left or right of a document 

window on the screen if it is too large to fit. Scroll buttons and 

arrows are horizontal and vertical buttons at the borders of a 

window used to scroll through long document. 

 

Saving changes to a file 
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After typing the content of the file in the work area, click file and 

then Click save Otherwise, if the file will be saved with a different 

name or location then: 

1.Click file and then save as  

2. From the resulting Save As dialog box, select where the 

document is to be saved then type its name 

3.Click the save button. 

 

Renaming files or folders 

Renaming refers to changing the previous name to a new name. 

To rename a file or a folder proceed as follows: 

1. Using My Computer icon display the Explorer window. 

2. From the folder tree on the left pane, select the file or folder to 

be renamed. 

 

3. From the file menu, click rename 

4. Type the new name, and then presenter key. 

 

Deleting files and folders 
In Windows, when you delete an item from the hard disk, it is 

temporarily held in a special folder called the Recycle bin from 

which it can be restored if necessary. 

 

The recycle bin is a default icon on the desktop therefore it cannot 

be removed. 

 

Warning 

1. One should not attempt to delete system and application files 

from the hard disk. 

2. Items deleted from removable storage are not held in the recycle 

bin and are completely lost. 

To delete a file or folder proceed as follows: 

1. Using My computer icon display the Explorer window. 

2. From the folder tree on the left pane, select the item that is to be 

deleted. 

3. On the File menu, click delete 
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4. A message appears on the screen asking whether you actually 

want to delete the item. 

5. Confirm by clicking yes 

 

Restoring deleted files and folders 
To restore a file or folder from the recycle bin to its original 

location proceed as follows: 

1. Double click the recycle bin icon. 

2. Select the deleted item (or items) to be restored.  

3. Click file then restore 

 

Emptying the recycle bin 
To completely discard files and folders you deleted, you need to 

empty the Recycle Bin. Deleted items take up the same amount of 

disk space they occupied before you deleted them. To free up that 

disk space occupied, you have to empty the bin. 

To empty the recycling bin proceed as follows 

1. Double-click the recycle bin on desktop. 

2. Choose empty recycle bin from the File menu. 

3. Click yes when prompted to confirm deletion of the files. 

 

NB: You can also delete selected items in the recycle bin by 

clicking file then delete 

 

Copying and moving files and folders 

Cut or copy commands are used to move or create a duplicate of an 

item respectively. When you cut or copy an item, it is temporarily 

held in temporary storage location known as the clipboard. To 

copy a file or folder: 

1. Using My computer icon display the Explorer window. 

2. On the edit menu, click copy 

3. Select the drive or folder where you want the item to be copied. 

4. From the edit menu click paste Information or item is pasted to 

a new location 

 

Copy progress dialog will be displayed on the screen as shown in 

Figure 3.16 below 

To move a file or a folder proceed as follows: 
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1. Using My computer icon display the Explorer window. 

2. On the edit menu click cut. 

3. Select the drive or folder where you want the item moved. 

4. From the edit menu click paste. 

5. Move progress dialog will be displayed on the screen similar to 

that of copying in Figure 3.16 but with the word moving in the title 

bar. 

 

Sorting files and folder 

Sorting means arranging files and folders in a particular order 

either alphabetically or by size or date of last modification or 

creation. Widows automatically sorts files and folders into 

alphabetic order but the user can choose to arrange them otherwise. 

For example Figure. 3.17 show how to sort by name. Notice that a 

dot appears next to name to show that it is selected. 

 

Manipulate files and folders using the shortcut menu 
When you right click an item, a shortcut menu is displayed which 

provides commands commonly used to manipulate the item. 

To copy, move, delete or rename an item proceed as follows:  

1. Right-click the file or folder to display its context sensitive 

menu.  

2. From the shortcut menu, left click the appropriate command i.e. 

(a) To copy or move, right click the destination location then click 

paste 

 

(b) To delete, simply click delete Command. 

(c) To rename, type in a new file name to replace the old one. 
 
Manipulate files and folders by drag and drop 
Another easier method of handling files and folders is drag and 

drop. This is done as follows: 

1. To copy a file or folder, hold down the CTRL key while you 

drag the icon of the file to a new location. 

2. To move files from one location to another on the same drive 

but in a different folder, simply press down the Mouse button and 

drag the item to the new location. 
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3. To delete any file or folder drag it into the recycle bin. 

4. To copy file or folder from one disk to another, simply drag the 

item to the destination drive icon e.g. from drive C to 31/2-floppy 

disk. 

5. To move an item, hold down the Shift key while you drag it to 

new location. 

 

Selecting multiple files and folders 
If you want to manipulate multiple files or folders at a go, you can 

select them by clicking each item while you hold down the control 

(CTRL) or SHIFT key. 

 

If you want to select all files in an open folder, click edit then 

select all. This will highlight all files in the folder. To manipulate 

the selected items, use the menu bar or the shortcut. 

 

Searching for files and folders 
To search for a specific file 'or folder proceed as follows: 

1. From the start menu, click find /search Figure 3.18 shows a 

Windows 98 find dialog box. 

2. Type the name of the file and the location to look in 

respectively. 

3. click find now button 

 
3.8 
 
Disk management using Windows 
Windows operating system provides the user with tools that help 

him/her to manage storage devices and media. It is important to 

have a routine check of all the storage devices otherwise one may 

end up losing very vital data and programs. 

Warning: Do not attempt these operations on disks without the 

guidance of the teacher. It is preferable to use the floppy disk 

rather than the hard disk to perform these operations because some 

of them can easily lead to loss of data and information stored on 

the hard disk. 

 

Fo
r f

re
e K

CS
E 

No
tes

, E
xa

ms
, a

nd
 P

as
t P

ap
er

s V
isi

t h
ttp

s:/
/T

ea
ch

er
.co

.ke
/



 

Formatting disks 
Before using a floppy disk, it must be formatted. Formatting is the 

process of preparing a new disk for use by imprinting empty 

sectors and tracks on the surface of the disk so that the operating 

system can recognize and be able to access it. Most diskettes today 

are sold readily formatted. Each operating system has its own 

special way of formatting a disk that may make the disk not to be 

read by another operating system. To format a new floppy disk 

proceed as follows: 

1. Put a new unformatted disk into the floppy drive. 

2. Double click my computer icon. 

3. Right click the icon labeled 3 1/2-floppy (A:) then select: 

Format. 

4. Select the disk capacity e.g. 1.44MB, format type i.e. either 

quick erase or full 

5. Give the diskettes an internal name (label). 

6. Click start to begin formatting. 

7. Once the process is over, click Close. 

 

Scanning a storage device for problems 
Windows has a disk management tool called the scan disk that 

helps the user check up and repair minor storage problems, such as 

lost storage locations, or damaged surface. To scan a storage 

device the following is done: 

 

1. Double click my computer icon to display the storage devices 

installed on the computer.  

2. Right click a drive icon e.g. 31/2-floppy disk (A:).  

3. From the shortcut menu, click properties then click Tools tab, to 

display a dialog box 

4. Click the check now button 

5. A prompt appears requesting the user to specify scandisk 

options like whether errors found should be corrected 

automatically. 

6. Once scan disk is complete, Windows will give a summary 

statistics on errors encountered if any. 

 

Using disk defragmenter to rearrange storage media content 
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Disk defragmenter is a tool that is used to rearrange scattered 

folders and files on a storage media in order to speed up access to 

files and folders. This enables the read/write head not to waste time 

looking for the same item all over the disk. Figure 3.20 shows a 

disk before and after defragmentation. Notice that the fragmented 

disk has related data elements spread all over it but the 

defragmented one has related data consolidated close to each other. 

 

To start disk defragmentation proceed as follows: 

1.Double click my computer icon to display the storage devices 

installed on the computer. 

2. Right click a drive icon e.g. 3 1/2-floppy disk (A:). 

3.From the shortcut menu, click properties then click tools tab 

4. From the dialog box displayed, defragment now button 

5. From the dialog box displayed, click defragment a process status 

bar is displayed. 

6. Wait for the process to complete then close the defragmenter. 

 

Compressing the storage media 

Windows provides the user with two compression tools namely, 

compression agent and DriveSpace. Compressing storage media 

contents to fit in smaller space helps to create more free space on 

the media. 

 

DriveSpace can use the free space on an uncompressed drive to 

create. a new, empty compressed drive called a host. To compress 

a disk proceed as follows: 

 

1. Double click my computer icon to display the storage devices 

installed on the computer.  

2. Right click a drive icon e.g. 3 1/2-floppy disk (A:) 

3.From the shortcut menu, properties If you are using windows 

XP select the Compress drive to save disk space, check box then 

click ok as shown in Figure 3.21 (a). If using windows 98 click the 

compression tab then click compress drive button. (Figure 3.21 

(b)) 

4. In confirm attribute changes, select the option, you want 
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NB: If you are using Windows 95/ 98, click the start button, point 

to programs, accessories, then system tools and select compression 

agent or DriveSpace. 

 

From the compress dialog box, click drive then compress 

 

Scanning for viruses 
A computer virus is a program written by malicious persons aimed 

at conducting unwanted operations like damaging disks and data. 

Severe virus attack can result in system failure. There are literally 

thousands of these evil programs that can get into a computer via 

infected floppies or even via electronic mail and the Internet. 

 

Cleaning infected storage devices 
To guard a computer against virus attack, special programs called 

antivirus software such as Norton Antivirus, PC-cillin or McAfee 

should be installed on the computer. These programs can check 

your system for thousands of known viruses and eradicate them. 

To scan for viruses the following is done: 

1. Double click my computer 

2. Right click a drive icon. 

3. From the shortcut menu displayed, select the name of the anti-

virus program e.g. Scan with Norton Antivirus. 

4. Follow the instructions displayed by the anti-virus program to 

start scanning. 

Backing up Data 

Windows comes with a utility called backup. It enables the user to 

create copies of data and programs (on separate storage device) to 

avoid losing important data and program files in case the storage 

device or the computer fails. It is good practice to keep backups 

away from the computer room to ensure security of the information 

in case of a calamity such as fire. To create a back up proceed as 

follows: 

1. Click the start-button, point to programs, accessories, system 

tools then click backup 

2. If a welcome to Microsoft Backup dialog box appears, click ok 

to close it. 
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3. In the Microsoft Backup dialog box, select the files and/or 

folders you want to backup by placing checkmarks next to their 

names. When all the files in a folder are selected, it will appear 

gray. 

4. Follow the on screen instructions to accomplish the operation. 

 

Restoring backed up data 
To restore backed up data proceed as follows: 

1. In the main backup window, choose there store tab. 

2. Select the back up files to restore, choose next step and follow 

the Instructions on the screen. The backed up data will be restored. 

 

The startup (Boot up) disk 
Suppose the hard disk is seriously damaged, and the computer 

cannot start Windows. The only other option available would be to 

start the computer using a startup disk that has booting 

instructions. The start up disk is usually a floppy disk that was 

created using the operating system. 

 

To create a startup disk 

1. Double click my computer: icon, then the control panel 

2. In the control panel double click add/remove programs. 

3. In the Add/Remove programs dialog box, click startup disk, then 

create disk. 

4. The startup disk creation progress will be displayed as shown in

 Figure 3.22. 

 

To boot up a computer using the start up disk insert it in the floppy 

drive then switch on the computer. The computer reads the boot up 

instructions from the diskette then displays a command prompt 

such as A:> - that enables the user to type commands. The 

commands help the user diagnose the problems that might have led 

to boot failure. 

 

Partitioning a disk 
Partitioning a disk refers to the process of dividing a large physical 

disk into two or more partitions called logical drives. A logical 
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drive is a drive that can be accessed as if it is a separate disk but in 

actual sense, it is a partition of one large physical disk. 

 

Reasons for partitioning a disk The reasons are: 

1. When the user intends to install more than one operating 

systems on the same disk. Install each on a separate partition. 

2. For purposes of backup on the same disk but different partitions 

so that if one partition fails, the other will still be working. 

 

Partitioning process 
To create partitions, you must have a startup or bootab1e diskette 

and proceed as follows. 

1. Before you switch on the computer, insert the system disk into 

the floppy disk drive. 

2. Switch on the computer and let it boot to A: > prompt. 

3. Type FDISK command at the prompt and press the enter key. 

4. A prompt Do you wish to enable large disk support (YIN) 

appears. Press Y to enable the computer to support large capacity 

hard disks of 500MB and above otherwise press N. 

5. From the menu displayed, Choose 1 (Create DOS partition or 

Logical DOS Drive) as shown in Figure 3.23. 

6. From the sub menu displayed: 

 (a) Choose option 1 to create primary DOS partition that will be 

treated at the bootab1e disk                              or drive C. 

 (b) Choose option 2 to create extended (other) DOS partitions. 

 (c) Choose option 3 to give your extended DOS partitions drive 

labels. 

Once you finish partitioning the disk, reboot the computer for the 

changes to be effected then format the drives created. If you do not 

format the drives, the computer will not be able to access the 

storage media. 

 

NB: You can also use the other FDISK options to display partition 

information or Delete partitions. 

 
3.9   Installing Windows operating system 
 
Installing Windows 98 
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Because the operating system is the supervisor for all the other 

computer programs it must be installed into the computer s hard 

disk before installing any other program. 

 

The term installation refers to the process of copying program files 

onto the hard disk. Installation differs from copy paste process in 

that it is specifically meant to copy executable files in a format that 

allows the computer to run the program. 

 

To correctly install an operating system, carefully study the 

manufacturer s documentation (manuals) in order to get the correct 

information on installation procedures and system requirements. 

For example to install Windows 98, Microsoft recommends that a 

computer should have the following minimum requirements: 

1. At least 486-66MHz Processor. 

2. At least 16 MB of RAM. 

3. At least 170MB of free hard disk space. 

4. A CD-ROM drive because Windows 98 comes a CD-ROM. 

This configuration would work but a Pentium I and a machine 

with 

32MB of RAM and above would be much better. 

 

Installation process 
In order to install Windows 98 on a computer that does not have an 

operating system, the user must have a Windows 98 Startup disk. 

This disk gives the user options for loading with or without the 

CD-ROM support. 

Because Windows 98 comes on a CD-ROM, you must boot the 

computer With CD-ROM support in order for the computer to 

recognise the CD-ROM drive. 

 

A successful boot displays the prompt; A :> -' Then 

1. Type the drive letter that represents the CD-ROM drive at the 

prompt e.g. A :\> D: then press the enter key. 

 

The prompt should change to the letter that was typed to represent 

the CD drive e.g. D: \> 
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This means that the computer is able to read whatever is in the CD-

ROM drive. 

2. Type SETUPEXE e.g. D :\> SETUP then press the enter key. 

 

First Setup scans the available disks for errors and if an error is 

encountered, it is fixed but if it is more serious, the setup process is 

halted. 

 

After this, the setup program (Wizard) asks you a few questions, 

gets you accept the license agreement and enter the product key. 

See Figure 3.24. 

 

The rest of the installation is automated. All you need to do is just 

relax and let the wizard complete the installation task. 

 
Troubleshooting Windows related problems 
The term troubleshooting refers to the process of diagnosing and 

trying to fix (resolve) hardware or software related problems. 

When using 
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Windows, you may experience some problems such as; 

1. Failure to load the operating system during the booting process. 

2. The computer hangs (stops responding) now and then. 

3. Abnormal restarting. 

4. Displaying a blue screen with a message such as Fatal exception 

 error has occurred etc. 

 

These problems may be due to one of the following reasons: 

1. There may be hardware conflict or incompatibility caused by 

interrupt request (IRQ) or missing Widows device drivers such as 

Himem.sys (device drivers in Windows that helps in allocation of 

main memory) 

2. There was a problem in the installation process e.g. missing 

system files that could not be copied due to a damaged installation 

disk. 
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3. There may be a problem with your hard disk boot sector either 

due to virus infection or damage.  

4. Insufficient system memory. 

5. Corrupted system Windows registry. Registry is a database 

where Windows stores its configuration information such as 

system hardware, installed programs, and property settings. 

6. Due to interrupt request conflict i.e. if two devices are sharing a

 common interrupt request number. 

 

To resolve these problems you need to: 

1. Study the troubleshooting guide that comes with the operating 

system 

2. During the booting process, hold down the F8 key on the 

keyboard in order to get the start-up options from which you can 

choose to start the computer in safe mode or display the command 

prompt. 

This will help you to check whether the problem is due to disk 

failure or corrupted registry. With safe mode, you can establish 

whether the problem is due to corrupted system registry or failed 

devices. If the registry has failed, the computer will prompt you to 

reinstall the registry backup. If the problem is due to disk failure, 

start the computer using the start-up disk and type Scandisk C: at 

the command prompt. Scandisk will establish whether the failure is 

due to bad file or directory structure or damaged disk surface. 

3. Use the device manager found in System properties dialog box 

to check on the devices that are causing problems. You get system 

properties dialog box by right clicking my computer then 

properties 

 

4. Reinstall the operating system if the problems above persist. In 

case the problem is beyond repair. 

 

APPENDIX I 
 
Beyond basics 
 
Arranging multiple application Windows on the desktop 
One of the biggest advantages of multitasking is that one can open 
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and work with several applications. One may wish to arrange open 

Windows either, side by side (Tile) or one on top of another 

(Cascade). 

 

Tiling windows 
 
Tile horizontally 
This arranges all running programs one below the other as shown 

in Figure AI.I. The program in focus will have its title bar 

highlighted. To switch to another program, simply click its title 

bar. To tile horizontally: 

1. Right click the task bar 

2. Click tile windows horizontally 

 

Fig. A 1.1: Tiling horizontally 

 

Tile vertically 
Applications can be arranged down the screen beside each other as 

shown 

in Figure AI.2. To tile vertically: 

1. Right click the task bar 

2. Click tile windows vertically 

Undoing tile 

You can undo tiling by right clicking the from the shortcut menu. 

 

then click 

 

Cascading 

Each window is placed on top of the other with the active program 

being foremost as shown in Figure A1.3. To cascade: 

1. Right click the task bar. 
2. Click cascade windows 

 
Undoing Cascade 
You can undo cascade by right clicking the taskbar, then click 

undo cascade from the shortcut menu. 

 

Customising common features in Windows 98 
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Customising the desktop 
Windows lets the user change desktop appearance and display. 

 

To customise the desktop, right click the desktop to display 

properties dialog box as shown in Figure A.1.4 and make the 

appropriate changes by clicking each tab. 

 

The background 

To set the background 

1. Click the back ground tab 

2. In Wallpaper list, select a wallpaper pattern. 

3. Click on tile to cover entire screen with small wallpaper 

images or stretch to fill the wallpaper with one large image or 

center to let the wallpaper occupy only the centre of the desktop.  

4. Click apply to see the changes before you close the dialog box, 

5. Click ok to effect the changes and close the dialog box. 

 

Setting the screen saver 
If the screen saver is set, it starts playing on the screen if the 

computer is left idle for a set period of time. 

 

To set a screen saver: 

 

1. Click the screen saver tab 

2. Select  a screen saver style from the screen saver list 

3. click apply to see the changes before you close the dialog box, 

4. click ok  to effect the changes and close the dialog box. 

 

NB: To clear the screen saver press the mouse button or any 

keyboard key. 
 
Changing the screen appearance 
This will change the appearance of Windows items such as icon 

size, border colours, highlights etc. 

 

To change the screen appearance: 
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1. Click the appearance tab 

2. From the schemes list box, select the color scheme such as rose, 

storm, Windows standard etc. 

3. From the items list box, select the item that the scheme will 

apply to i.e. icon, desktop, menu bars etc.  

4. Click apply to see the changes before you close the dialog box, 

5. Click ok to effect the changes and close the dialog box. 
 
Set Windows items effects 
With Windows 98, the user can change icon type as well as visual 

effects of most of items such size of icons, animate windows, and 

menus among others. To set Windows effects: 

 

Web 
With Windows 98 you can customise the desktop by integrating 

the Web 
features on it. You can also turn the Web elements into desktop 

elements and update them at any time, this is done by: 

1. Click the web tab to apply web effects on the desktop. 

2. Check view my active desktop as a web 

3. Click apply to see the changes before you close the dialog box. 

4. Click ok to effect the changes and close the dialog box. 

 

Setting display colours and resolution 

The clarity of an object depends on color intensity and resolution 

of the display unit. 

 

To change color and resolution settings 

1. Click the Settings tab. 

2. From colours list box, select the calibration e.g. 256 colours. 

3. Use the slide button to adjust the screen resolutions e.g. 800 x 

600 pixels. 

4. Click apply to see the changes before you close the dialog box.  

5. Click o.K. to effect the changes and close the dialog box. 

 

Setting date and time 
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To set date and time: 

1. Click the start button, point to settings then click control panel 

alternatively double click the Clock on the system tray. 

2. In the control panel, double-click date/time icon. 

3. Adjust date and time accordingly. 

 

Mouse settings 
To change the default mouse button, double click speed and the 

pointer appearance to set a mouse: 

1. Click the, Start button, point to Settings then; control panel. 

2. In the control panel, double click the mouse icon. 

3. Change the mouse properties the click ok. 

 

APPENDIX III 
 
Windows Xp desktop feature 
They re some slight changes on how some icons appear and their 

labeling on the desktop as shown to enhance security, the user has 

to log on by pressing Ctrl + Alt + Del keys in order to use the 

computer resources. 

The start menu 
The start menu layout is slightly different from that of Windows 

95, 98 and Me. The start button displays a pane divided into two. 

The control panel has replaced the settings menu while the shut 

down and log off commands can be accessed on the start menu as 

shown in Figure A3.2 

 

Changing desktop properties 
To change desktop properties: 

1. Right click a blank area on the desktop. 

2. From the shortcut menu, click properties to display the desktop 

properties dialog as shown in Figure A3.3. 

3. To change a property, select a tab associated to the property then 

make the necessary changes. For example to change the desktop' 

background, select the desktop tab as shown and choose a 

background. 

 
Shutting down the computer 
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Simply click the start button to display the shut down dialog box 

similar to the one shown in FigureA3.4. As with Windows Me, in 

XP one cannot also restart in MS DOS mode. New commands such 

as log off Administrator and Hibernate have been introduced. 

 
APPENDIX IV 
 
Glossary 
 
Access time: The length of time needed to write or read data from 

storage. 

 

Application package: It is a program that is used in processing user 

specific needs sometimes called off-the-shelf or canned programs. 

 

Arithmetic and Logic Unit (ALU): A part of the central processing 

unit that performs computations and makes comparisons as 

instructed. 

 

Artificial intelligence (AI): A field of computer technology in 

which researchers and electronic product developers concentrate 

on developing computers that imitates human intelligence. 

 

Bits (binary digits): Since digital computers and computer 

accessories circuitry represent data as a pattern of on and off state 

of electric current, a bit is a 1 or a 0 used to represent the two states 

respectively. 

 

Byte: A group of bits used to store a single character. A byte 

usually consists of seven or eight bits, which the computer handles 

as a unit. 

 

Central processing unit (CPU): This is the brain of a computer, 

which apart from performing processing tasks; it controls all other 

activities of a computer system. 
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Computer hardware: The physical computer equipment one can 

see and touch. Such equipment includes the system unit, input 

devices, storage devices and output devices. 

 

Computer program: A set of instructions that direct the computer 

what tasks to perform and how to perform it. These instructions are 

specially written using a computer programming language. 

 

Computer software: See computer program 

 

Computer system: A computer system refers not only to the 

physically attached devices to the computer but also to software 

and the user. 

Control unit: The part of the CPU that interprets the instructions 

and controls all the operations in a computer system. The control 

unit monitors on the input, storage, the arithmetic and logic 

operations, and the output operations to have the instructions 

carried out. 

 

Data: This are the raw facts represented by numeric, alphabetic 

characters and special symbols that are processed into information 

by the computer. 

 

Data processing: The varied activities performed to convert data 

into useful information. 

 

Desktop publishing: The process of designing and creating 

professional documents such as books, magazines, brochures and 

cards using specialised software such as PageMaker, which 

instructs the computer to size, insert, graphics as well as print a 

document. 

 

Direct access: The ability to go directly to the storage location for 

the particular data required for processing, without having to 

search through all the records from the beginning of the file. 

 

Drive: Devices used to read and/or write (store) data on a storage 

media. 
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Electronic mail (e-mail): A type of mail system that uses 

computers and the telecommunication facilities to transmit 

messages. Messages may be in the form of letters, memos, reports, 

or graphic displays. 

 

Electronic spreadsheet: Computer software that has rows and 

columns used for doing a number of calculations and forecasting 

future trends. 

 

Floppy disk: A floppy disk or simply a diskette is made up of a 

small flexible disk coated with iron oxide. This disk is covered 

with a plastic protective case. It is portable thus making it the most 

common type of storage device used with microcomputers. 

 

Hard copy: Hardcopy refers to the tangible output produced 

mostly on a piece of paper by devices such as printers and plotters. 

 

Hard disk: Also referred to as a hard drive or a Winchester disk, is 

a sealed unit in which are shiny, metallic disk platters and 

read/write heads that reads and records data on the disks. 

 

Information processing cycle: The full set of operations that take 

place, from collection of input data to the availability of output 

(information). 

 

Input: A collection of raw data at the start of information 

processing cycle. 

 

Input/output (I/O) devices: Devices used for entering data to be 

processed and for reporting the results of processing. 

 

Integrated circuits: Thousands of small circuits etched on a silicon 

chip. As these circuits are made more and more compact, they are 

called Large Scale Integrated (LSI) and Very Large Scale 

integrated (VLSI) circuits. 
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Menu: A program s list of user choices or possible actions usually 

shown on the screen. Choices are usually expressed in simple 

language statements for ease of use. 

 

Microcomputer: The name given to a small, low cost computer 

system with a microprocessor as its brain. A microcomputer can 

perform input, processing, storage and retrieval, and output 

operations rapidly, accurately, automatically, and economically 

despite its relatively small physical size. 

 

Microprocessor: A complete central processing unit of a computer 

placed on a single Large-Scale Integrated (LSI) circuits chip. 

 

Minicomputer: A computer having a smaller capacity for both 

primary and secondary storage than medium size and large size 

mainframe computers. 

 

Networks: Communication systems that connect computers, 

terminals, and other electronic office equipment for the purpose of 

efficient communication and sharing of resources. 

 

Operating system: This is a complex program that is responsible 

for controlling processing operations in a computer system. It 

handles input, output, storage and running of other user programs. 

Examples of common Operating Systems are Microsoft Windows 

95/9812000/XP, UNIX and Linux, Apple Mac OS etc. 
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Optical disk: These are disks on which data is recorded using a 

laser beam (a very strong concentrated light). The beam bums the 

thin shiny reflective surface to record data. 

 

Output: Useful information available at the end of the information 

processing cycle. 
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Plotter: One type of graphics printer used to provide hard copy of 

graphical output. The output appears in such forms as multicolored 

charts, graphs, diagrams and maps. 

 

Random-Access Memory (RAM): A type of main memory that 

holds data and information temporarily before and after 

processing. It is called random access memory because the data 

contained in each storage address can be directly retrieved without 

regard for the sequence in which it was, stored. 

 

Read-Only Memory (ROM): The other type of main memory with 

data or instructions permanently or semi permanently recorded in 

it. This means that no new data can be transferred in to ROM 

during processing. ROM is used to store program instructions that 

the computer always needs to operate. ' 

 

Robotics: The use of robots controlled by computer to perform 

work ordinarily done by human beings. Robots usually have 

computer controlled arms and a control camera placed inside that 

enables it recognise different objects. 

 

Scanner: An input device that captures data from source 

documents and objects. 

 

Semiconductor: An electronic component consisting of small chips 

of silicon on which integrated and support circuits are etched. It is 

used for developing microprocessors, primary and other electronic 

components. 

 

Storage: The storing of data and information for future us. The 

length of time the data is stored can vary from less than a second to 

months or even years. 

 

Supercomputer: The largest, fast, and most expensive type of 

computer available. They can perform hundreds of millions of 

complex scientific calculations in a second. 
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Utility program: A collection of instructions designed to make 

common processing operations run smoothly. 

 

Volatile memory: The term applied to semi-conductor memory 

because its content is lost when the electric current is turned off. 

The content must be stored on an auxiliary storage if it is to be 

used again. 

 

Word processing: The processing of textual data to produce 

documents such as letters, reports, manuals, catalogs, newspapers, 

magazines, books or other documents. 

 

 

FORM TWO NOTES 

 
WORD PROCESSORS 

 

Chapter outline 

 

1.1 Definition of word processor.  

1.2 Purpose of word processing.  

1.3 Using a word processing package (Microsoft word). 

1.4 Editing and formatting a document. 

 1.5 Creating and editing a table. 

1.6 Mail merge document. 

1. 7 Inserting graphics.  

1.8 Printing a document. 

Definition of a word processor 

 

What is a word processor? 

A word processor is an application software that enables a person 

to create, save, edit, format and print text documents. Word 

processing is the act of using a word processor.  

 

Examples of word processors 

Examples of word processors include, Microsoft Word, Corel 

WordPerfect, WordStar, Lotus WordPro and many others. 
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A word processor has a number of advantages over he type writer 

that include: 

1. A document can be stored in the computer for future 

reference in computer files that do not occupy physical space 

like the one on paper. This creates a paperless document-

processing environment. 

2. Typing using a word processor is easier and more efficient 

because some actions are automated. For example, word-

wrap feature automatically takes the cursor to the beginning 

of the next line once you reach the end of the current. 

Another automatic features common in most word processors 

is automatic insertion of a new page after reaching the end of 

the current page. 

3.  Most word processors have special editing tools such as 

spelling  and grammar checkers and thesaurus that help the 

user to easily Correct grammar and spelling mistakes. A 

thesaurus helps to find a word or phrase with similar 

meanings. 

4.  With insert and type over modes available in most word 

processors, one can easily insert or replace a word or a phrase 

without affecting the structure and neatness of the document. 

5. Word processors have superior document formatting features. 

Formatting refers to the art of making the document more 

attractive and appealing to the eye. Such features include, 

underlining, boldfacing, italicization, applying different 

colors etc. 

6.  While a typewriter may require that we retype the entire 

document when we want many copies, with a word 

processor, printing lets you produce as many copies per 

session as needed. 

7. Using the cut, copy and paste commands, you can 

incorporate other text without having to retype it. 

 

Basic word processing features and concepts  

1. They allow the user to create a file, save it and open it again and 
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again for reuse, editing or formatting. 

2. They have almost similar document windows with the following

 Features: 

(a) Most are designed to look like a piece of paper with a few  

(b) Most of the screen is blank before typing of text. 

(c) There is a cursor, which blinks at the position where you can 

Begin entering text. 

(d) There is a status bar or line that provides the user with current 

status information such as saving operation, the name of the file in 

use, the current page, the current imaginary horizontal-line and 

column cursor position. 

(e) Word wrap: The feature that automatically moves a word or 

cursor to the beginning of the next line if it does not fit at the end 

of the current line. 

(g) Scrolling: This is the vertical movement of text document on 

the screen. We can scroll through a text document using the up or 

do n arrow keys, page up and page down keys and also using, a 

mouse in windows based word processors. 

(h) Help: Sometimes we get lost, confused or need more 

information on how to use an application. Help contains 

instruction, tips, pointers, explanations and guidance. You can get 

help by either pressing F 1 on the keyboard or clicking Help from 

the menu. 

(i) Editing Modes: Word processors have two editing modes, insert 

and type over mode. In insert mode, every character typed between 

words, lines or characters is placed at the cursor position. This 

pushes all the text in front of the cursor away without deleting it. 

However in type over mode every character typed deletes what was 

there before and replaces it with new text at the cursor position. 

3. Nearly all word processors have a spelling checker, thesaurus 

(Dictionary of synonyms) and grammar checker. 

4. They provide for the use of headers and footers, indexing, 

footnotes and references, typefaces (fonts) and character set. 

5. Most word processors have ability to create and import tables, 

text and graphics from other programs. 

Mostly, word processors are used for writing letters, reports, 

projects, books, essays, memos curriculum vitae etc. 
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Factors to consider when choosing a word processor The choice 

of a word processor depend on: 

1. The type of operating system. For example, most 

microcomputers are currently running on Windows based 

operating system such as Microsoft Windows. This means that you 

should consider acquiring a graphical user interface based Word 

Processor, 

2. Its user-friendliness, i.e. ease of use. 

3. Its formatting and editing features. They should be good and 

varied. 

 

Using a word processing package Microsoft Word 

. 

Microsoft Word is one of the components of Microsoft Office. 

Microsoft Office is integrated software with a number of 

interrelated programs. The programs include Microsoft Word, a 

spreadsheet called Microsoft Excel, and a database management 

system called Microsoft Access, communication software called 

Microsoft Outlook, and a presentation package called Microsoft 

PowerPoint among others. 

Although there are several versions of Microsoft Word, the most 

common are Word 97, Word 2000, WordXP and Word 2003. These 

versions of Microsoft Word are found in Microsoft Office 97, 

2000, XP and 2003 suites respectively.  

Starting Microsoft Word 

There are a number of ways you can start Microsoft Word. 

However the 

Simplest is by using programs start menu. 

 

Starting Microsoft Word from the start menu 

1. Click the start button. 

2. Point to programs/ all programs if you are using Windows XP 

3. Click from the programs menu  

Microsoft Word screen layout 

Once you start Microsoft Word, it provides you with a blank 

document window referred to as the new document template where 

you can create your document.  
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However you may need to use other specialised templates such as 

Faxes and letters, Memos and Web page. How? Click File then 

select New from the menu. The New dialog box in Figure 1.3 that 

appears enables a person to select a template by activating 

templates tab then double clicking its icon. 

 

With Windows multitasking capability, you can have more than 

one document window at the same time sharing one application 

window. However, each document window will have its own title 

bar but both will share other facilities like the menu bar of the 

application window. 

However only one document window will be visible on the 

desktop at a time while others remains minimized or covered. This 

window is referred to as the active document window. To switch 

between document windows, click their buttons on the taskbar. 

 

Parts of a window 

 

Title bar 

A title bar is mostly a blue strip at the top of the window that 

displays the title of the currently running application or task. 

However it is possible to change the color of the title bar using the 

display properties. 

 

The title bar also enables the user to move the window around the 

desktop. This is possible by pointing to it then dragging using the 

mouse. 

 

On the right of the title bar are three tiny buttons called minimize, 

restore/ maximize and the close buttons. 

The minimize button reduces a window to become a button on the 

taskbar. 

 

The restore/maximize button stretches the window to cover the 

entire desktop or restore it to its original size respectively. 

The close button is used to close and exit a window. 
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Menu bar 

Provides a drop down list of commands that one can use to 

perform a task. Examples are File, Exit, Window and Help. Figure 

1.4 shows the File drop down menu. 

Too/bars 

These are rows of buttons or icons that represent commands. The 

command buttons are shortcuts to the same commands you can 

access from the menu bar. There are various toolbars available in 

Microsoft Word but the most common are the Standard and 

Formatting toolbars (Figure 1.5 and 1.6) 

To see what other commands are, just point to the icon on the 

toolbar and a text tip will be displayed showing the function of the 

icon. 

Most of these commands will be discussed later. 

Hiding and displaying the toolbars 

1. Click the View menu option. 

2. Position the pointer on Toolbars. 

3. Click the type of tool bar required to select it. 

 

Selected toolbars have ticks or check marks next to them as shown 

in Figure 1.7. 

Rulers 

Microsoft Word provides the user with vertical and horizontal on 

screen rulers that helps the user position text or objects in the right 

position. 

 

If the ruler is not visible on the screen, then display it using the 

following procedure. 

1. Click the View menu option. 

2. On the drop down menu that appears, click Ruler. A check mark 

or tick will appear next to it showing that the ruler is displayed on 

the screen. 

 

Work area 

This is the working area where you can enter text or graphical 

objects. All windows based application programs provide the user 

with a unique working area suited to that particular application. 
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Status bar 

This is an interactive strip at the bottom of the screen that acts as a 

communication link between the user and the program. It displays 

interactive activities like saving, opening, background printing, 

cursor position etc.  

Scroll bars/button_ and scroll arrows 

Scroll bars or buttons are horizontal and vertical bars on the 

borders of a window that the user drags to scroll upward, 

downwards, to the right or left of a document. Scroll arrows are 

arrows at the end of the scroll bars that the user clicks instead of 

dragging the scroll button. Using scroll bars or arrows is equivalent 

to using the arrow keys on the keyboard 

 

Running the program 

 

Creating a document 

When you start a new document, you will see a blinking vertical 

bar called an insertion pointer. You can move your insertion 

pointer by using the arrow keys or the mouse. 

 

In case you are in Microsoft Word and you want to create another 

new document, you should proceed as follows: 

1. Click the File menu, 

2. Choose new, from the resulting dialog box, click Blank 

Document Or select template by clicking any template's tab 

3. Click the OK button. 

 

Saving a new document 

1. From the file menu, click save or Save As or simply click the 

save Button on the Standard toolbar. The difference between save 

and save as is that although both give the save as dialog box when 

saving for the first time, Save allows the user to save document 

without the opportunity to change the file name or the location. 

Figure 1.9 below shows a save as dialog box. 

2.In the file name box, type a unique name for the document 

3.Select a the location or drive you want to save in, by clicking the 

down arrow on the right of save in list box, 
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4.To save the file in a different format or type such as Word 6.0, 

Word for Macintosh etc. click the down arrow on the right of Save 

as type list box and choose a file type. 

5.Click the save button. The file will automatically be saved as a 

Microsoft Word document. 

Opening an existing document 

1.From the file menu, click Open command or on the Standard 

toolbar, click the Open button. Alternatively press Ctrl + 0 key 

combination on the keyboard. The Open dialog box shown 

appears. 

2.Select a drive or folder where the file is saved. 

3.In the file name box, type or select the name of the document you 

want to open. 

4.Click the open button 

To open a document created in another program, click the file 

format you want in the files of type box, and then double click the 

document name in the folder list. You can also use wildcards in the 

file name box for example, type *. Document to find Microsoft 

Word files. 

 

NB: Microsoft Word keeps a list of shortcut links to recently used 

files on the file drop down menu. If the list of recently used 

documents is not displayed, you can configure Microsoft Word to 

be displaying them by doing the following: 

1. Click the Tools then Options command. This displays the 

options Dialog box. 

2. On the general tab, select the recently used file list check box as 

Shown in Figure 1.11. 

 

Protecting a document with a password 

A password is a combination of characters that prevents other users 

from opening and changing a document without permission. If a 

document is protected by a password, only the person who knows 

the password can open the document or edit it. 

 

To save a document with a password 

1. Create or open the document you want to protect 
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2. From the file menu, choose Save As. 

3. Click the down arrow on the Tools button in the save as dialog 

box  

4. Click General options. 

5. Type in a password in the password to open. This prompts the 

user to enter password when opening a document. 

6. Type in a password in the password to modify. This prevents the 

user from making changes to a document unless the user enters the 

correct password. 

7. Finally click OK. 

 

Closing a document 

Closing a document means unloading the current active document 

from memory so that the user can create or open another without 

necessarily exiting from Word. 

To close a document: 

1. Click the File menu.  

2. Choose Close. 

 

Exiting from Word 

1. To exit from Word, make sure all open documents are saved.  

2. Click File menu, 

3. Click Exit command. 

 

NB: You can exit from Microsoft Word by pressing Alt + F4 keys 

or by double clicking the application icon at the left most comer of 

the title bar. If you have not saved any of the open documents, 

Microsoft Word prompts you to save the document first. 

 

1.4 

Editing and formatting a document 

 

Editing 

Editing refers to making necessary changes to an existing 

document. Apart from manual editing using delete, insert and 

overtype/overwrite commands, Microsoft Word provides the user 

with inbuilt tools such as the spelling and grammar checker, 

thesaurus, undo and re-do, find and replace etc. 
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Block operations 

 

Selecting (highlighting) a block of text 

The purpose of selecting text is to enable the user perform a 

number of editing or formatting operations on the selected block of 

text. Microsoft Word presents the user with a number of ways for 

selecting a block of text. You can either select a block of text using 

the mouse or keyboard. 

 

 Selecting with a mouse 

  1. To select a word, place the insertion pointer on the word then, 

double Click it. 

 2. To select a sentence, positions the mouse pointer at the left 

margin until it changes to a right arrow, and then click once.   

  3. To select a paragraph, place the pointer at the beginning or end 

of the paragraph. Notice that the pointer changes to I-beam. Now 

drag the I-beam over the text to be selected and release the mouse 

button at the end of the text you wish to work on. 

 

Selecting with the keyboard  

1. To select one word, move the insertion pointer to the 

beginning or End of the word then press Shift+Ctrl+Right or 

left arrow. 

2. To select one line, press Shift+Up or Shift+Down arrow key. 

Alternatively, move the insertion point to the end or beginning 

of The line then press Shift+Home or end keys respectively.  

3.To select an entire page; press Shift+Page Down or 

Shift+Page Up. 4. To select the entire document, press Ctrl+A 

or place the cursor at the beginning of the document then press 

Shift+Ctrl+End. 

 

Deleting text 

1. To delete a character or a word from the right to the left, place 

the insertion pointer on the right of the word then press the 

backspace key. 

2. To delete a character to the right of the cursor position, place the

 Insertion pointer on the left of the word then press the Delete 
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key. 

 

To delete a block of text 

1. Highlight the text to be deleted.  

2. Press the Delete key. 

 

Restoring deleted text 

To restore text that has just been deleted in the current word 

processing session: click the Edit menu, then the Undo command 

 

Copying and moving text and objects 

Copying means creating a duplicate of text or an object while 

moving means changing the position of text or an object in a 

document. In Microsoft Word, you can copy or move a block of 

text. 

To copy a block of text: 

1. Highlight the text, 

2. Click Edit, then Copy or simply click the Copy button on the 

standard Toolbar. 

3. Position the insertion pointer where you want to copy the text, 

4. Click Edit then Paste or simply click the Paste button on the 

standard toolbar. 

 

NB: To use the keyboard shortcut keys, press Ctrl + C to copy, 

then Ctrl + V to paste 

 

To move text and objects  

1. Highlight the text, 

2. Click Edit, then Cut or simply click the Cut button (whose icon 

is a Pair of scissors) from the standard toolbar. 

3. Position the insertion pointer where you want the text to be 

placed,  

4. Click Edit then Paste or click the Paste button on the standard 

toolbar. 

 

NB: To use the keyboard shortcut keys, press Ctrl + X to cut, then 

Ctrl + V to paste 
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Typing modes 

There are two typing modes in a word processor that assist the user 

in typing or editing text documents. These are: 

1. Insert mode.  

2. Overtype/typeover mode. 

 

Insert mode 

This is the default mode in most word processors. In this case 

when text is inserted between words or characters it pushes the 

existing text away without replacing it. 

 

Typeover mode. 

In this case, when text is typed between existing words or 

characters, the new text automatically replaces the existing text by 

deleting it. To switch between typeover and insert mode, simply 

press the insert key on the keyboard or double click the OVR label 

on the status bar. 

 

Find and replace 

When you need to search for a word or phrase in a large document, 

use the Find command. In case you wish to replace a word or 

phrase, use the Replace option. 

 

Find 

1. Click Edit menu, then click Find command. The find dialog 

box appears. 

2.  Type the text or phrase you want to search for then click 

FindNext 

3.  Step 2 can be repeated if you wish to find other occurrences 

of the same word or phrase. Click OK when a message 

appears telling you that Microsoft Word has finished 

searching the document. Click Cancel to close the dialog box. 

 

NB: You can use the keyboard shortcut Ctrl+F to find. Some 

search options: 

 

You can specify search options by clicking the more buttons to 
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display them. They include: 

1. Match case: This identifies only text that matches in case 

with that in the find what box e.g. it will not find the word 

DEEN if you typed deen and selected the match case option. 

2. Whole Word: Searches for a word or phrase that is whole. If 

it is part of another word it will not be found, e.g. the word 

ever will not be found in words like however, whenever etc. 

during the search. 

3. Use wildcards: Wildcards are special symbols such as * and? 

That are used to represent a set of words with certain 

characters in common e.g. names like Jeff, Joe, Jane can be 

represented using a wildcard as J* which means all names 

starting with J. 

4. Like: Searches for words, which are similar in pronunciation 

e.g.,  fare and fair. 

 

Replace command 

Click Edit menu then Replace command. The dialog box appears. 

 

Type the name you want to replace in the Find what box and the 

one that will replace it in the Replace with box. Click the Find next 

button to find the next occurrence of the word then click Replace 

button to replace it. To replace all the occurrences of the word in 

the document at once, click the Replace all button. 

Proofreading 

Proofreading refers to checking whether the document has 

typographical or grammar errors. Microsoft Word has tools for 

proofreading e.g. spelling and grammar checker, Thesaurus, 

Autocomplete and Autocorrect. 

 

Spelling and grammar checker 

The spelling and grammar checker is an inbuilt tool that helps the 

user to correct spelling errors and incorrect grammar structures. 

However, the checker can only recognise errors of those words 

whose correct spelling is in its dictionaries. A correctly spelt word 

used wrongly cannot be detected hence the document should be 

proofread just before and after printing. To check the accuracy of 

spelling and grammar: 
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1. Click Tools menu option. 

2. Click Spelling and grammar on the drop down menu. The 

spelling 

And grammar checker dialog box appears as shown in Figure 1.14. 

Words that do not match in the custom dictionary are highlighted 

for correction. The lower plane of the dialog box suggests to the 

user with a list of suggested correct words. 

3. Either choose one of the following buttons: 

(a) Change to correct only the highlighted incorrect word. 

(b) Change all to correct all the occurrences of the misspelled 

word. 

(c) Ignore to retain the highlighted and continue. For example, 

although a word like jembe may not be in the custom dictionary, in 

the Kenyan context, the word is acceptable therefore if highlighted, 

click Ignore. 

(d) Ignore all to retain all the occurrences of the same word or 

phrase in the document from another language e.g. a Kiswahili 

(e) Click Add to add the word into the custom dictionary. 

 

In case you want to undo the changes made, click on the Undo 

button at the lower bottom of the spelling and grammar dialog box. 

 

NB: You can close the spelling and grammar dialog box even if 

the process is not complete by choosing Close. 

 

Using the thesaurus 

This is an editing tool that helps the user find words or phrases 

with similar meaning (synonyms) or opposite meaning (antonyms) 

to the one selected. 

To use the Thesaurus: 

 

1. Select a word or a phrase. 

2. Click Tools, and then point to Language. 

3. Click Thesaurus to see Figure 1.15 displayed on the screen. 

4. For synonyms, under the heading Replace with Synonym, 

choose an alternative word phrase you intend to use as replacement 

for the selected text. 
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5. To replace a word or a phrase with an antonym, select the word 

or phrase with antonym enclosed in brackets. 

6. Click Replace. 

 

Autocomplete The auto complete feature displays a complete word 

when the user types the first few characters of the word. This 

enables the user to type faster by simply accepting the suggested 

word if indeed he/she intend to type it. To accept the suggestion, 

simply press the Enter key, and continue typing other word or 

phrases 

The figure shows an auto text that automatically completes Dear 

sir or Madam text entries. 

 

To turn auto complete on/off 

1. Click Insert menu and point to Auto text. A dropdown list is 

displayed. 

2. Click AutoText. 

3. Select or clear the Show AutoComplete tip for AutoText and 

dates Check box  

4. Type in an Auto text in the Enter AutoText entries here text box 

then Click Add. 

 5. Click Close. 

Autocorrect 

The auto correct feature automatically detects wrongly spelled or 

capitalised words and replaces them with the correct word. 

However, the settings of auto correct are user defined e.g. if a 

person keeps on typing the word certain as certain, set the auto 

correct feature to replace the later with the former. Figure 1.18 

shows the auto correct feature. 

 

To turn auto correct on/off 

1. Click Tools menu, then AutoCorrect. 

2. To turn on the spelling checker corrections, select the Replace 

text as you type check box, and then select the Automatically use 

suggestions from the spelling checker check box. 

3. To turn off the spelling checker corrections, click Automatically 

use suggestions from the spelling checker check Box at the bottom 
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of the dialog box  

4. Click OK to close the dialog box.  

Undo and redo 

Undo: It reverses the last command that was issued in Order to 

revert back to the previous state. To undo, click Edit then Undo 

command. 

Redo: It does the last undone action. To redo, click Edit, then Redo 

Command. 

 

Formatting a document 

Formatting refers to applying various styles or features to enhance 

the document's appearance. You can format text, a paragraph or a 

page. 

Text formatting 

Text formatting refers to features such as changing fonts (type, 

style and size of characters), changing text color, underlining, 

bolding Italicising etc. You can use either the formatting tools bar 

or the Format menu to underline, bold, etc. 

 

To format existing text using the format menu 

1. Highlight the text to be formatted 

2. From Format menu, click the Font command. A dialog box with 

all Text formatting features is displayed  

3. To change font type and size, where necessary scroll down the 

Font list box then click the font required, for example Verdana font 

style would appears as Verdana. To increase the font size, where 

necessary, scroll down the Size list box and select the required size 

e.g. 12 points (pt). A point is 1/72 of an inch in height. 72 points 

i.e. 72/72 is equivalent to 1 inch For example "Verdana" is in 

Times New Roman 16 points and "Verdana" is in Verdana 16 

points. 

4. Bolding text: Bolding makes the selected text appear darker than 

the rest of the text. To bold text: 

(a) Activate the font dialog box.  

(b) From the font dialog box, select Bold. 

5. Underline text: Underlining refers to placing a line at the base or 

bottom of a word or a phrase. To underline: 
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(a) Activate the font dialog box. 

(b) Click the down arrow at the right of Underline style and select. 

The underline style required e.g. single, double, dashed etc. 

6. Italicising text: To italicise is to make the text slant forward.  

(a) To italicise activate the font dialog box. 

(b) Click Italic. 

7. Changing the font color: In most cases, the font default color is 

black. However you can change the font color for example to red, 

green, blue etc. To change the font color, 

(a) Activate the font dialog box 

(b) Click the down arrow at the right of font color list box and 

Select the color of your choice. 

 

Using formatting toolbar 

As mentioned earlier, the formatting toolbar lets the user easily 

format text by clicking the required format button. To format some 

text, highlight it first then click a command on the toolbar.  

For example to bold text, highlight it then click then bolding 

command (B) on the formatting toolbar. 

 

Paragraph formatting 

 

Text alignment 

Text alignment refers to how text is lined up on the page relative to 

the left, right or center of the page. There are four ways in which 

text can be aligned namely left aligned, centered, right aligned and 

justified. 

 

Left alignment 

Lines of text are lined up evenly along the left margin but unevenly 

at The right margin. This is the default alignment. To align left, 

1. Highlight your text. 

2. Simply click the left alignment button. Alternatively click 

format, Paragraph. And select left from the alignment list box as 

shown in Figure 1.20. 

3. Click OK. To apply the choice. 
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Right alignment 

This is opposite of left alignment. Lines of text are lined up evenly 

along the right margin but unevenly at the left margin. To align 

right, 

1. Highlight your text 

2. Simply click the right alignment button. Alternatively click 

Format, Paragraph. select Rigl1t from alignment list box, then 

click OK.. 

Center alignment 

The lines of text are centered unevenly between the left and right 

margins. 

To center text, 

 

1. Highlight your text, 

2. Simply click the Center, button. Alternatively click format, 

paragraph, 

 Select centered from alignment list box, then click OK. 

Justification 

Lines of text are arranged evenly along the left and right margin. 

To justify text, 

1. Highlight your text 

2. Simply click the Justify alignment button. Alternatively click 

Format, 

Paragraph, select Justify from Alignment list box, then click OK. 

 

Change case 

When typing a text, there are a number of cases the user may 

intend to apply in order to create contrast within the text. These 

are: 

1. Sentence case: All the first characters in a sentence are in 

uppercase (Capitalised). 

2. Lowercase: All characters appear in lowercase. 

3. Uppercase: All characters appear in uppercase. 

4. Title case: All the first characters of each word in a sentence 

appear in uppercase. 

5. Toggle case: It changes upper cases to lowercases and vice 

versa. 
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Figure 1.21 shows a dialog box for change case. 

 

To change case in an existing text; 

1. Highlight the text. 

2. From the format menu, click Change case. 

3. From change case dialog box, select the case type to be applied.  

4. Click OK. 

Drop caps 

There are times when you wish to attract the reader's attention by 

making the first character in a sentence large, taking more space in 

the next line. Such kind of a character is said to be "dropped". 

To apply drop cap; 

1. Highlight the first character in the sentence 

2. From the Format menu, click Drop Cap. Drop cap dialog box 

appears 

3. Click Dropped or In Margin 

4. Select font in case you wish to apply a certain font to the 

dropped Cap 

5. Specify the number of lines to drop. 

6. Click OK 

Indenting paragraphs 

Indentation refers to moving the text away from the margin. You 

can indent the first sentence in a paragraph (first line), the whole 

paragraph (full indent) or the rest of the text except the first line 

(hanging indentations). 

First line indent 

1. Select the paragraph to be indented 

2. From the format menu click paragraph. Paragraph properties 

dialog box appears 

3. Click the down arrow in the list box under Special and select 

First Line. 

4. Specify by how far the paragraph is to be indented from the 

margin 

In the by text box  

Click OK to apply the indent and close the dialog box. The 

paragraph will be indented  

NB: You can also indent the first line by positioning the cursor at 
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the beginning of the paragraph then press the Tab key. 

Hanging Indent 

1. Select the paragraph to be indented 

2. From format menu, click Paragraph. 

3. Click the down arrow in the list box under Special and select 

Hanging. 4. Specify by how far the paragraph is to be indented 

from the margin In the by text box 

5. Click OK to apply the indent and close the dialog box. The 

paragraph will be indented  

Full indent  

1. Select the paragraph to be indented or position the cursor 

anywhere in the paragraph 

2. From the formatting tool bars, click the Increase or Decrease 

indent Button 

Setting tabs 

Tabs are used to indent the first line of a paragraph or create 

columnar data. By default the tab stop is set at 0.5 of an inch. To 

change the default setting: 

1. From the format menu, click Tabs 

2. Enter a new value for tab stop in the Tab stop Position box.  

3. Choose the type of tab either left, center or right. 

4. If need be specify the Tab leader option 

5. Click the Set button then OK. 

Setting tabs using the ruler 

The easiest way to set tabs is by using the ruler. On the left comer 

of the horizontal ruler is a tab alignment button that lets the user 

select the type of tab. Figure 1.28 shows various tab alignment 

buttons, while Table 1.1 gives an explanation of each button. 

To set the tab using the ruler; 

1. Click on the tab button to choose the required tab type. Notice 

that the tab type keeps on changing as you click the tab button. 

2. Set the tab stop by clicking where you want it to be on the ruler.  

3. Drag the tab stop 

 

Button Name Purpose 

 Left tab Text is left aligned 

 Center tab Text is centered 
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 Bar tab 
Inserts a vertical line 

at 

  
Tab stop and align 

text to 

  The right of the line 

. 
Decimal tab 

Text is aligned at 

decimal 

 Character 

 Right tab Text is right aligned 

 

Table 1.1 Examples of tabs 

 

Line and character spacing 

Line spacing refers to the vertical distance between lines of text. 

The default line spacing is single spacing. This type of spacing 

accommodates the characters in a text leaving a small extra space 

between lines. Character spacing on the other hand refers to the 

space between the characters in the text. 

 

To change line spacing:  

1. Highlight the text, 

2. From format menu, click Paragraph to display the paragraph 

dialog Box. 

3. Click the down arrow from the Line Spacing list box and select 

the Type of spacing required e.g. double, 1.5, at least etc.  

4. Click OK to effect the changes. To change character spacing: 

1. Highlight the text 

2. From Format menu, click Font.  

3. Click the Character Spacing tab  

4. Adjust the spacing as required  

5. Click OK.  

Bullets and numbering 

Bullets and numbers are used to mark steps in a procedure or items 

in a list. 

To apply bullets and numbers in a list:  

1. Select the list. 

2. From the Format menu, click Bullets and numbering. A dialog 
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box appears. 

3. Do one of the following; 

(a) To apply bullets, click the Bulleted tab. 

(b) To apply independent numbers click the Numbered tab. 

(c) To apply outlined numbered list, click Outline Numbered. Tab  

4. Click OK to effect the changes and close the dialog box. 

  

Section breaks 

A break is used to identify where a section, a column or a page 

ends and the beginning of next. This allows the user to apply more 

than one paragraph or page format in the same document 

especially when it comes to page layout, size, different margins 

etc. 

 

To insert a section break  

1. Position the text cursor in the document where the break is to 

be inserted.  

2. Click Insert then. Break.  

3. From the Break dialog box select the type of section break to 

insert e.g. page break. 

4. Click OK. 

  

Formatting pages 

 Inserting page breaks 

A page break identifies the end of one page and the beginning of 

the next. NofQ1ally, Word automatically inserts a new page after 

the current. One is full. However, there may be a need to start a 

new page even if the. Current one is not full. 

 

To insert page breaks: 

1. Position the pointer where the break is to be inserted.  

2. Click Insert then Break. 

3. From the Break dialog box  

4.  Click Page break then OK. 

 

Creating columns 

To, create columns on existing text: 

1. Highlight the text 
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2. From Format menu, click Columns to display the dialog box 

3. In the columns dialog box, select the number of columns or 

type in  the Number of columns text box 

4. In the Width and spacing boxes, specify the column widths 

and space between columns  

5. Click OK 

Page setup 

Page setup options let the user specify the size of the margins, 

paper size, paper source and layout. 

 

Setting margins 

Margins are blank spaces around the edges of the page. Only text 

and objects inside the margins are printable. 

 

To set up margins: 

1. Click the File menu then Page setup. Page setup dialog box 

appears 

2. Click the Margins tab. 

3. Enter the values for the left, right, top and bottom margins in the 

respective boxes. 

4. Click OK. 

 

Setting the paper size 

By default, the paper size may be either Letter or A4. An A4 paper 

has dimensions 210 mm x 297 mm 

 

To specify a different paper size 

1. From the File menu click Page setup  

2. In the page setup dialog box click the Paper size tab. 

3. Select the size of paper required from the paper size list. If your 

size is different from the ones provided, click Custom size and 

enter dimensions in the height and width boxes. 

4. Click OK. 

Specifying page orientation 

The term page orientation refers to the positioning of the page in 

relation to the text. The two available orientations are: 

Portrait: text and graphics are printed with the longest side 

vertically upright. For example, on an A4 piece of paper, the 210 
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mm edges are at the bottom and top. 

 

Landscape: With landscape, text and graphical objects are placed 

with the longest side of the page placed horizontally and the lines 

of text printed parallel. For example, to create a timetable on an A4 

page, the 297 mm side should be horizontal. 

 

To select the orientation: 

1. From File menu, choose Page setup. 

2. Click on the Paper size tab and a dialog box comes on the 

screen. 

3. Select the orientation required then clicks the OK button. 

 

Page layout 

This option lets the user specify how text will be placed on the 

page from the margins. By default, text starts from the top margin. 

 

To change the layout 

1. From File menu, choose Page setup. The dialog box Appears. 

2. Click on the Layout tab. 

3. From the Vertical alignment tab, select the alignment required 

then click OK. 

 

Inserting headers and footers 

Headers, footers and page numbers make it easy to locate 

information. Headers are few words placed at the top of every page 

while footers appear at the bottom. To insert headers and footers: 

1. Click on the. Headers and Footers from the View menu 

2. In the text boxes that appear, type a header using the top text 

box or a footer using the bottom text box or even both if you are to 

insert both a header and footer. 

Inserting page numbers 

To give your document page numbers: 

1. From the Insert menu, click Page numbers to display the dialog 

box 

2. In the Position box, specify where you want the page numbers to 

be inserted. 
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3. In the alignment box, specify whether the number is to be on the

 right, left, center, inside or outside 

4. Use the Format button to choose the number format, i.e. 1,2,3,..., 

A,B, C  etc. You can start from any page number by using Start at 

box 

 

Creating and editing tables 

 

Creating tables 

A table is a feature in Microsoft Word made up of rows and 

columns that is used to organise and enhance display of 

information. 

 

Creating a new table 

 . . 

You can create a table either by using the Insert Table command 

from tables menu, or by using Draw Table tool that resembles a 

pencil to create more complex tables. 

 

To create a table using the insert table command; 

1. Click Tables menu, position the pointer on Insert, then click 

Table 

2. In the Insert table dialog box displayed, specify the number of 

rows and columns. 

3. Click OK. The table will be displayed on the screen and you can

 start entering data in it.  

NB: You can insert a table by clicking the table button on the 

standard toolbar, then drag to select the number of rows and 

columns. 

 

To create a table using the drawing tool: 

1. Click Tables menu, then Draw table or simply click the Draw 

table button from the standard toolbar. The mouse pointer changes 

to a pencil symbol 

2. Drag the pointer to draw the outline of the table 

3. Fill in the table with rows and columns by dragging the pointer 

as you would draw using an ordinary pencil. 
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Formatting and editing a table 

 

Inserting rows and columns 

To insert a row: 

1. Place the cursor where you want to insert a row 

2. Click Table, point Insert then click Row above or Row below. 

 

To insert a column: 

1. Place the cursor where you want to insert a column 

2. Click Table, point Insert then click Column to left then Column 

to the Right. 

 

Adjusting the column width: 

 1. Position the mouse pointer on the row or column boundary until 

the mouse pointer changes to an arrowed cross.  

2. Drag the boundary to the required size. 

 

Deleting rows, column or cells 

1. Select the rows or columns to be deleted. 

2. From Table menu, point Delete, then Columns, Rows or Cells. 

 

Merging cells in a table 

This refers to combining more than one cell in a table. To merge 

cells: 

1. Select cells to be merged 

2. From Tables, click Merge cells. 

 

Splitting cells in a table 

This refers to subdividing a cell or cells into more cells. To split 

cells: 

1. Select cells to be split 

2. From Tables, click Split cells. A dialog box appears that lets you 

specify the number of rows and columns that the selected cells will 

be split. 

 

Formatting table borders and shading 
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Word provides the user with automatic formatting feature that lets 

you choose border styles and shading. 

 

To format a table: 

1. From Table menu, click Table AutoFormat. 

2. In the formats list box, select the format you want. Note that 

the format you choose applies to borders, shading font and 

colour. 

3. Click Ok to apply the effects. 

NB: You can also format a table by using the table's toolbar. If the 

toolbar is not displayed, click view point to toolbars then click 

tables and Borders. 

 

 

Table conversions 

With convert feature in Microsoft Word, you can convert a table to 

lines of text and vice versa. 

 

To convert a table to text 

1. Select the entire table or row and columns you want to convert 

to text. 

2. From table menu, point to convert then click table to text. A 

dialog box is displayed that requires you to specify how the text 

will be  separated after conversion  

3. In the separate text with box enter or select the character to be 

used as a separator. 

4. Click ok 

 

To convert text to table: 

1. Select the text that you want to convert to a table. 

2. From table menu, point convert then  click text to table 

.A dialog box is displayed that requires you to specify the number 

of rows and  of columns 

3. From Separate text at, specify whether the table will be defined 

by paragraphs, commas, Tabs or other characters. 

4. Click OK. . 
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Importing tables 

Microsoft Word lets you import tables from other applications or 

an existing file. To import a table, 

1. Click the Insert menu then Objects. A dialog box appears 

2. From the Object type select the type of object to insert e.g. 

Adobe table. 

3. The program in which the table was created in starts and lets you 

choose a table from it and return back to Microsoft Word. 

Alternatively click Create from file. This lets you browse for a file 

that contains the table you wish to insert. 

4. Click OK to insert the table. 

 

Performing arithmetic calculations in a table 

It is possible to perform mathematical calculations such as sum, 

product and count, if a table has numerical figures. 

 

To perform calculations: 

1. Click the cell in which you want the result to be placed. 

2. From the Table menu, click Formula. A formula dialog box is 

displayed. 

3. Type the formula you want or select from the Paste function 

box. For example, to add figures in a row or column, click SUM. 

The function in Table 1.2 below that calculates the total is 

=SUM(ABOVE). The word "ABOVE". in brackets is called the 

argument of the formula and tells Microsoft Word which cells in 

the table are to be worked on. 

Sorting 

In Microsoft Word you can sort a list of text, numbers and dates in 

ascending or descending order. 

To sort a list or table: 

 

1. Highlight the text list or table you want to sort.  

2. From the Table menu, click Son. 

3. Select the type of data to be used when sorting i.e. Text, Number 

or Date. 

4. Click either Ascending or decending  

5. Click OK. 
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Mail merge document 

Mail merge is the process of generating personalised letters or 

documents by combining a main document, e.g. a letter, with an 

existing data source such as the address book. Therefore in mail 

merge, the three files created are: 

1. The primary file (main document)  

2. The secondary file (Data source)  

3. Merged file 

To create the main document, 

 

1 From the file menu, select New to create a new document. You 

can also open or retrieve an existing document. 

2. On the Tools menu, click mail merge to display a dialog box. 

3 Click create button, to select the type of document needed e.g. 

form .letters. Select the active window as the main document this 

means that the currently running document will be the form letter 

that will be later merged with a data source to produce 

individualised letters. 

The next step is now to create a data source. 

4. Click Get Data. To use an existing list of names and addresses, 

click 

Open Data. Source To use existing addresses from an electronic 

address book, click on Use Address Book. To create a new list of 

names and addresses, first choose the necessary fields from the 

create data source box then save the record structure. A message 

appears asking you whether you want to edit the data source or the 

main document choose one then the Next.  

5. With the main document open, spot the mail merge toolbar on 

the screen. Position the text cursor where you want to insert merge 

fields. Use the insert field’s button to insert merge fields in the 

document 

Merging the document 

Once you finish inserting merge fields from the data source in the 

main document, you are now ready to merge. There are several 

merge options: 

 

To merge to a new document 
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Click the Merge to new document icon on the mail merge toolbar. 

 

Merging to printer 

Click the .Merge to printer, icon on the mail merge toolbar. Before 

you merge to a printer or other device, you may want to preview 

the appearance of the merged documents. For example, you can 

preview the merged documents one at a time. You can also collect 

the merged documents into a new document, so you can review 

and personalise the documents. 

 

Preview merged documents 

Before you print the documents, ensure that you've inserted merge 

fields in the main document and selected a data source. To 

preview, click anywhere in the main document, and then click 

View Merged Data on the Mail Merge toolbar. 

 

Microsoft Word displays information from the first data record in 

place of the merge fields. 

 

Send merged documents via e-mail or fax 

Click the merge button on the Mail merge toolbar Select e-mail or 

fax in the merge to box. Click the Setup button to specify the e-

mail addresses or faxing number then click the merge button. The 

internet connection wizard starts and if your computer is properly 

configured, the mail merged document will be sent. 

Inserting graphics 

 

Working with graphics 

The term graphics refers to non-text images generated by a 

compute! This includes photographs, drawings and graphs. 

Graphics present information in a form that is easy to understand. 

 

You can insert a graphical object from Microsoft Clip Gallery, a 

scanner or by using drawing tools available in Microsoft Word. 

 

Inserting a clip art or a picture from clip gallery: 

1. Position the insertion pointer where you want your object to be 

inserted, 
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2. On the insert menu, point to picture  then click clipart Click on 

the  tabs to select on the category of 

objects i.e. clip art, pictures, sound or videos. See Figure 1.42. 

3. Double click on the object you want or click it once then click 

the insert button. 

 4. Use the object place holders to resize your object. If you place 

the mouse pointer on one of these holders, it turns into a two 

headed arrow, hold down the mouse button and drag to increase or 

reduce the object size 

5. Click anywhere outside the object to remove the holders. 

6. To move you object to another position, click inside the object. 

The pointer turns into an arrowhead cross. Hold down the mouse 

button and drag your image to a new location. 

 
Fig. 1.42: A clip art image 

Inserting an image from a scanner 

The computer must be connected to a scanner to complete this 

procedure. A scanner is a data capture device that transforms a 

hand copy or real graphical object into digital form. 

 

To scan an object: 

1. Position the insertion pointer where you want your picture to 

appear, 

2. from the insert menu, point to Picture and then click from 

scanner or Camera. 

3. To scan, follow the instructions that come with your scanner. 

4. When the image appears on the screen you can edit and format it 

as required the same way you would with a clipart. 

 

Inserting a picture from another file 
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1. Position the insertion pointer where you want your picture  

placed,  

2.  From the insert menu, point to Picture, then click "From file 

3. Locate the file that contain the image you want to insert eg 

from your floppy disk, from a compact disk etc. 

4. Select the object you want to insert 

5 Then click the Insert button. 

6 When the image appears on the screen you can edit and 

format it as required the same way you would with a clipart. 

 

Editing and formatting pictures 

 

To format or edit a picture: 

Microsoft Word provides the user with a picture editing toolbar 

that lets you adjust the brightness, contrast, change it to black and 

white or grayscale and crop the image. Cropping refers to hiding 

the unwanted details so that they do not come out when printing. 

 

To display the picture toolbar, click on View menu, point to 

toolbars then select Picture. The picture toolbar has buttons that 

enable a person to format a picture to format a picture, click it to 

select it then use the commands on the picture toolbar. 

 

Drawing an object using MS Word drawing tools 

Microsoft Word provides the user with basic drawing tools such as 

polygons, lines, a circle, stars and banners, call outs and many 

others. If the drawings toolbar is not displayed, click on View 

menu, toolbars then click on Drawing. The toolbar will be 

displayed which a button has labeled Auto shapes, an arrow, a line, 

square and a circle 

 

To draw a line, a circle an arrow or a rectangle: 

1. Click on the appropriate shape button. The pointer changes to a 

plus sign. 

2. Place the pointer where you want to draw that shape and drag to 

the required size. 

 

To draw an object using the Auto shapes: 
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1. Click the Auto shapes button. A menu is displayed showing 

categories of shapes you can choose from 

2. Point to the category required then select the type of object you 

wish to draw 

3. Place the pointer where you want to draw that shape and drag to 

the required size. 

 

Editing and formatting a drawn object 

You can resize, move, fill color and change the drawing outline. 

 

To resize or move a drawing. 

1. Click anywhere inside it. The place holders appear. 

2. To move it, hold down the mouse button and drag. 

3. To resize it, place the pointer at one of the place holders and 

drag. 

 

To fill the object with color and fill effects: 

1 Click the object. The place holders appear. 

2 Click the down arrow of fill color button, the one that looks like 

a bucket pouring ink. 

3 Select the color you want applied. To fill the drawing with 

texture, gradient or pattern, click the Effects button. From the 

resulting dialog  box, select the appropriate fill effect. 

Printing a document 

 

Printing in Microsoft Word 

Because the main purpose of any word processor is to prepare 

documents for printing, this cannot be accomplished without a 

printer. The choice of a printer depends on the quality of hardcopy 

desired. Before you print, it is very important that you preview you 

document to confirm that no details are outside the printable area 

and that the document layout is okay. 

 

Using print preview 

In Microsoft Word, to view your document before printing 

proceed as follows: 

1. From file menu, select print preview the mouse pointer changes 

into a symbol that resembles a magnifying glass. You can click on 
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the mouse button inside the document to increase or reduce the 

size of the view. 

2. Click the close button or Esc key to return to your document. 

 

To print: 

 

1. From file menu click on print A dialog box appears where you 

can specify: 

(a) The type of the printer installed in your computer other than 

the default printer. 

(b) Whether to print the whole document or a range in the 

Page range box, 

(c) Number of copies to print per page in the Number of copies 

box then, 

2. Click OK to start printing. 
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SPREADSHEETS MS-EXCEL 

 

Chapter outline 

 

2.1 Definition of spreadsheet 

2.2 Components of a spreadsheet 

2.3 Application areas of a spreadsheet  

2.4 Creating a worksheet/workbook using Microsoft Excel 

2.5 Cell data types 

2.   Cell referencing 

2. 7 Basic functions and formulae 

2.8 Editing a worksheet 

2.9 Worksheet formattin2.10 Data management 

2.11 Charts/graphs 

2.12 Printing worksheets 

 

2.1 Definition of a spreadsheet 

A spreadsheet is essentially a ledger sheet that lets you enter, edit 

and manipulate numeric data. There are two types of spreadsheets 

namely: 

1. The manual spreadsheet. 

2. The electronic spreadsheet. 

A manual spreadsheet is the most commonly used type by book 

keepers as a ledger book with many sheets of papers divided into 

rows and columns on which various amounts of money are entered 

manually using a pen or pencil. You can visit your bursar's office 

and request to see a ledger sheet. 

 

An electronic spreadsheet on the other hand is prepared using a 

computer program that enables the user to enter values in rows and 

columns similar to the ones of the manual spreadsheet and to 

manipulate them mathematically using formulae. ' 

 

In this book, the word spreadsheet shall be used to refer to the 

electronic spreadsheet. '. 
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Advantages of Using Electronic Spreadsheets over Manual 

Spreadsheet 

 

1. The electronic spreadsheet utilizes the powerful aspects of the 

computer like speed, accuracy and efficiency to enable the user 

quickly accomplish tasks. 

2. The electronic spreadsheet offers a larger virtual sheet for data 

entry and manipulation. For example the largest paper ledger you 

can get is one that does not exceed 30 columns and 51 rows while 

with an electronic spreadsheet, the least ledger has at least 255 

columns and 255 rows! 

3. The electronic spreadsheet utilizes the large storage space on 

 computer storage devices to save and retrieve documents. 

4. The electronic spreadsheet enables the user to produce neat 

work because the traditional paper, pencil, rubber and calculator 

are put aside. All the work is edited on the screen and a final clean 

copy is printed. With a handwritten spreadsheet, neatness and 

legibility depends on the writer's hand writing skills. 

5. Electronic spreadsheets have better document formatting 

capabilities. 6. Electronic spreadsheets have inbuilt formulae called 

functions that enable the user to quickly manipulate mathematical 

data. 

7. An electronic spreadsheet automatically adjusts the result of a 

formula if the values in worksheet are changed. This is called the 

automatic recalculation feature. For a manual sheet, changing one 

value means rubbing the result and writing the correct one again. 

 

Examples of spreadsheets 

1. VisiCalc: This was the first type of spreadsheet to be developed 

for personal computers. 

2. Lotus 1-2-3: This is integrated software with spreadsheet module 

graphs and database. 3. Microsoft Excel 

4. VP-Planner etc. 

In this book, the spreadsheet that will be considered in details is 

Microsoft Excel. 

Components of a spreadsheet 

A spreadsheet has three components   

1. Worksheet. / 
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2. Database. 

3. Graphs. 

Worksheet 

This is the component in which data values are entered. It is made 

up of rows and columns. The intersection between a row and a 

column is called a cell. A row is a horizontal arrangement of cells 

while a column is a vertical arrangement of cells. Each row is 

labeled with a number while each column is labeled with a letter as 

shown in the Figure 2.1. Each cell is referenced using the column 

label followed by the row label e.g. cell B3 has the value 20. A 

group of many worksheets make up a workbook. 

 

                                                    A             B       C          D        E         

F 

1            

2            

3  20          

4            

5    I        

 

Fig. 2.1: A Worksheet 

 

Database 

Data values can be entered in the cells of the spreadsheet and 

managed by special Excel features found on the Data menu. These 

features were incorporated in Excel but they actually belong to 

database management software. One of such feature is filtering 

records, using forms, calculating subtotals, data validation pivot 

tables and pivot chart reports. 

 

If the data values for the same entity (related values) are entered 

on the same row, they form a record. Hence a worksheet can be 

manipulated to some extent as a database that has data records 

entered in it. Figure 2.2 shows a worksheet having two records, Joy 

and Jeff. 

 

                                                            A              B             c           

D            EF1 
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   1 Name IDNo. Age Nationalit

y 

   2 Joy 123445 25 Kenyan 

   3 Jeff 125675 35 Ugandan 

   4     

 

Fig. 2.2: A spreadsheet with records 

 

NB: A spreadsheet file is structured in such a way that it can be 

visualised as a table of records. That is why such a 'file can be 

imported into a database program as will be discusses later in 

databases. 

 

Graphs 

A graph is a pictorial representation of the base data on a 

worksheet. Most spreadsheets refer to graphs as charts. A chart 

enables the user to present complex data elements from a 

worksheet in a simple easy to understand format. Examples of 

charts are pie charts, line charts and bar charts. As shall be 

discussed later, it is easy to generate charts when working with a 

spreadsheet program. Figure 2.3 shows an example of a pie chart. 

 

2.3 Application areas of a spreadsheet 

 

Statistical analysis 

Spreadsheets provide a set of data analysis tools that can be used to 

save steps when developing complex statistical or engineering 

analyses. The user is usually expected to provide the appropriate 

data and parameters for each analysis. The statistical tool then uses 

appropriate automated statistical or engineering functions and then 

displays results in an output table. Some of the tools generate 

charts in addition to the output tables. 

 

Because most of these tools are complex, the user needs to have 

the statistical background knowledge before attempting to use the 

tools. Examples of some simple statistical functions include the 

following: 

1. Average: This is used to calculate the mean of a set of values. 
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2. Median: This is used to return the value in the middle of a set of 

values. 

 

For example a set of values may be composed of: 

 

10   20    30   40    50     60. 

 

The average of the set is 35 and its median is also 35. The median 

is found by taking the average of the two numbers at the centre of 

the set, in this case 30 and 40. 

 

Accounting 

Many accountants find the spreadsheet a useful tool to use in 

recording daily transactions and keeping of financial records. 

Spreadsheets provide a user friendly environment for financial 

management and they come with inbuilt functions that make 

accounting tasks easier. For example, the spreadsheet can be used 

by accountants to do the following: 

1. To track the value of assets over time (depreciation and 

appreciation)  

2. To calculate profits 

3. To prepare budgets 

 

Other formula like sum, average, product etc. enables the 

accountant to carry out his daily work without any problem. 

 

Data management 

A spreadsheet enables neat arrangement of data into tabular 

structure. Related data can be typed on the same worksheet. 

However, when data is on different worksheets, the worksheets can 

be linked to enhance accessibility. 

 

Data management functions include sorting, filtering (displaying 

only the required items) and using forms to enter and view records. 

 

Spreadsheets enable the user to create, edit, save, retrieve and print 

worksheet data and records. 
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Forecasting ("What if" analysis) 

The automatic recalculation feature enables the use of "What if' 

analysis technique. This involves changing the value of one of the 

arguments in a formula to see the difference the change would 

make on the result of the calculation. For example, a formula to 

calculate a company's profit, margin may be as follows: 

 

Profit =, (Total units sold x sale price) - (Total units bought x cost 

price)  - Operating ‘expenses. 

A sales manager in the company c n ask the following question: 

What if sales increase by 20%, how much profit wills the company 

make? The manager substitutes the total units sold value with one 

that is 20% higher and the spreadsheet automatically displays the 

new profit. A traditional analysis method would require a different 

work sheet to be prepared. Therefore, this method can be used for 

financial forecasting, budgeting, stock portfolio analysis, cost 

analysis, cash flow etc. 

Creating a worksheet/workbook using Microsoft Excel 

To start Microsoft Excel, click Start button, point to Programs and 

then select Microsoft Excel from the programs menu This 

procedure may vary slightly depending on the version of Excel you 

are using or the computer's hardware and software configuration. 

The Windows environment allows a person to place shortcuts to a 

program's executable (.exe) file in various places like the desktop. 

If the Excel shortcut is on the desktop, simply double click it to 

start the application. 

 

The Microsoft Excel application window opens as shown in the 

Figure 2.5. Make sure that you can be able to identify all the 

labeled parts of the Microsoft Excel application window. 

 

The Microsoft Excel application window 

The Microsoft Excel application window is made up of the 

following components:  

 Title bar: It has the title of the application and control buttons for 

minimising, maximising and closing the application 

The menu bar: It displays a list of menu options e.g. File, Edit, 

View etc. Clicking one of them displays a menu that has 
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commands which can be selected in order to manipulate data in the 

spreadsheet. ' 

Tool bars: The most common of these are the standard and 

formatting toolbars. The most important thing is to be able to 

identify each toolbar by its icons. The standard toolbar has 

shortcuts to some of the most commonly used menu commands 

like print, copy, paste and save. The formatting toolbar has 

shortcuts to the commonly used commands found on the format 

menu option  

Formula bar: This is one of the most important components of the 

Microsoft Excel application window. It enables the user to enter or 

edit a formula or data in a cell. You can identify the formula bar 

because it has an equal sign (or fx). The name box to the left of the 

formula bar displays the position of the cell in which data or a 

formula is being entered which is also called the current cell. If the 

formula bar is not available, click on View menu then select 

Formula bars. A check mark appears on the left of the selected 

item to show that it is now displayed on the screen. 

Cell pointer: It marks the position of the current cell or the 

insertion point. It is special cursors that is rectangular in shape and 

makes the current cell appear as if it has darker boundaries. 

The Worksheet: Consists of cells, rows and columns. Data is 

entered here for manipulation. 

Status bar: It shows the processing state of the application. For 

example, on its left is the word Ready which shows that the 

spreadsheet is ready to receive user commands. ' 

 

Worksheet labels: These are usually of the format Sheet 1, Sheet 2 

etc. A workbook may have several sheets. It is also possible to 

rename the sheets by right clicking on the labels then choosing 

rename command from the shortcut menu that appears. The active 

sheet (one being used) has its label appearing lighter in colour than 

the rest. To move to a particular sheet in the workbook, simply 

click its sheet label. 
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Vertical and horizontal scroll bars: Clicking the arrows at their 

ends moves the worksheet vertically and horizontally on the screen 

respectively. 

 

Worksheet layout 

The worksheet has the following components: Cells: An 

intersection between a row and a column. 

Rows: Horizontal arrangement of cells. Columns: Vertical 

arrangement of cells. 

Range: Is a group of rectangular cells that can be selected and 

manipulated as a block. 

 

Navigating the Microsoft Excel screen 

1. Click cell D5. Notice that the cell pointer immediately moves to 

the cell and the name box reads D 5. Typing on the keyboard now 

inserts entries in cell D5 as long as the pointer is still there. 

2. Click letter A that heads the first column. Notice that the whole 

column is highlighted. 

3. Double click cell EIO. Notice that the text cursor forms in the 

cell and you can now type characters inside the cell. Also the status 

bar will now read enter which means that Microsoft Excel expects 

you to enter a value in the cell. 

4. Click the down arrow on the vertical scroll bar. The worksheet 

moves upwards on the screen. The opposite happens when you 

click the up arrow on the vertical scroll bar. 

5. Click the right button on the horizontal scroll bar. The 

worksheet moves to the left. The opposite happens when you click 

the left button on the horizontal scroll bar. 

6. Press the right arrow key on the keyboard. Notice that the cell 

pointer moves one column to the right on the same row. This can 

also be done by pressing the Tab key once. 

7. Press the left arrow key on the keyboard. Notice that the cell 

moves one column to the left on the same row. Pressing gives the 

same results. 
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8. Press the up arrow key on the keyboard. Notice that the cell 

pointer moves one row up on the same column. 

9. Press the down arrow key on the keyboard. Notice that the cell 

pointer moves one row down on the same column. 

10. Press the end key. The status bar will display the message 

"END". If you press the right arrow key, the cell pointer will move 

right to the last cell on the row. If the left up or down keys were to 

be pressed instead, the cell pointer would move to the last cell to 

the left, top or bottom respectively. 

 

11. Pressing Ctr1+Home moves the cell pointer to the first cell of 

the worksheet i.e. cell AI. 

 

Creating a worksheet 

At its simplest level, creating a worksheet consists of starting the 

spreadsheet program and entering data in the cells of the current 

worksheet. , However, a person can decide to create a worksheet 

either using the general format or from a specially preformatted 

spreadsheet document called a template. 

 

Using the general format 

When a spreadsheet program is running it will present the user 

with a new blank screen of rows and columns. The user can enter 

data in this worksheet and save it as a newly created worksheet. If 

this is not available then click File menu option and select the new 

command. The dialog box shown in Figure 2.8 will be displayed 

on the screen. On the General tab, double click the workbook icon. 

Enter data in the new worksheet created. 

 

Using a template 

Click File menu option then new command. On the spreadsheets 

solutions tab, double click the template that you wish to create. 

Figure 2.9 below shows some examples of templates that may be 

present for selection. 

 

NB: If the template was saved previously on the hard disk, it will 

open as a new worksheet with all the preformatted features present 

Fo
r f

re
e K

CS
E 

No
tes

, E
xa

ms
, a

nd
 P

as
t P

ap
er

s V
isi

t h
ttp

s:/
/T

ea
ch

er
.co

.ke
/



 

allowing the user to enter some data. However, some templates 

may require the original program installation disk in order to be 

able to use them because they may not have been copied to the 

hard disk during program installation. 

 

Editing a cell entry 

Editing a cell means changing the contents of the cell. Before the 

contents in a cell can be. Changed, the cell must be selected by 

making it the current cell. 

To edit a cell entry proceeds as follows: 

.1. Move the cell pointer to the cell you wish to edit. 

 2. Double click the formula bar for the text cursor to appear in the 

bar. The status bar message changes to edit 

3. Use the keyboard to delete and add contents to the formula bar 

then press enter key to apply. Click the save button on the standard 

toolbar to save the edited changes. 

 

Selecting a range 

As you have experienced with the previous two examples, working 

with one item at a time is tedious and time consuming. Using a 

range saves time when working with a large .amount of data. 

 

A range is a rectangular arrangement of cells specified by the 

address of its top left and bottom right cells, 'separated by a colon 

(:) ego Range AI:CIO is as shown in Figure 2.10. 

Selecting multiple ranges 

When using a mouse, you can select more than one range without 

removing the highlight from the previous. To do this: 

Hold down the Shift key or the Ctrl key while you click on the row 

header of the second range you want to highlight. What happens? 

Do you notice the difference when holding down the shift and the 

ctrl keys? 

1. Shift key will cause all columns/rows between the selected and 

the newly clicked cell to be highlighted. 

2. Ctrl selects individually clicked cells or range. 

 

Hiding rows/columns 
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You can hide some rows or columns in order to see some details, 

which do not fit, on the screen. To do this: 

1. Highlight the columns/rows you want to hide 

2. Click format menu, point on row or column and click hide 

command. 

 

Saving a worksheet 

To save a worksheet, one has to save the workbook in which it 

belongs with a unique name on a storage device like a hard disk. 

The procedure below can be used to save a workbook: 

1. Click File menu option then select Save as' command. 

Alternatively, click the save command on the standard toolbar. The 

save as dialog appears  

2. Select the location in which your workbook will be saved in the 

Save in box then type a unique name for the workbook in the File 

name box. Make sure that the option Microsoft Excel Workbook is 

selected under the save as type box. 

3. Click the Save button to save. 

 

Retrieving a saved workbook 

This means opening a workbook that was previously saved. 

1. Click File menu option then the Open command. Notice that the 

Open command has three dots (called ellipsis) indicating that a 

dialog box will open, as the user is required to provide additional 

information. Alternatively just click the Open command on the 

standard toolbar. The open dialog box appears on the screen. 

2. Click the Look in drop down list arrow and select the drive or 

folder where the workbook was saved. For example, if you saved 

in a diskette, insert it in the floppy drive then select 3 1/2-floppy 

(A:). A list of folders and files in the drive will appear in the list 

box. 

3. Double click the icon of the workbook you want and the 

worksheet will be displayed in the Microsoft Excel window. 

Notice that the cell pointer is in the same cell it was in when the 

worksheet was last Saved. 

Closing a worksheet 
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Click File then Close command. This closes the worksheet but 

does not 

Close the Excel spreadsheet program. Alternatively, click the; 

close button of the worksheet window 

Exiting from the spreadsheet  

Click File then Exit command. This closes not only the worksheet 

but also the spreadsheet program as well. Alternatively click the 

close button of the main application window.  

Cell data types 

There are four basic types of data used with spreadsheets: 

1. Labels 

2. Values, 

3. Formulae 

4. Functions. 

 

Labels 

Any text or alphanumeric characters entered in a cell are viewed as 

labels by the spreadsheet program. Labels are used as row or 

column headings usually to describe the contents of the row or 

column. For example, if a column will have names of people, the 

column header can be NAMES. Sometimes, numbers can be 

formatted so that they can be used as labels. To achieve this add an 

apostrophe just before the most significant digit in the number. For 

example, the number 1990 will be treated as numeric. if typed in a 

cell but' 1990 will be treated as a label. 

 

Labels are aligned to the left of the cell and cannot be manipulated 

mathematically. 

 

Values 

. , 

These are numbers that can be manipulated mathematically. They 

may include currency, date, numbers (0-9), special symbols or text 

that can be manipulated mathematically by the spreadsheet. 

 

Formulae 

These are user designed mathematical expressions that create a 

relationship between cells and return a value in a chosen cell. In 
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Microsoft Excel, a formula must start with an equal sign. For 

example, the formula 

=B3+D4 adds the contents ofB3 and D4 and returns the sum value 

in the current cell. 

 

Excel formulae use cell addresses and the arithmetical operators 

like plus (+) for addition, minus (-) for subtraction, asterisk (*) for 

multiplication and forward slash (I) for division. 

Using cell addresses, also called referencing, enables Microsoft 

Excel to keep calculations accurate and automatically recalculates 

results of a formula in case the value in a referenced cell is 

changed. This is called automatic recalculation. 

 

Functions 

These are inbuilt predefined formulae that the user can quickly use 

instead of having to create a new one each time a calculation has to 

be carried out Microsoft Excel has many of these formulae that 

cover the most common types of calculations performed by 

spreadsheets. To add the contents of cell B3 and D4 the sum 

function can be used as shown below: 

 

= Sum (B3:D4) 

 

2.6 

 

Cell referencing 

A cell reference identifies a cell or a range of cells on the 

worksheet and shows Microsoft Excel where to look for the values 

or data needed to use in a formula. With references, you can use 

data contained in different cells of a worksheet in one formula or 

use the value from one cell in several different formulae. 

By default, Microsoft Excel uses the A 1 cell referencing style. 

This means that a cell is identified by its column label followed by 

the row number. However, the Rl Cl referencing style can be used. 

In this case, the cell is referencing by its row number followed by 

its column number. The table below gives a few examples of 

equivalent referencing using both styles.   
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A1 style R1C1 style 

B2 R2C2 

C10 R10C3 

E20 R20C5 

 

 

The RlCl style is useful when automating commonly repeated 

tasks using special recording programs called Macros. 

 

Relative referencing 

When performing tasks that require cell referencing, you can use 

formulae whose cell references keep on changing automatically 

depending on their position in the worksheet. This is called relative 

cell referencing. A good example would be if you type the formula 

=Al+Bl in cell Cl. If the same formula is copied to cell C2 the 

formula automatically changes to =A2+B2. 

 

Absolute referencing 

These are cell references that always refer to cells in a specific 

location 

, of the worksheet even if they are copied from one cell to another. 

To make a formula absolute, add a dollar sign before the letter 

and/or number, 

such as $B$lO. In this case, both the column and row references are 

absolute. . 

 

Referencing using labels and names 

Labels of columns and rows on a worksheet can be used to refer to 

the cells that fall within those columns and rows. It is possible to 

create a name that describes the cell or range then use it instead of 

having to specify a range with actual cell references. Such a 

descriptive name in a formula can make it readable and easier to 

understand its purpose. For example, the formula 

=SUM(SecondQuarterProfits) might be easier to identify than 

=SUM(AlO:C20). In this example, the name SecondQuarterProfits 

represents the rangeAlO:C20 on the worksheet. Names can also be 

used to represent formulae or values that do not change 
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(constants). For example, you can use the name .Tariffs to 

represent the import tax amount (such as 7.0 percent) applied to 

imports. 

 

To create a named range 

To create a named range proceeds as follows: 1. Select the range to 

be named: 

2. Click inside the name box to move the text cursor inside. Delete 

the Cell reference that is there and type a name for the range. 

3. Press Enter key to apply. Figure 2.13 shows a worksheet range 

called sales that has values used in a formula to give the sum in 

cell C 11. 

 

 

2.7 Basic functions and formulae 

Formulae perform mathematical operations ranging from very 

simple arithmetic problems t9 complex scientific, financial and 

mathematical analysis. 

 

Statistical functions. 

1. Average: It returns the average (mathematical mean) of a set of 

values which can be numbers, arrays or references that contain 

numbers. If the value 20 is in cell DIO and 30 in ElO then: 

=Average(D lO:E 1 0) returns 25 as the average of the two values. 

2. Count: Counts the number of cells that contain values within a 

range e.g. 

= count (AIO: EIO) many return a value 5 if all the cells have 

values. 

3. Max: It returns the largest value in a set of values. It ignores text 

and logical values e.g. == Max (AlO:EIO) will return the 

maximum value in the range. 

4. Min: It returns the smallest value in a set of values. It ignores 

text and logical values e.g. = Min (AIO:EIO) will return the 

minimum values in the range. 

5. Mode: It returns the most frequently occurring value in a set of 

values. e.g. = Mode (AIO:ElO) 

6. Rank: Returns the rank of a number in a list by comparing its 

size relative to the others. For example if A 1 to AS contains 
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numbers 7, 3.8,3.8, 1 and 2 then RANK (A2, Al :A5,1) returns 3 

while RANK (AI, AI:A5,I) returns  

5. The general format is RANK (number to be ranked, range, 

order). 

 

Logical functions 

1. If: It returns a specified value if a condition is evaluated and 

found to be true and another value if it is false. If (marks > 50, 

"pass", "fail") will display a pass if values are more than 50 else it 

will display fail. 

2. Countif: Counts the number of cells within a specified range that 

meet the given condition or criteria. e.g. suppose A 1 0 : E 1 0 

contains eggs, beans, beans, eggs, eggs, countif(AIO:EIO, "Eggs") 

will return 3. 

3. Sumif: It adds values in the cells specified by a given condition 

or criteria. e.g. For example if AIO to ElO contains values 

10,50,60, 30, 70, to sum all values greater than 50 = 

Sumif(AIO:EIO, ">50"). This returns 130. 

 

Mathematical functions 

1. Sum: adds values in a range of cells as specified and returns the 

result in the specified cell. e.g Sum (AIO:EIO) adds values in the 

range 

2. Product: multiplies values in a range of cells and returns the 

result in the specified cell. For example if A 10 has 30 and BIO has  

3. Product (AlO:BIO) will return 90. 

 

Arithmetic formulae - using operators  

 Operator Function 

 

+ (plus)                                          adds values as specified 

- (minus) .                                      subtracts values as specified 

* (multiplication)                           multiplies values 

/ (division)           divides values. 

( ) parenthesis    encloses arguments to be 

calculated first. 
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For a formula =(Al +C3)/E20, if the value in E20 is not zero, the 

result is displayed in the current cell. 

 

Order of execution 

If several. Operators are used in a single formula; Microsoft Excel 

performs the operations in the order shown in Table 2.3. Formulas 

with operators that have same precedence i.e. if a formula contains 

both a multiplication and division operator are evaluated from left 

to right. Enclosing part of the formula to be calculated in 

parentheses or brackets makes that part to be calculated first. 

 

Operator  Name Precede

nce 

1. -  Negation as in -1 1 

2.%  Percent 2 

2. 1\  Exponentiation 3 

3. * and / ! Multiplication and 

division 

4 

4. + and -  Addition and 

subtraction 

5 

6. =,<>,>,<,<=,>= Relational 6 

 

Table 2.3: Operators' order of execution 

 

2.8 

 

Editing a worksheet 

 

Coping and moving data 

Spreadsheet software automates many processes that could have 

been tedious if done manually. For example with Microsoft Excel, 

you can do calculations using formulae fairly easily as you give the 

data and correct instructions to the program. Copying and moving 

of, data can also be done quickly and efficiently. 

 

When data is cut or copied from the worksheet, it is temporarily 

held in a storage location called the clipboard. 
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Copying data 

To copy a cell or a range of cells: 

1. Highlight the cells or range you want copied 

2. Click the Edit menu then select Copy command. 

3. Select the cell in which you want to place a copy of the 

information 4. From the Edit again, click Paste command. The 

Paste command puts a copy from the clipboard on the specified 

location 

 

Moving data 

Unlike the Copy command where a duplicate copy is created, the 

Move command transfers the contents of the original cell (s) to a 

new location. 

 

To move a range of cells: 

1. Highlight the range you want to move. 

2. From the Edit menu, select Cut. 

3. Specify the location you want to move the contents to.  

4. From the Edit menu again, click Paste. 

 

2.9 Worksheet formatting 

Worksheet formatting refers to enhancing the appearance of the 

worksheet to make it more attractive and appealing to the reader. 

Appropriate formatting should be used to lay emphasis, catch 

attention and bring otherwise II hidden detail to the fore of the 

document. 

 

The golden rule of formatting is to use simple clear formats. It 

essentially consists of changing text colour and typeface (font), 

size, style and alignment. In Microsoft Excel, format the cells 

whether empty or not and their contents will acquire the set format 

automatically. 

 

To format a single cell, make it the current cell then format menu 

option and select the cells command In the format cells dialog box, 

make the formatting specifications that you wish then click the ok 

button to apply. If it is a range of cells, they must be highlighted 

first before formatting them as a block of cells. 
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Formatting text 

1. Highlight the cells that have the text to be formatted. 

2. Click Format menu then cells command. The dialog box appears 

3. Select the font tab as shown in the figure by clicking it. 

4. Select the font type e.g. Times New Roman. Other font 

formatting features like style, size, underline and colour are 

available and can be selected. 

5. Click button to apply. 

 

NB: Alternatively, use the formatting toolbar to accomplish all 

your text formatting needs. Notice that the options in the font 

dialog box are commands on the formatting toolbar. 

 

Formatting numbers 

1. Highlight the cells that have the numbers to be formatted. 

2. Click Format menu then cells command. The dialog box in 

Figure 2.15 appears. 

3. Select the Number tab as shown in the figure below. 

4. You can now choose number formats as explained below: 

Number            Meaning 

General  general format cells have no specific number format.  

Number Used for general display of numbers e.g. 2345.23.  

Currency For displaying general monetary values e.g. $100, 

Ksh.10. 

Accounting Lines up the currency symbols and decimal poin 

s. Displays date in chosen format. 

Date  Displays time in chosen format. 

Percentage       Multiplies the value in a cell with 100 and display ' 

it as %. 

Text  Formats cells to be treated as text even when numbers 

are entered. 

Custom          For a number format not predefined in Microsoft 

Excel, select custom then define the pattern. 

 

Worksheet borders 

Fo
r f

re
e K

CS
E 

No
tes

, E
xa

ms
, a

nd
 P

as
t P

ap
er

s V
isi

t h
ttp

s:/
/T

ea
ch

er
.co

.ke
/



 

You may need to put a printable border around your worksheet or 

in a range of cells to make it more attractive and appealing. To put 

a border: 

1. Highlight the range you wish to insert borders. From the format 

 menu, click cells command. 

2. Click the borders tab and specify the border options for left, 

right, top and bottom. . 

3. From the style options, select the type of line thickness and 

style. Also select the preset options. 

4. Click the ok button. The selected range will have a border 

around it. 

 

Formatting rows and columns 

Sometimes, the information entered in the spreadsheet may not fit 

neatly in the cell set with the default height and width. It therefore 

becomes necessary to adjust the height of a row or the width of a 

column. The standard width of a column in Microsoft Excel is 8.43 

characters but can be adjusted to any value between 0 and 255. 

 

Changing column width 

1. Move the mouse pointer to the right hand side line that separates 

the column headers i.e. for instance the line between A and B. 

2. Notice that the mouse pointer changes from a cross to a double 

arrow 

3. Click the mouse button and hold it down so that you can now 

resize the width of the column by dragging to the size you wish. 

After Dragging to the required point release the mouse button and 

the Column will have a new size. 

 

NB: Alternatively, move the cell pointer to one of the cells of the 

column then click Format, point to Column then click Width 

command from the sidekick menu. Type a width in the dialog box 

that resembles Figure 2.17 then click Ok.button to apply. 

NB: To change the widths of several columns at the same time, 

highlight them first before following this method. 

 

Changing row height 
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1. Point to the line that separates two row numbers e.g. the line 

between 1 and 2. The mouse pointer becomes a double arrow. 

2. Drag the line until the height of the row is as required then stop 

and release the mouse button. 

NB: Alternatively, click Format point to Row then click Height 

from the sidekick menu that appears. Type the height that you wish 

in the dialog box that appears and then click OK button to apply. 

 

Inserting rows and columns 

I, Click cell A5 to make it the current or active cell. 

2.clik insert then columns to insert a 'row above cell A5 and shift 

all the other rows downward. 

OR 

 

Click insert then Columns to insert a column to the left of column 

A and shift all the others to the right. 

 

NB: Alternatively, click  insert  then cells to display the dialog box 

select the entire row or entire column options to insert a row or 

column respectively. 

 

Global worksheet formatting 

The word global in this case refers to the entire worksheet. In order 

to format the whole worksheet globally, it must be selected as a 

whole. 

Two methods can be used to select a worksheet globally: 

1. Click the top left comer of the worksheet that has a blank 

column header i.e. immediately on the left of A and just above I, 

OR 

2. Press Ctrl+A on the keyboard. 

 

Notice that the whole worksheet becomes highlighted. It can now 

be formatted as one big block using format cells command. 

 

Using autoformat 

Fo
r f

re
e K

CS
E 

No
tes

, E
xa

ms
, a

nd
 P

as
t P

ap
er

s V
isi

t h
ttp

s:/
/T

ea
ch

er
.co

.ke
/



 

It allows the user to apply one of sixteen sets of formatting to & 

selected range on the worksheet. This quickly creates tables that 

are easy to read and are attractive to the eye.. 

1. Select a range e.g. B 1 :G7 to make it active. 

2. Click format then select the auto format command on the menu 

that Appears. Select a format from the autoformat dialog box 

shown in Figure 2.19. 

3. Click the ok button to apply the format to the selected range. 

 

2.9 Data management 

At times, it becomes necessary to use advanced data management 

tools to manage large ,data stored on a 'worksheet. For example, if 

the worksheet has many records, it may become necessary to 

arrange them in a particular order using a method called sorting for 

easier access to data items. Other methods of data management 

include use of filters, total/subtotal function and forms. 

 

Sorting 

To carryout sorting proceed as follows: 

1. Highlight the range that you wish to sort by clicking its column 

header letter.  

2. Click Data then Sort . Notice that the Sort by field is already 

reading the field that you selected. This field is called the criteria 

field. 

3. Select the field to be used as the key for sorting and the sort 

order as either descending or ascending then click OK button to 

apply. 

 

Filtering data 

Filtering is a quick and efficient method of finding and working 

with a subset of data in a list. A filtered list will only display the 

rows that meet the condition or criteria you specify. Microsoft 

Excel has two commands for filtering lists. 

1. The auto filter: It uses simple criteria and includes filter by 

selection.  

2. Advanced filter: It uses more complex criteria. 
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In this Pupil's Book we will look at the autofilter. 

 

Autofilter 

Filters can be applied to only one list on a worksheet at a time. 

1. Click a cell in the list that is to be filtered; usually the list is in a

 column. 

2. On the Data menu, point to Filter, and then 

3. To display only the rows that contain a specific value, click the 

arrow in the column that contains the data you want to display as 

shown in Figure 2.21. 

4. Click the value that is to be displayed by the filter from the drop 

 down list. e.g in the example below, the selected value is 34. 

NB: Sometimes while looking through a list of values on a large 

worksheet, you may come to a value of interest and want to see all 

other occurrences of the value in the spreadsheet. Simply click the 

cell that has the value then click auto filter on the standard toolbar. 

Microsoft Excel turns on AutoFilter and then filters- the list to 

show only the rows you want. 

 

Subtotals function 

Consider the following scenario: A company that has many 

salespersons 

will need to know how much each of them should be paid at the 

end of a period by looking at individual sales volumes. Also, the 

grand total for all the payments has to be calculated. Therefore, if 

the salespersons are held in a list, there would be need to calculate 

the amount due to each of them. This can be called a subtotal in the 

list. All the subtotals can then be added together to make the grand 

total. Consider the following list: 

Name                 Amount Owed 

Stephen  ` 6000 

Joy   3000 

 Stephen  2000 

 Virginia  5000 

 Joy    800 

Stephen  200 

 Virginia  5000 
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Microsoft Excel can automatically summarise the data by 

calculating subtotal and grand total values of the list. To use 

automatic subtotals, the list must have labelled columns and must 

be sorted on the columns for which you want subtotals. In this 

example, the list is first sorted by name 

1. Click a cell in the list that will have subtotals e.g. cell A3. 

2. On the Data menu click Subtotals 3. Notice that all the data 

range is now selected. 

3. In each change in box, select Name from the drop down list 

because we want a subtotal for each of the names. 

4. In the Use function box select the sum function  then select the 

list for which subtotals will be inserted in the add subtotals box by 

checking the appropriate label. In this case it is the amount owed 

field. 

5. Click ok button to apply and the list will now have sub totals 

inserted   

Totals function 

Use theAutoCalculate feature in Microsoft Excel to automatically 

show the total of a selected range. When cells are selected, 

Microsoft Excel displays the sum of the range on the status bar. 

Right clicking this function displays other functions like Min, Max 

and Average that can also be used. To find the total of a range, 

highlight it then click the autosum icon ∑ on the standard toolbar. 

 

Forms 

A form is a specially prepared template that the users can use to 

enter data in a worksheet. It is specifically formatted to enable 

users to enter data in a format that is more convenient to them. If 

data is collected on paper before entering in the computer, then a 

form can be created to have the layout of the data on the paper to 

quicken data entry procedures. To display a form: Click 'Data, then 

form. 

 

2.10 Charts/graphs 

Charts/graphs are graphics or pictures that represent values and 

their relationships. A chart helps the reader to quickly see trends in 

data and to be able to compare and contrast aspects of data that 
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would otherwise have remained obscure. Microsoft Excel has both 

two-dimensional and 3-dimensional charts that can be used instead 

of the raw data in the table that has to- be studied for a long time to 

understand it. 

 

The various types of charts available include column, bar, line. 

Pie, bubble and area charts among others. Consider carefully the 

type of chart that would best represent the base data in the 

worksheet before creating one. For example, if the aim is to depict 

the performance index of a student from Form I-to 3, a line chart 

would be most appropriate because it clearly shows the trend in 

performance. 

 

 Types of charts 

1. Line chart - represents data as lines with markers at each data 

value in the x-y plane. 

2. Column chart- represents data as a cluster of columns 

comparing values across categories. . 

3. Bar chart - data values arranged horizontally as clustered bars. 

Compares values across categories. 

4. Pie chart - it displays the contribution of each value to a grand 

total. 

5. Scatter chart - compares pairs of values on the same axis. 

  To view types of charts, right click the chart object then select the 

chart type command. 

 

Creating a chart 

A chart must be based on values that are already entered in the 

worksheet. 

 

To create a chart: 

1. Select the range of values for which you want to create a chart. 

2. Click the Chart wizard button on the standard toolbar and the 

chart wizard dialog box will open as shown in Figure 2.25 

3. Click the type of chart you wish to .create. If the office assistant 

appears, close it. The chart sub-type preview will show several 

styles of the selected chart type. 
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4. Click the Next button to move to the dialog in Figure 2.26.  

5. Click the Series tab then the collapse dialog button on the labels 

text box. 

This will shrink the dialog box so that only the category labels text 

box is shown. Highlight the data labels from the worksheet. 

 6. Click the Expand dialog button to bring the full dialog box into 

view then click the: Next button. In step 3 of the wizard, use the 

appropriate tabs to type the title of the chart, show a legend, select 

whether to display gridlines or not etc. After all these click the 

Next button.' 

7. At step 4 determine whether the chart will be inserted in the 

current  worksheet or a new worksheet then click Finish button 

(Figure 2.27). 

 

Moving and resizing a chart 

Once the chart is created, its size and location can be changed in 

the worksheet. The chart element is enclosed inside a boundary 

called the chart area and hence both can be resized independently. 

Simply click the object you wish to resize and use the object 

handles just like in objects to drag to size. To move the chart, click 

inside the chart area then drag to the desired position. 

 

Data ranges 

A data range is a rectangular block of cells that provides the base 

data that is used to create the chart. In charting, a data range is 

referenced as an absolute range e.g. . 

=Sheetl !$B$2:$C$8 which means that the base data is found on 

Worksheet 1 and absolute range B2:C8. 

To see the data range of a chart, right click it then select the Source 

data command. . 

 

Labels 

Each representation of data on a chart can either be labelled by a 

value 

or text label. For example, in a bar chart that compares the height 

of pupils, each bar can be given a value label to make it more 

readable. 
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To label: 

1. Right click the chart then select the Chart options command 

from 

the shortcut menu. 

 

2. Click the lables tab and choose whether you want value or text 

labels  then click OK button to 

apply. . 

 

Headings and titles 

Each chart must have a heading showing clearly what it represents. 

To I make the chart understandable, include axis titles. 

 

. To include axis titles proceed as follows: 

1. Right click the chart then select the. Chart options command. 

2. Click the Titles tab then type the chart title (heading). And axis 

titles respectively. 

3. Click OK button to apply. 

 

Legends 

The legend is like a key that explains what each colour or pattern 

of the data representation in the chart means. For example, 

Microsoft Excel may give red colour to one data value and green to 

the other. Without a legend it would be difficult to know how to 

differentiate the two sets of values. 

 

 : To create a legend: 

.1.Right click the chart then select the Chart options command. 

2. Click the legends tab and specify that it be displayed in the chart 

area. 

3. Click OK button to apply. 

 

2.11 

 

Printing worksheets 
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A worksheet will finally be printed for sharing with others or for 

filing purposes. If it contains objects like charts, it may not fit on a 

standard printing page using the default printing options and 

settings. Therefore, Microsoft Excel allows the user to preview and 

set up the pages of a' worksheet in order to fit them on the hard 

copy page. 

 

Page setup 

1. Click .File menu option then Page setup command to display the 

page setup dialog box.. . 

2. On the Page tab, select the orientation of the page. Study the 

meanings of each buttons and options in Figures 2.28. 

 3. After making the necessary selections, click OK to apply. 

 

Print preview 

It displays the worksheet from the point of view of the printer i.e. 

exactly the way it will look when printed. Before using this 

command, make I sure the chart is deselected. 

1. Click the Print preview button on the standard toolbar. 

2. The worksheet will be displayed in the print preview window 

with the status bar reading preview. 

3. Click Setup to start the page setup dialog box. To close the 

preview, click the Close. Button. 

I Print options 

 

To print click File then Print command. The print dialog, box 

appears as shown in Figure 2.29 . 

1. Select printer - the name box in this dialog box enables a person 

to select the printer that will be used to print the document. All the 

printers that are installed on the computer will be available here. 

2. The print what options are: 

(a) Selection - this prints the selected worksheet area.  

(b) Workbook - prints all the worksheets in the workbook.  

(c) Selected chart - prints the selected chart only. 

 

Page orientation 
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As explained earlier, page orientation refers to the layout of the 

text on the page. A worksheet can also be printed on either 

landscape or portrait depending on the number of columns across 

the worksheet. 

 

Pages and copies . 

The number of copies box specifies how many copies of a 

particular worksheet or workbook should be printed. 

 

Sometimes only some specified pages in a workbook are specified 

for printing e.g. if a workbook has 100 pages and you wish to print 

only pages 50 to 60 select the page(s) range button then type 50 

and 60 in the from, to boxes respectively before clicking the OK 

button. 

 

Printing 

After selecting all the options, click the OK button to print. 

 

Some common printing problems 

1. A message appears on the screen saying that the printer 

specified could not be found in the directory. 

 

Possible problems and solutions 

(a) The printer could be off. Switch it on and it will start printing. 

(b) The data cable to the printer could be loose. Make sure it is 

firm at the ports. 

(c) The wrong printer could have been selected. Select the right 

one in the print dialog box and send the print job again. 

(d) A message appears on the screen reading that there is paper 

jam. I 

 

The printer is clogged with a paper jam. Alert the lab, technician or 

the Teacher to clear the paper jam. 
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DATABASES 

 

Chapter outline 

 

3.1 Introduction to databases 

3.2 Database concepts 

3.3 Data organization in a database 

3.4 Creating a database using Microsoft Access  

3.5 Editing a database 

3.6 Form design 

3. 7 searching for specific records in a database  

3.8 Creating reports 

3.9 Creating labels 

 

Introduction to databases 

We are often faced with the need to keep, search for or give a 

report of daily experiences. This is the reason why many people 

use data storage methods like recording daily experiences in a 

diary. Traditionally, human beings used to manage data and 

information manually by using simple devices. However these 

methods have a number of weaknesses which include 

 

1. Unnecessary duplication of data 

2. Boredom and time wasting especially when searching for a 

Particular item. 

3. Misleading reports due to poor data entry and organisation 

4. Poor update of records etc. 

 

Today, computerized systems have radically changec4the way data 

and information is managed by use of special programs called 

Database Management System (DBMS). 

 

A database is a collection of structured and related data items 

organised so as to provide a consistent and controlled access to 

the items. 

 

Database concepts . 
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Computerised database creation and manipulation is achieved 

using Database Management System software. This software 

facilitates the creation, organisation and maintenance of databases. 

Examples of database management software’s include Microsoft 

Access (Ms Access), Oracle, FoxPro, Dbase/V, Lotus Approach 

etc. 

 

The functions of database management software are to:  

1. Allow the user add or delete records. 

2. Update or modify existing records. 

3. Organise data for easy access, retrieval and manipulation of 

records.  

4. Act as an interface between a database and other application 

programs.  

5. Ensure security for the data in the database by safeguarding it 

against unauthorized access and corruption (damage). 

6. Keep statistics of data items in a database. 

Database models 

 

Databases are classified according to the method used to organise 

data. The main database models are; 

1. Flat file 2. Hierarchical 

3. Network    4. Relational 

 

NB: Current database models are called object relational and 

object databases. However these models will not be discussed in 

details in this book. 

 

Flat files 

 

In a flat file model, a database holds only one set of data and is not 

any different from the manual files. For example, the teacher's 

assessment report may consist of performance cards for every 

student in a class. Another example of a flat file database are the 

cards used in a library books catalogue. The cards are arranged 

sequentially for easy access e.g. alphabetically using books' titles 

or by authors' names. Figure 3.1 below is a sample record of a flat 

file. 
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Name Serah Seki 

Admission 

number 

649 

Total marks 680 

Number of 

subjects 

10 

Average 68 

Position 4 

Fig. 3.1: Sample record in a flat file 

 

Hierarchical model 

 

In this model, data items are arranged in hierarchical (tree) form as 

shown in Figure 3.2. To access level two data items, you have to 

first access level 1 data items. Level 1 item is called the root 

component. A specific single path leads to each item at lower 

levels. Hierarchical model is rarely used in modem database 

systems. 

 

                 Level 1 main data item 

                                 Path 

               Level 2 data item 

 

 

Fig. 3.2: Hierarchical database model 

 

Network model 

 

In this type of organisation, links are used to express the 

relationship between different data items, forming a network of 

items as shown in Figure 3.3. Access to one item can be through 

multiple paths and from any item. This model is also rarely used in 

modem database systems. 

 

                                                     

 

 

 

Data item 2 
Dataitem 1 

 

Dataitem 3 

 

Dataitem 4  
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Fig 3.3: Network database model 

 

Relational model 

This is the most common type of model used on minicomputers 

and microcomputers. In this type of organisation, related data 

items are stored together in structures called relations or tables. 

Relationship can be created between tables such that a record or 

records from one table relates to another or other records in 

another table. Tables 3.1 and 3.2 show customers and orders tables 

that are related by two fields; the customer number in Table 3.1 

and customer ID in Table 3.2. In this case, the orders table shows 

that one customer with number 450 (Bat Hori) has made several 

orders. 

 

  Customer 

Number 

Name  Telephone 

number 

  900  Mary 

Koech 

02078907 

  230  Peter 

Karimi 

0667896 

  450  Bat Hori 04456000 

   Table 3.1: Customer 

number 

 

 Customer 

ID 

Order 

Number 

Date   Amount 

(sh) 

 90

0 

 2380  2/3/2004 90 000 

 45

0 

 811  2/5/2004 5000 

'- 45

0 

 234  . 3/5/2004 13 000 

 45

0 

 567  3/6/2004 13 000 

Table 3.2: Customer ID 

 

Object oriented models . ! 

The next generation of database model will look at records as 

objects that are independent and relate with the other objects in the 
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database. This concept is a bit difficult to conceptualise because 

such databases are still at developmental stage. However, many 

databases today combine object and relational concepts to come up 

with object relation models. 

 

Features of a database management software 

Most database software contains a collection of features that 

provides the user with a means to manipulate data in a database. 

These features include Tables/files, Queries, Reports generators, 

Form interface and a computer programming language within it. 

Microsoft Access database software that will be considered in this 

book has two distinct features used to automate operations namely 

Macros and Modules. 

 

Tables/ file structure 

This is a database structure that is used to hold related records. 

Tables are organised in rows and columns with each row 

representing a record while each column represents common fields 

in each record. Table 3.3 shows a table of six records and each 

record is made up of four fields. 

 

FIRST 

NAME 

MIDDLE 

NAME 

LAST 

NAME 

ADDRESS 

MBUGUA STEPHEN KIMANI 250 

KERUGOYA 

ADERA NELSON ODUOR 396 HOMA 

BAY 

MARGAR

ET 

JUDY WEKESA . 761 NAIROBI 

GATO PATRICIA MUILA 170 TALA 

MWELU LUCY. MWENI 390 

KANGUNDO 

. 

KOECH PETER KORIR 605 KERICHO 

 

Table 3.3: Table of six records and four fields 

 

Queries and query language 
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A query is a database tool used to search for or question a database 

on specific records. Because a query is a question posed to the 

database, it returns a result for the user. In Microsoft Access, this 

result is called a dynaset. For example, assume you work with the 

National Irrigation Board (NIB), you may wish to display all those 

farmers from Mwea Rice Irrigation Scheme who delivered rice in 

January to the National Irrigation Board. You can use a query 

object or statements to get the required records. 

The query statements are written using a special language called  

Structured Query Language (SQL). The user creates a, query by 

writing Structure query language statements such as:  

Select  

Farmer Number, Name, Month of Delivery 

From 

 Delivery Table 

Where 

Month of Delivery = "January" 

 

Forms/screen input 

 

A form is a graphical interface that resembles the ordinary paper 

forms used to collect data. However, a database form enables the 

user to view and enter data into a table. Figure 3.4 shows a sample 

form used for entering a student's marks scored in four subjects 

and. the date of admission. Form interface is a more convenient 

and easy way of entering and viewing records from a table. 

 

Reports 

 

Most database systems provide the user with a tool for generating 

reports from an underlying table or query. It is the report generator 

that provides the user with a means to specify the output layout and 

what is to be output or printed on a report. Table 3.4 shows a 

sample report for employees' salaries. 

Net Pay Report 
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fay rol/no .Last.Name      First Name. . .Basic salary                

PAYE              Net salary. 

 

07 Wangui Grace sh 80,000.00 Kshs 7,300.00 sh 

72,700.00 

09 Ochieng Mbenga sh 37,000.00 Kshs 3,800.00 sh 

33,200.00 

13 Mumbua Peter sh 22,000.00 Kshs 2,300.00 sh 

19,700.00 

20 Mbuvai Sicily sh 60,000.00 Kshs 5,700.00 sh 

54,300.00 

  Table 3.4: Sample report   

 

Macros 

 

Some database software provides the user with a tool called a 

macro, that can be used to automate frequently performed 

procedures or tasks. For example, if you frequently use a particular 

form when you start a database program, you need to create a 

macro that automates the opening of the form. 

 

Programming module 

 

When your database becomes more and more complex, you may 

need a more powerful tool than the macros to automate your 

database operations further. Some database software come with 

their own computer languages associated with them. For example 

Microsoft Access comes with a language called Visual Basic 

included as a Module in the software. Using this feature, you can 

create a program that will print a query result over and over again 

until a certain condition is true. This can be illustrated using a 

simple statement like; 

 

Print Student Report until NumberofStudents = 40 (Not a real 

command anyway). 

 

NB: For the purpose of this book, only tables, forms, queries and 

reports, have been covered. 
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Data organisation in a database 

One of the functions of a database system is to organise data for 

easy access, retrieval and manipulation. Data is organised from the 

simplest fQfll1 called a field to a very complex structure called a 

data,base. 

 

Fields 

A field is a character or a logical combination of characters that 

represent data item. For example, in a class list, the student name is 

a field. 

 

Records 

This is a collection of related fields that represent a single entity. 

An example of a record is the student report card that may contain 

the. student's name, admission number, class, total marks, average 

and grade. 

 

Files/tables 

A file is a collection of related records. For example, the students' 

file in a school database contains the details of all the students in 

the school. 

 

Database 

This is the highest in data organisation hierarchy that holds all 

related files 'or tables. For example, a school database may contain 

students and staff tables/files. 

 

Creating a database using Microsoft Access 

Microsoft Access (Ms Access) is a package in Microsoft Office 

suite used for creating and manipulating databases. Because there 

are different versions of Ms Access such as Ms Access 95/97/2000 

and XP, a general approach for carrying out tasks has been adopted 

in this book. However most of the illustrations are based on Access 

2000 in order to maintain consistency. 

 

Starting Microsoft Access 

1. From Windows desktop, click the start button. 
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2. Select. Microsoft Access from the programs menu 

3. In the dialog box that appears when Microsoft Access starts, 

click Blank Access database as shown in Figure 3.5 then OK. 

 

4. The Save As dialog box appears. See Figure 3.6. This lets you 

specify the name and location where your database will be stored. 

Click Create to save the database. 

 

5. Microsoft Access database objects window is displayed from which 

I you can choose the type of object to create such as tables, forms, 

queries etc. 

 

Microsoft Access screen layout 

Like the other applications discussed earlier, Ms Access 

application Window has a title bar, menu bar, toolbars and status 

bar. However instead of having a work area like that ofMs Word 

or Excel, it provides the user with an object window from which 

you choose the type of an objectto work with such as tables, forms, 

reports e,tc. See Figure 3.7. 

 

 .Exiting from Microsoft Access 

Because Microsoft Access consumes a large amount of computer 

memory  it is advisable to exit from the application at end of each 

working session. 

 

To exit: 

From the File menu, click exit the close button on the title bar. 

 

Guideline on designing a good databases 

To design a good database which will require little time to 

maintain, consider the following: 

1. Carefully study the requirements of the user in order to define 

all the data inputs, outputs and relationships required. 

2. Design a draft database on the paper to determine the number of

 files or tables required. 

3. Divide the information into separate fields, records and tables to 

allow flexibility in manipulating the database. This process of 
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dividing information into independent tables to avoid repetition of 

data entries items is referred to as normalizing a database. 

 5. Define a field for each table that will be used to identify each 

record uniquely. This field is referred to as a primary key 

6. Give the most important fields the first priority when 

constructing a table structure. Important fields are those that are 

used in sorting' and querying the database. " 

7. Design data entry forms needed for the database 

Creating a table/file structure 

To define a table structure: 

1. From the Microsoft Access objects window, click the tables tab 

then new 

2. From New table dialog box, select Design View Figure 3.8 

appears. : 

3. using the grid displayed, enter a unique name for each field in 

the table. A field name must start with a letter and can be up to a 

maximum of 64 characters including letters, numbers, spaces and 

punctuation. 

4. Choose the correct data type before adding the next field. By 

default, Ms Access inserts Text as a data type. Figure 3.8 shows 

various data types used in Ms Access. 

6. To save the table, click the Save button on the standard tool bar 

or save from the file menu. 

7. Access will ask you whether you want to create a Primary Key, 

click Yes. 

 

Description of field data types 

The type of data to be used in a database must be clearly defined 

for the purpose of manipulation and storage. For example, if a field 

is to be used for calculation, it must be defined as a number. The 

data types allowed in Ms Access include: 

 

Text 

This type includes alphabetic letters, numbers, spaces and 

punctuation. Use this data type for fields that do not need to be 

used for calculations such as names, places, identification numbers 
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etc. This type of field accommodates a maximum of 255 

characters. 

 

Number 

These are fields made up of numeric numbers 0 to 9 that are to be 

manipulated mathematically. 

 

Memo 

This is a field made up of alphanumeric (both alphabetic and 

numeric) data. Instead of using Text use this data type if you need 

to enter several paragraphs of text because it accommodates a 

maximum of 32 000 characters. 

 

Date/Time 

Used to identify a field as either a date or time. This is because 

date/time values can be manipulated mathematically in a database. 

For example, you can calculate the age of a person from the date of 

birth to the current data. 

Currency 

Used to identify numeric values that have decimals or fractions. 

Use this data type especially when dealing with monetary values 

such as fees balance, amount sold etc. 

 

AutoNumber 

This is a numeric value used if you wish Ms Access to 

automatically increment the values in a field. For example when 

entering a list of forty students and you have a field labelled 

StudNumber, the numbers will increase by one every time you 

enter a new record. 

 

Yes/No 

 This is a logical field where an entry is either a yes or a no, true or 

a 

false. For example a field may require you to answer whether you 

are a male or a female. 

 

OLE Object 

Fo
r f

re
e K

CS
E 

No
tes

, E
xa

ms
, a

nd
 P

as
t P

ap
er

s V
isi

t h
ttp

s:/
/T

ea
ch

er
.co

.ke
/



 

OLE stands for Object linking and Embedding. This type of field is 

mostly used with graphical user interface applications for inserting 

graphical objects such as pictures, drawings charts etc. - - -- 

 

Field properties 

As you create more and more complex tables, you will find a need 

to use the field properties to specify finer details related to fields 

and the table entries expected. The field properties depend on the 

type of-the field selected. For example when you click on a Text 

field then the General tab you will see properties associated to text 

data type as shown in Figure 3.9. The various properties are: 

 

Field size 

This allows the user set the number of characters in a field instead 

of the default 50 for text fields for numeric field’s integer and long 

integer, Byte, Single and Double. 

Integer and longer integer: Accept numbers with no decimals. 

Byte: Can only accept a number from 0-255. 

Single and double: Accept numbers with decimals. Single 

accommodates up to 38 decimal places while double, 

accommodates up to 308. 

 

Format 

Determines how information appears on the screen and when 

printed. For example, you can format a number to scientific, 

currency, percentage or general format. 

 

Decimal places 

For number and currency fields you can specify the number of 

decimal places. 

Input mask , 

Input mask automatically formats the field entry into a specified 

format. F or example, if you enter a number such as 02000 I 

00409874 and the input mask is set as 000-(00000)-000000, it is 

automatically displayed as 020-(00100)-409874. This property is 

mostly used to format phone and address entries. 

 

Caption 
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This is a more descriptive name for a field to be used in a table or a 

form display. For example the caption for StuName could be 

Student Name. 

 

Default value , 

This is a value that will appear automatically in the datasheet or 

form if ' nothing is entered by the user to change it. For example = 

Date -( ) automatically displays the current date in a date field. 

 Validation Rule 

Logical expression restricts the values to be entered in a field. 'For 

example, if you want to restrict marks entered in a field to values 

between 

, zero and a hundred, type >=0 And <= 100. 

 

Validation Text 

The message that appears once the validation rule is violated. For 

example, you may create a validation text for the above validation 

rule I to display "Enter a number between 0 and 100" whenever 

the user enters I a value outside this range. 

 

Required 

Determines if an entry must be made in the field before you 

proceed to the next field or record. For example, if a primary key is 

required, you must enter before you proceed. 

 

Allow Zero Length  

This allows the user to proceed without making any entry in the 

field set as Zero length. 

 

Indexed 

An Index, facilitates the organisation of records for easy search. A 

primary key is an example of an index set to No duplicates to 

control double entry of a record (redundancy). 

 

Primary key and Indexes 

 

An index is a database feature used to speed up search and sort 

operations in a table. A key field also referred to as a primary key 
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is a special index that enforces uniqueness in a table so that one 

record is not entered twice. 

 

Ms Access uses the primary key to search for data stored in a table 

as well as define relationships between tables. Once a field is set as 

primary key, its datasheet is automatically indexed or sorted using 

the primary key. 

To set a primary key: 

1. Open the table in design view. 

2. Select the field you want to set as the primary key by clicking in 

the row header to the left of the Field Name. 

3. Click Set Primary key button on the tools bar. A key should 

appear on the left of the field name as shown in Figure 3.10. 

 

To see another field as an index other than the primary key: 1. 

Open the table in design view. 

2. Ensure that non of the fields is selected as a primary key. 

3. Click the Indexes button on the tool bar that is located next to 

the primary key. The index design grid is displayed on the screen 

as shown in Figure 3.11. 

4. In the index name column, type in the name you want to give to 

 the index. 

 5. In the Field Name column, click the cell to display a drop down 

list. From the drop down list, select the field to use as an index. 

6 In the Sort Order column, select either ascending or descending.  

7. In the lower portion, specify whether you want to make the field 

a primary key by selecting yes for primary and unique, and Ignore 

Nulls to ensure that data is entered into the field before proceeding. 

8. Close the dialog box. 

 

Entering data into a table 

 

To enter/append data into a table: 

1. Open the database in which the table is located 

2. Click the Tables tab then double click the table you want to add 

records to. 
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3. Enter each record field by pressing the tab key to move to the 

next. Once you reach the end of the record and move the cursor to 

a new row the previous record is automatically saved. 

 

Editing a database 

 

Modifying the Datasheet view  

 

To adjust the column size: 

1. Point to the column border between the field's header then drag 

to the require size. 

2. Alternatively, click on the format menu then point to column 

and click on width 

3. Type the desired width 

To adjust row height 

1. Point to the border between two rows in the row header and then 

drag. 

2. Alternatively, use format menu, then Row height. 

To reorder fields: 

1. Select the column of the field you wish to move by pointing to 

the desired file name. 

2. Drag the column right or left to the top of the field where you 

want your field to appear and then drop. 

 

Modifying the table structure 

 

Once you create a table, you may need to add more fields, remove 

some fields, reorder the fields or change fields data types and 

properties. Before you modify the table it is important to save a 

copy to avoid losing everything in case you make a mistake 

To make a copy of your table:  

1. From the file menu, click save as /export 

2. From the dialog box that appears, choose whether to save to 

another (external) database or the current. 

3. Type a new name for your table and click OK. 

 To modify the original table: 
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1. Open the table in design view by clicking the button that looks 

like a pencil and a set square placed on the edge of a ruler. 

2. Select the field or fields to be modified and make the necessary 

changes.  

3. Click the Save button to save the changes. 

NB: If a table contains data and you make changes to the field data 

type, Ms Access may refuse to implement the changes. To avoid 

this problem, exit without saving and delete all the records from 

the table then return to the design view. You can then import a 

copy or copies of tables you backed up. 

To import a table from another database: 

1. From the File menu, point to Get External Data then click 

Import 

 2. From the dialog box that appears, select the database you wish 

to 

import data from then click the Import button. Objects dialog box 

is displayed as shown in Figure 3.12. 

3. From the objects dialog box displayed, click the Tables tab  

4. Select the table(s) you wish to import then click OK. 

 

Form design 

 

Tables display many records at once from the database and in 

some cases you may not be able to see some fields properly. A 

form is an interface that enables the user to view and make data 

entries into an underlying table more easily. Figure 3.13 shows a 

sample form used to enter records into a books table. 

 

In Microsoft Access, a form is designed using graphical objects 

called controls. A control is an object such as a text box, check 

box, command button or shapes that you place on a form design 

grid to display data or perform actions. There are two types of 

controls you can place on the grid: bound and unbound controls. A 

bound control is one whose source of data is a field in a table or 

query while unbound control is a control that is not connected to 

any data source. 
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You design or modify a form layout by dragging these controls to 

the required position. Figure 3.14 shows a form layout grid for a 

table called exam entry. 

 

 Creating a form layout using form wizard 

 

To create a form layout, you can either use the form wizard or start 

from scratch. Using the form wizard you can create either a 

columnar, a tabular a datasheet or a justified form layout. 

Columnar form: The fields for each record are displayed down a 

column i.e. each value displays on a separate line with field labels 

to the left. Tabular: Records are displayed from left to right across 

the page and labels appear at the top of each column and each row 

represents a new record. 

Datasheet: The form resembles a table datasheet view. 

Justified: One record occupies the whole form. 

To create a form using the form wizard: 

1. Open the database for which the form is to be created 

e.g."EMPLOYEES" 

2. Click the Form tab then, New. From the New form dialog box 

that appears, click Form Wizard. 

3. Select the table you want to create a form for then New, A 

dialog box appears. 

4. Click the name of the table or query that includes the data you 

want to add into the form, and then click OK. 

5. From the fields list window, select the fields to add into the form 

by clicking the> button or click>> to add all fields then 

6. From the layout dialog box, select the layout you wish to use 

e.g. Standard then. click Next. 

7. In the Form title dialog box, type the name of the form then 

click Finish. Ms Access will automatically display the form on the 

screen. 

 

Creating a form using autoform wizard 

 

You can easily create a form using the Autoform wizard. This 

wizard creates a form for you automatically by asking you very 
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minimal questions. The form includes all the fields from the 

selected table. 

 

To construct an autoform tabular. 

1. Make sure your database is open 

2. Click the Form tab, then New. 

3. In the new form dialog box, select an auto form layout e.g. 

columnar  

4. In the "Choose the table or query where the object data comes" 

select the table you wish to create a form for then click OK. The 

form with all fields will be displayed. 

5. Click the Save button to save the form. 

 

Creating a form from scratch 

 

1. Open your database 

2. In the database window, click the Form tab then New 

3. From the New form dialog box, select Design view 

4. In the "Choose the table or query where the-object data comes" 

select the table you wish to create a form for then click The form 

with all fields will be displayed. 

To add controls onto the grid: 

1. Click the View menu, then. Field list command . The table you 

selected fields list is displayed. 

2. Drag and drop each field and arrange them on the grid. 

3. Save the form by clicking on the save button. 

 

 

Data manipulating in a form 

 

Adding and displaying records 

 

The form provides the user with navigation buttons located at the 

bottom that can be used to navigate the form  

The functions of the buttons can be summarized from left to right 

as follows 

1. Displays the first record in the table 

2. Displays the previous record.  
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3. Displays the next record 

4. Displays the last record. 

5. Add a new record. 

 

Formatting fields/controls in a form  

To format fields in a form; 

1. Open the form in design view 

2. To resize, click the controls then position the pointer on the 

outline of the control then drag to the required size. 

3. To move, click the control and position the pointer onto the 

place holder or inside the control then drag to the required location. 

 

Searching for specific records in a database 

One major reason for use of a computerised database is the ability 

to search and retrieve specific information more efficiently. Rather 

than searching through endless filing cabinets, you simply enter an 

instruction and let the database do the rest. To search for data in a 

database, Ms Access provides the user with two search tools: 

1. Find command 2. Queries' 

 

Using the find command 

With a large database, the Find command saves your time when 

you need to move a record pointer to a particular record. 

To search for a record: 

1. From Edit menu, click Find. The find dialog box appears in which 

you specify the field you want to search for in the" Find What" box 

as shown in Figure 3.16. 

2. Type the name of field you wish to search for in the Find What text 

 box. . 

3. In the Search box (Figure 3.16), specify whether to: 

( a) Search All 

(b) Search Down to up or 

(c) Search up to bottom 

4. In the match box, you can select one of the match types: 

(a) Any part of field - As long as a string of characters to be 

searched are present in a word, then all the words having the string 

will 
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be searched e.g. "Berg" finds Berger, inselberg etc. 

(b) Whole Field - Searches for the whole field for example, "Berg" 

will not return Berger, inselberg but specifically berg if it is in 

the database. 

(c) Start of Field - Specifies that, the searched word should start 

with the specified search string e.g. "Berg" 

5. In searching, you can also check or uncheck; 

(a) Match case - Finds only text that has the same pattern of upper 

and lower case as the one specified in the Find What box. 

(b) Search Field As Formatted - Select (check) to find data based 

on its display format e.g. 'a date stored asa number 1/5/98 but 

displayed as 05-Jan-98 

(c) Search Only Current Field:- Select to search through all 

records for the current field only.  

6. After you set the search conditions click the Find First button.  

7. If you want to search for the second record or other records with 

the same field, click Find Next button. 

 

You can use a wildcard e.g. asterisks (*) if you are not sure of the 

correct search word that will find all records that match the 

specified search string. For example, if you wish to search for all 

names that start with letter "J" in a school database, type J *. All 

names that start with J e.g. John, Jane Joy, Joyce and James will be 

displayed. 

 

Using Queries 

Queries are the fastest way to search for information in a database. 

A query is a database feature that enables the user to display 

specific records as well as perform calculations on fields from one 

or multiple tables. You can analyse a table or tables by using either 

a select query or an action query. However, only the select queries 

will be discussed in detail in this book 

 

Select query 

This is the most common type query used for searching and 

analysing data in one or more tables. Select query lets the user 

specify the search criteria and the records that meet those criteria 

are displayed in a dynaset 
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Action query 

These are queries that are used to make changes to many records 

once. They are mostly used to delete, update, add a group of 

records from one table to another or create a new table from 

another table. 

 

The four types of a action queries found in Microsoft Access are: 

1. Update - Updates data in a table. 

2. Append query - adds data in a table from one or more tables. 

3. Make table Query - Creates a new table from a dynaset. 

4. Delete Query - Deletes specified records from one or more 

tables. 

 

Creating a select query 

1. Ensure that the database you want to create a query for is open.  

2. Click the Query tab, then New. 

3. From the New query dialog box, choose either to create a query 

from in Design view or using a Wizard. 

4. To design from scratch, click Design View. The Show Table 

dialog box appears from which you can add a table or tables you 

wish to create a query for as shown in Figure 3.17.  

5. Click the table from the table/ query list and then click Add.'  

6. Click Close to close the show table dialog box. 

7. The query design grid opens. In Microsoft Access it is called 

Query By-Example. This lets the user to design a query. Figure 

3.18 is QBE grid for a table called Exam. 

 

Parts of the query grid  

Field row- Fields from a table or tables to be used are arranged in 

this row. Each field should occupy its column. 

Sort row - By clicking the down arrow in the sort cell, you can 

specify the sort order i.e. ascending, descending or no sort. 

Show row - By clicking the Show box, you specify whether to 

display the field in the query results: When the box is not checked, 

the field will not be displayed. 

Criteria row - This is where you type conditional statement that 

will be used by the query to display specific records. 
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Or row - Used to specify an alternative condition e.g. if you want 

to display records with a field called City with items Nairobi or 

Embu, type Nairobi in criteria cell and Embu in the Or cell. 

To add fields into the query grid: 

1. Open the query in design view 

2. From the field list of the underlying table, drag each field and 

place it in the field row 

 

Specifying the search criteria 

In order to search for a particular set of records, you have to enter a 

conditional statement or statements in the criteria row. For 

example if you have a table called employees with one of the fields 

as salary, you can display all the employees earning more than 

Shs. 5,000, by typing >5000 in the criteria row, salary column. 

 

To define criteria, use either relational or logical operators. 

Relational operators include less than «), greater than (», greater 

than or equal to (>=), less than or equal to «=), not equal to «» and 

equal to (=). Logical operators include AND, OR and NOT. 

 

Use AND to display values in a specific range. For example, to 

display records from the employees table with salaries above 4000 

but less than 6000, type, >4000 AND < 6000 on the criteria row in 

the salary column. All the employees who meet this condition will 

be displayed. 

 

Use OR if you wish to get either one of two values. For example if 

you wish to get those employees either in Nairobi OR Embu. 

 

If you want to display data in a particular range use the word 

Between. For example, instead of typing , >4000 AND < 6000, 

type Between 4000 And 6000. 

 

If you want to list all records except those that you do not want to 

see use NOT. For example if you type NOT 6000 in the salary 

column of the employees table, all employees records will be 

displayed except. those with their salary as 6000. 
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To display records you are not sure of the field name but at least 

you can remember a few characters, use LIKE and the wildcards. 

Wildcards are 

special symbols mostly an asterisk and a question mark used in 

place of other characters. For example, to display all names 

starting with "Sm" followed by any other character, type Like Sm? 

Like */*/1993 lists records created in 1993 regardless of the day or 

month. 

 

Saving and running the query 

1. Click the Save button on the standard tool bar or save command

 from the file menu. 

2. In the name box that appears, type in the name of the query then

 click OK. 

3. To run the query in design view, click the Run button on the 

toolbar as shown in Figure 3.19 or Run command from the Query 

menu. 

4. You can view the results of your query any other time by 

selecting the query, then clicking the Open button from the 

database window. 

 

Sorting the dynaset To sort a dynaset: 

1. In the sort row, click the down arrow that appears to specify the 

sort order i.e. ascending or descending of the desired field.  

2. Display the dynaset. 

 

Modifying and updating a query 

To delete fields from the query grid: 

1. Open the desired Query in design view.  

2. Select the field column you wish to delete  

3. Choose Delete from the Edit menu. 

4. Click the Save button to save the changes 

 

To adjust the column size in a query 

1. Open the desired query in design view. 
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2. Position the mouse pointer at the boundary that separates 

columns then drag it to the required size. Alternatively, double 

click the boundary to auto fit cell content. 

3. Click the Save button to save the changes 

To modify a criteria statement 'select query, 

1. Open the desired query in design view. 

2. Modify the criteria statements as desired, 3. Click the Save 

button to save changes. 

4. To test whether the changes have been effected, click the Run 

button to display the results of the query. 

 

Performing calculations in a query 

Unlike tables, queries let the user perform mathematical 

calculations on numeric data. You can perform calculations in a 

query by using the Total functions or by creating basic formulas 

Creating basic formulae 

To create a formula that calculates the total marks in an underlying 

table e.g. Exams table: 

1. Open your query in design view 

2. In an empty cell, preferably the immediate last field cell, type an 

expression that includes a field name of your choice such as: 

Total: [Math’s) + (Physics) + (Chemistry) as shown in Figure 3.20 

 

Math’s Physics Chemistry Total: 

(Math’s)+(physics)

+(Chemistry) 

Exam Exam Exam  

   . 

        √      √     √     √ 

 

Fig. 3.20: Creating an arithmetic expression 

 

3. You can then set the criteria, and other query options. 

4. Save the query and run it. The results of the calculations will be 

displayed in the dynaset as shown in Figure 3.21. However, this 

field is not added to the underlying table(s) because query results 

must always be based on the most current data in the database.  
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Using Total functions . 

With a query, you can analyze all records fields using the inbuilt 

functions such as Sum, Average, Minimum and Maximum etc. To 

use the total functions: 

1. Open your query in design view. 

2. Click the Totals button on the query toolbar. 

3. Select the field you want to analyze. 

4. For each field to be analyzed, click its cell in the Total row, and 

then select any of the functions as shown in Figure 3.22.  

Sum: Adds all the numerical data items. 

Avg; Calculates the mean of all numeric data items in the field 

column.  

Min: Returns the minimum value from the field column. 

Max: Returns the maximum value from the field column. 

Count: Returns the number of items field column. 

5. Set criteria and other options then click run to preview the 

results 

6. Save the query. 

 

Printing a query: 

1. Open the database window of the database containing the query 

you want to print 

2. Click the query tab then the query you want to print. 

3. From the file menu, click print Set the printing options then 

click the OK. Button. 

 

Creating a select query from multiple tables 

When you use fields from more than one table in a query, there 

should be a common link or relationship between the tables. There 

are three type of relationships  

1. One – to - One 

2. One -to - Many 

3. Many -to - Many 

In a one -to - one relationship, for a particular field in one table 

(the main table), there is only one matching record in the related 

table and vice versa. In a one -to - many relationships, for a 

particular field in one table there are several matching records in 

another table. This is the most common type of relationship. For 
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example, a person may make one order, or several orders. For this 

instance, there is only one record with that person's details say in 

customers' table, yet there are several records related to the same 

person in the Orders table. 

In a many -to - many relationship, for particular records in one 

table there are several matching records in the other table and vice 

versa. This is not very common. 

 

Defining relationship between tables 

1. Make sure your database is open. 

2. From Tools menu, choose Relationships. The relationship dialog 

box appears. 

3. Select the tables to add then click the Add button. . 

5. To create relationship, click on the common field and drag it to 

the second table. The fields used to create the relationship must be 

of the same type and properties. 

6. To Enforce Referential Integrity, right click the line joining the two 

tables then click Edit. An Edit relationship dialog box such the one 

in Figure 3.23 will be displayed. 

7. Make sure Enforce Referential Integrity is checked to ensure that 

all records entered in the related table exists in the primary table. 

 

8. Click OK to close the Edit relationship dialog box. 

 

To create a query based on related tables 

1. Start the database window and click the Queries tab,  

2. Select design view and click OK. 

3. From the show table dialog box, click the tables you want to 

base your query on and then click Add. 

4. Relationship between various tables will be displayed as shown 

in Figure 3.24. Add the fields from both tables into the QBE grid. 

5. Save and Run the query. 

 

Creating reports 

Reports are used to summarize and present information from a 

database. A good database software should enable the user to 

generate database reports and print them for presentation and 

distribution. This process is referred to as formal presentations. As 
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with forms, a report layout is also designed by placing controls on 

to the report layout grid as shown in Figure 3.25. 

 

Parts of a report layout in design view 

Report Header-This contains unbound controls that displays title of 

the report. 

Page Header - Contains heading or labels data items to be 

displayed in every column. 

Detail - Holds bound controls that display data items for the table 

or query it was created from. 

Page footer holds a control that is to be displayed on every page 

such as the page number and date. For example =Now() displays 

the current date and time as set in the system clock. 

 Report footer - Used to display summary from a report such as the 

grand total for numerical data in a particular field column. 

 

Creating a report using report wizard 

Just like the form wizard, report wizard takes the user through a 

number of steps by answering a few questions and Ms Access 

automatically does the rest. 

 

To create a report layout: 

1. Ensure that the database is open. 

2. Click the Report tab, then New 

3. From the/New Report dialog box, click Report Wizard then 

4. Select a table or a query then the fields to be added to the report 

then click next. 

5. The wizard asks you whether you wish to add any group. 

Grouping is used to categorise records using a particular field for 

better presentation or if you need to perform calculations on a 

group of common items. For example, to categorise books in a 

library database according to ISBNNumber, double click the field 

then click Next. (Figure 3.26). 

6. In .the dialog box that appears, select the Sort option if you want 

to sort the records. You can also click the Summary options button 

in case you want Ms Access to perform calculations on numerical 
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fields. In summary options dialog box, select the Summary options 

you want performed e.g. Sum, Average etc. as shown in Figure 

3.27. Click OK to close the summary options dialog box then Next. 

8. From the layout dialog box, select the type of layout such as 

stepped, block etc. Select page orientation i.e. either portrait or 

landscape then click Next. 

9. In style dialog box, specify the report style by selecting either 

bold, casual etc. 

10. Finally enter the name of your report then click finish. The 

report will be displayed on the screen in print preview mode. 

 

Creating a report in design view 

Just like with forms, you can create a report in design view by 

placing controls on the report design grid. 

 

To design a report in design view: 

 

.' 

1. In the database window, click the Reports tab then New. 

2. In the New Report dialog box, click Design view. 

3. Click the name of the table or query you want to generate a 

report from. 

4. Click the OK button. You will get a report design grid where 

you can place data controls.  

5. From the view menu, click Field List.  

6. To design the layout, drag each field from the field list to the 

layout grid and drop it where you want the data column to appear. 

7. Once you finish placing controls, click the Save button. 

8. In the save as dialog box, enter the name of the report and click 

OK.  

9. To view the report, click the Print Preview button. Alternatively, 

click Print Preview from the file menu. 

 

Modifying a report layout 

To modify headers and footers: 

1. Open the report in design view. 

2. Click the report header or footer you want to modify. 

3. Make the necessary changes and then click the Save button.  
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4. Click the Print Preview button to view the changes. 

 

To add more controls onto the report layout:  

1. Open a report in design view. 

2. Display the field list by clicking the Field list button or using the 

View. 

3. Select one or more fields in the field list and drag view to the 

Report design grid. 

 

To resize or move a control: 

1. Click at once to select it. Position the mouse pointer to on the 

place holder, until the mouse pointer changes to a double-sided 

arrow. Drag the pointer to resize the control 

2. To move a control, select it and place the mouse pointer on the 

place holder until it changes to a hand. 

 

Creating labels 

A label is a sticker or piece of paper put on an item for the purpose 

of identification. Examples of stickers are mailing labels, label on 

the floppy disk where you write your name etc. Using the report 

label wizard, Microsoft Access lets you easily create labels of 

different sizes. 

To create a label using the report wizard, 

1. Open the your database 

2. From the database window, click the Report tab then New 

3. From the New Report dialog box, select Label Wizard the table 

or query from which the labels are to be generated from. 

4. Label wizard starts running as shown in Figure 3.28. 

5. From a series of dialog boxes displayed, specify the label size, 

font, and fields to be included in the label, whether to sort the 

labels, the name of the label then click Finish. 

 

Modifying labels 

Just as you can modify a report or a form, you can also modify a 

label by manipulating the layout controls. 

To modify a label, 
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1. From your database window, click the Report tab then the 

Design View button. 

2. The label design grid is displayed. Edit the layout as desired, 

save and close the design grid. 

3. To view the modified label, click the Preview button from the 

database window. 

 

Printing the report and labels 

Before you print a report or a label, you should first set the page 

options i.e. the margins, paper size and orientation. 

1. Open the database that contains the report you want to print. 

2. Click the Report tab, select the report you want to print then 

click the Preview button. 

3. From the File menu, click Print. 

4. Set the printer options i.e. the printer type, print range and 

number of copies. 

5. Click OK to print. 
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DESKTOP PUBLISHING (DTP) 

 

Chapter outline 

 

4.1 Introduction. 

4.2 Definition of desktop publishing.  

4.3 Purpose of desktop publishing. 

4.4 Types of desktop publishing software.  

4.5 Designing a publication. 

4.6 Manipulating text using the toolbox  

4.7 Editing a publication. 

4.8 Formatting a publication. 

4.9 Printing a publication. 

 

Introduction 

Have you ever asked yourself how newspaper and book publishing 

companies manage to produce publications that are attractive with 

creative layouts and graphics in large volumes? They do this 

through a special process called publishing. Publishing is the 

process of producing publications like newspapers, cards, 

pamphlets, pictures, calendars etc. that have special text and 

graphical layouts and designs. The traditional method of 

publishing involved drawing and writing manually on wooden or 

metallic boards. The artwork would then be painted with ink and 

pressed on papers to produce a printout. This was a very tedious 

work. 

 

Today the art of publishing has changed because of the advent of 

personal computers and smaller printers that are able to print high 

quality text and graphics even in an office or at home. 

 

Definition of desktop publishing (DTP) 

Desktop publishing refers to the process of producing publications 

like cards, newspapers etc. by designing their text and graphics 

layout and inserting, editing, formatting and printing of text and 

graphical objects using a special desktop publishing software 

installed on computers. The term desktop means that all the 

publishing processes can now be done on a desk in the office or at 
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home using a personal computer! The difference between a 

desktop publisher and a word processor is that a desktop publisher 

software gives the user more tools and control of the page layout, 

text manipulation and graphic design than a word processor. 

 

However it is important to note that some word processors today 

have also been incorporated with text and graphic formatting and 

editing tools. Hence a thin line exists between them and the 

desktop publishers. For example you can design a full publication 

in Microsoft Word by using the available drawing and picture 

tools, create columns etc. 

 

Examples of desktop publishers include Adobe PageMaker, 

CorelDraw, Microsoft Publisher and Ventura. This book will use 

Adobe PageMaker to demonstrate the concepts of desktop 

publishing. 

 

Purpose of desktop publishing software 

Desktop Publishing programs are very popular in publishing 

because they give the person designing publications (typesetter) a 

lot of control on: 

Graphic design: Using desktop publishing software, a typesetter 

can create and edit very complex text and graphical objects like 

pictures to the finest details. For example, the software provides 

the user with rulers and ruler guides that can be used to place an 

object in exactly the correct position. 

Page layout design: With a desktop publisher, the user can be able 

to design a page layout by setting consistent picture and object 

locations, dividing a page in a number of columns and creating 

layers. A layer can be viewed as the arrangement of objects on top 

of each other with the one on top being on the first layer e.g. text 

can be on one layer while graphical objects on another. Therefore 

the text layer can be manipulated separate from the graphical 

object layer like for example text moves separate from the objects. 

Another good example is you can make the graphical object layer 

transparent in order to make the text in a layer behind the object 

visible. 
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Printing: Because the main purpose of any desktop publisher is to 

produce publication s, this cannot be accomplished without 

printing. Desktop publishing software therefore helps the user 

prepare what is referred to as an artwork in commercial circles for 

printing. 

 

Types of desktop publishing software 

There are two main types of desktop publishing software: 

Graphical based: They are specifically developed to edit and 

format graphic objects like pictures. Examples are Adobe 

Photoshop, Corel Draw, harvard graphic etc. This desktop 

publishers have superior image handling capabilities like setting 

resolution, brightness, contrast, cropping and filling images of all 

types with colour. 

 

Layout based: These types of desktop publishers are specifically 

developed to create different page layout designs for text and 

pictures. Have you ever wondered how the complicated front page 

of a newspaper is developed? It is difficult to achieve such without 

a good layout based DTP. Good examples of layout based desktop 

publishers are Adobe PageMaker and Microsoft Publisher. 

 

Designing a publication 

Publications vary in design and formatting. For example, a card 

has a particular design layout that is different from a newspaper. 

Therefore, publication designs determine how they are classified. 

 

Types of publications 

It is possible to produce different types of publications using a 

desktop publishing software. There are several types of 

publications that can be published namely: 

Cards: These may be for weddings and other special occasions like 

graduations and for congratulations. 

Certificates: To show completion of courses and special events. 

These type of publications are very sensitive because they must be 

designed to discourage any type of duplication or counterfeits. 
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Newspapers, magazines, pamphlets and newsletters: Have news 

targeting a group of people. They may have many text and 

graphical layouts and designs. 

Books: Are bulky publications with many pages bound together in 

the same publication. 

Calendars: Apart from showing dates, they are used by companies 

to advertise their products hence most of them have heavy catchy 

graphics. 

 

Running Adobe PageMaker 

Currently PageMaker versions 6.5 and 7.0 are the most common 

desktop publishing software developed by Adobe PageMaker. 

Other Adobe products includes Adobe Photoshop mainly used for 

editing and formatting photographs, Adobe illustrator used for 

creating complex freehand artwork such as drawings and logos etc. 

 

Starting Adobe PageMaker 

1. Click the Start button and then point to Programs 

2. From the programs sidekick menu, point to Adobe group then 

select PageMaker. Figure 4.1 shows how to start PageMaker in a 

typical Windows environment. 

3. The PageMaker program starts and provides the Document 

Setup dialog box. If the Document setup dialog box is not 

displayed, then click File menu and select the New command. 

4. In the Document Setup dialog box similar to the one in Figure 

4.5 specify the publication setup options. 

5. Click OK to apply the selected options. A publication window 

similar to the one in Figure 4.2 is now displayed. 

 

PageMaker screen layout . 

The PageMaker application window looks like most application 

windows for programs you have used before. It also has a title bar, 

menu bar and scroll bars. However, you will note that unlike most 

of the Microsoft applications you have used before, Adobe 

PageMaker does not have a status bar on its application window. 

The most notable difference between a desktop publishing 

software such as PageMaker and a word-processing software such 
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as Microsoft Word is that a desktop publishing software has its 

printable work area centered on a pasteboard as shown in Figure 

4.2.  

The PageMaker publication window is made up of the following 

layout components: 

 

1. The pasteboard.  3. The toolbox.  5. Rulers 

 

2. The printable area.  4. Master pages. 

6. Control pallete. 

 

The pasteboard 

A pasteboard is a large blank area where you place text and 

graphical objects before arranging them neatly on the printable 

work area enclosed with margins. 

 

The printable area 

It is the area that looks like a page surrounded by margins on the 

pasteboard. Any object or text that is placed on the printable area 

will be printed by the printer. 

 

The Toolbox. 

This is a set of buttons that contains various tools you can use to 

create and manipulate your publication it has the following tools 

Line tool 

Rectangle tool 

Ellipse tool 

Polygon tool 

Hand tool 

Pointer tool  

Rotate tool 

Text tool  

Cropping tool 

Constrained tool  

Rectangle frame 

tool  

Ellipse frame tool  

Polygon frame 

tool 

Zoom tool 
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